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Introduction

This manual contains detailed instructions and notes on the operation and use of this printer. For your safety and

benefit, read this manual carefully before using the printer. Keep this manual in a handy place for quick reference.

For safe and correct use, be sure to read the "Safety Information" before using the machine.
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Manuals for This Printer
For particular functions, see the relevant parts of the manual.

Safety Information

Provides information on safe usage of this machine.

To avoid injury and prevent damage to the machine, be sure to read this.

Quick Installation Guide

Contains procedures for removing the printer from its box, connecting it to a computer, and installing
its driver.

Hardware Guide

Contains information about paper and procedures such as installing options, replacing consumables,
responding to error messages, and resolving jams.

Software Guide (This manual)

Contains procedures for using this machine in a network environment, utilizing the software, and using
security functions.
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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

This symbol indicates a potentially hazardous situation that might result in death or serious injury when you
misuse the machine without following the instructions under this symbol. Be sure to read the instructions, all
of which are described in the Safety Information section.

This symbol indicates a potentially hazardous situation that might result in minor or moderate injury or
property damage that does not involve personal injury when you misuse the machine without following the
instructions under this symbol. Be sure to read the instructions, all of which are described in the Safety
Information section.

*The statements above are notes for your safety.

If this instruction is not followed, paper might be misfed, originals might be damaged, or data might be
lost. Be sure to read this.

This symbol indicates precautions for operation, or actions to take after abnormal operation.

This symbol indicates a reference.

[ ]

Keys that appear on the machine's display.

Keys and buttons that appear on the computer's display.

[ ]

Keys built into the machine's control panel.

Keys on the computer's keyboard.
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Description for the Specified Model
In this manual, the following items explain about the printer for the specified models:

This explains about the 220-240 V model printer.

Read if you purchase this model.

This explains about the 120 V model printer.

Read if you purchase this model.

• You can identify the printer's model by checking the label on its inside as shown.

AUB067S
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Using Keys
This section describes configuration using the display panel on the initial screen.

BKK002S

1. Display

Shows the current status of the printer and error messages.

2. Power indicator

Is on while the printer power is on.

Is off when the power is turned off or while the printer is in Energy Saver mode.

3. Alert indicator

Blinks or lights up whenever any printer error occur. A message describing the cause of the error also appears
on the display.

4. Data In indicator

Blinks while the printer is receiving data from a computer.

Is on if there is data to be printed.

5. [Online] key

Press this key to switch the printer between online and offline.

6. [Job Reset] key

When the printer is online, press this key to cancel any ongoing print jobs.

See p.108 "Canceling a Print Job".

7. [Form Feed] key

If the printer is offline, press this key to print all the data left in the printer's input buffer.

This does not work if the printer is online.
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8. [Menu] key

Press this key to make and check the current printer settings.

9. [Escape] key

Press this key to return to the previous condition on the display.

10. [  Enter] key

Press this key to execute menu items selected on the display.

Press this key to clear some errors.

11. [ ] [ ] keys

Press keys to increase or decrease values on the display when making settings.

Keep the key pressed to quicken scrolling, and increase or decrease values on the display in units of 10.
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1. Preparing for Printing

Quick Install
Windows 2000/XP/Vista, and Windows Server 2003/2003 R2 users can easily install this software
using the CD-ROM provided.

Quick Install sets the TCP/IP port and installs DeskTopBinder and the PCL and/or RPCS driver.

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrator.

• The Quick Install is not available when using this printer under USB connection.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

5. After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is displayed in [Connect To].

For parallel connection, select the printer whose printer port is displayed in [Connect To].

7. Click [Install].

The printer driver installation starts.

8. Click [Finish].

A message about restarting the computer may appear. Restart the computer to complete installation.

9. Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Select a printer to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for
Client when using TCP/IP.

17
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• Quick Install is not available unless bidirectional communication between the printer and computer
is enabled via parallel connection.

• p.59 "Making Option Settings for the Printer"

• p.49 "Installing the Printer Driver Using USB"

1. Preparing for Printing
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Confirming the Connection Method
This printer supports network and local connection.

Before installing the printer driver, check how the printer is connected. Follow the driver installation
procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet and wireless LAN.

Available ports are determined based on the combination of Windows operating system version and
connection method used.

BKK008S

Windows 2000

Connection Method Available Ports

Ethernet/Wireless LAN SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Confirming the Connection Method
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Windows XP

Connection Method Available Ports

Ethernet/Wireless LAN SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows Vista

Connection Method Available Ports

Ethernet/Wireless LAN SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows Server 2003/2003 R2

Connection Method Available Ports

Ethernet/Wireless LAN SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

• p.23 "Using the SmartDeviceMonitor Port"

• p.34 "Using the Standard TCP/IP Port"

• p.38 "Using the LPR Port"

Using as a network printer

This printer can be used as the Windows network printer, the NetWare print server, or the NetWare remote
printer.

• In an IPv6 environment, Netware servers cannot be used.

1. Preparing for Printing
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BKK009S

• See the explanation of how to install the printer driver for each type of network printer.

• p.42 "Using as the Windows Network Printer"

• p.46 "Using as the NetWare Print Server/Remote Printer"

Local Connection

Local connections can be established via parallel and USB connections.

Windows operating system version determines the available connection methods.

• Windows 2000:

USB and Parallel connections

• Windows XP:

USB and Parallel connections

• Windows Vista:

USB and Parallel connections

• Windows Server 2003/2003 R2:

USB and Parallel connections

• See the explanation of how to install the printer driver for each method of connection.

Confirming the Connection Method
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• p.49 "Installing the Printer Driver Using USB"

• p.53 "Printing with Parallel Connection"

1. Preparing for Printing
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Using the SmartDeviceMonitor Port

Installing DeskTopBinder-SmartDeviceMonitor for Client

• To install SmartDeviceMonitor for Client under Windows 2000/XP Professional/Vista, Windows
Server 2003/2003 R2, you must have an account that has Manage Printers permission. Log on as
an Administrator.

• Install SmartDeviceMonitor for Client before installing the printer driver when using the
SmartDeviceMonitor for Client port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [DeskTopBinder-SmartDeviceMonitor for Client].

5. The DeskTopBinder Lite Setup dialog appears, and then click [Next >].

6. The software license agreement appears in the [License Agreement] dialog box. After
reading through its contents, click [Yes].

7. Click [Full install] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and SmartDeviceMonitor for
Client.

[Custom Install] installs selected applications.

8. Follow the instructions on the display and click [Next >] to proceed next step.

9. After the installation is completed, select one of the options to restart the computer either
now or later, and click [Complete].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

Using the SmartDeviceMonitor Port

23

1



Installing the PCL or RPCS Printer Driver (TCP/IP)

• To install this printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Click [Port:], and then click [Add].

11. Click [SmartDeviceMonitor], and then click [OK].

12. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

13. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IP address or host name of the printer.

14. Check that the port of the selected printer is displayed in [Port:].

15. Set a User Code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols are available.

16. Select the [Default Printer] check box to configure the printer as default.

1. Preparing for Printing
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17. Click [Continue].

Installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• This allows a SmartDeviceMonitor for Admin user to display and check statistics about the number of
sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, install using
[Add Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PCL or RPCS Printer Driver (IPP)

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

Using the SmartDeviceMonitor Port
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8. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].

10. Click [SmartDeviceMonitor], and then click [OK].

11. Click [IPP].

12. In the [Printer URL] box, enter "http://printer's address/printer" as the printer's address.

If the server authentification is issued, to enable SSL( a protocol for encrypted communication), enter
"https://printer's address/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http: //printer's address/ipp" as the printer's address.

13. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

14. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

15. Click [OK].

16. Check that the port of the selected printer is displayed in [Port:].

17. Set a User Code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

18. Select the [Default Printer] check box to configure the printer as default.

19. Click [Continue].

Installation starts.

20. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• This allows a SmartDeviceMonitor for Admin user to display and check the number of sheets each
user prints. For details, see SmartDeviceMonitor for Admin Help.

• To stop installation of the selected software, click [Cancel] before installation is complete.
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• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IPv4 address or host name of the printer.

11. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].
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15. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• IPv6 cannot be used under Windows 2000.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(printer's address)/printer" as the printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's address)/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer
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https://192.168.15.16/printer

You can enter "http://(printer's address)/ipp" as the printer's address.

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

15. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using [TCP/IP] appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IPv4 address or host name of the printer.

11. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 13 does not apply for Windows Vista users.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

15. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(printer's address)/printer" as the printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's address)/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://(printer's address)/ipp" as the printer's address.

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings, and then click [OK].

For information about the settings, see SmartDeviceMonitor for Client Help.
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13. Click [OK].

14. Check that the name of the printer driver you want to install is selected, and then click [Next
>].

15. Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 16 does not apply for Windows Vista users.

16. Specify whether or not to share the printer, and then click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

18. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout,
recovery/parallel printing, and printer groups.

For Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
click [Properties].

3. On the [Ports] tab, click [Configure Port...].

The [Port Configuration] dialog box appears.

For Windows XP and Windows Server 2003/2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties]. The printer
properties appear.
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3. Click the [Ports] tab, and then click [Configure Port...].

The [Port Configuration] dialog box appears.

For Windows Vista

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer].

The [Printers] window appears.

3. Right-click the icon of the printer you want to use, and then click [Properties].

4. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

• For TCP/IP, timeout setting can be configured.

• User, proxy, and timeout settings can be configured for IPP.

• If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Click [Cancel] to close the [Port Configuration:] dialog box.

2. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon
on the task tray.

3. Point to [Properties], and then click [Extended Features Settings].

4. Select the [Set Recovery/Parallel Printing for each port] check box.

5. Click [OK] to close the [Extended Features Settings] dialog box.

• For information about these settings, see SmartDeviceMonitor for Client Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Click [Port:], and then click [Add].

11. Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if [Standard TCP/IP Port]
does not appear.

12. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".
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14. Click [Next >].

15. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

16. Check that the port of the selected printer is displayed in [Port:].

17. Configure the default printer as necessary.

18. Click [Continue].

The printer driver installation starts.

19. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].
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6. Click [Local printer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box, and then
click [Next >[.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".

11. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

12. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

13. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

14. Specify whether or not to share the printer, and then Click [Next >].

15. Specify whether or not to print a test page, and then click [Next>].

16. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation . For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port] in [Create a new Port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".

11. Click [Next >].

12. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

14. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 15 does not apply for Windows Vista users.

15. Specify whether or not to share the printer, and then Click [Next >].

16. Specify whether or not to print a test page, and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

17. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

• To install this printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].

10. Click [LPR Port], and then click [OK].

If [LPR Port] does not appear, see Windows Help and install it.

11. Enter the printer's IPv4 address in the [Name or address of server providing lpd] box.

12. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].

The port is added.

13. Check that the port of the selected printer is displayed in [Port:].

14. Configure the default printer as necessary.
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15. Click [Finish].

The printer driver installation starts.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

7. Click [Create a new port:].

8. Click [LPR Port], and then click [Next >].

9. Enter the printer's IPv4 address in the [Port Name] box, and then click [OK].
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10. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to share the printer, and then click [Next >].

13. Specify whether or not to print a test page, and then click [Next >].

14. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local Printer attached to this computer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.
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If you are using Windows Vista, you do not need to click [Next >].

7. Click [Create a new port:].

8. Click [LPR Port] in [Create a new Port], and then click [Next >].

9. Enter the printer's IP address in the [Name or address of server providing lpd] box.

10. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].

11. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 13 does not apply for Windows Vista users.

13. Click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

15. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting "Network printer server", and then select the
Windows 2000/XP/Vista, or Windows Server 2003/2003 R2 shared printer.

This section assumes that the client has already been configured to communicate with a Windows 2000/
XP/Vista, or Windows Server 2003/2003 R2 print server. Do not begin the following procedure before
the client is set up and configured correctly.

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. For this, log on as
an Administrators or Power Users group member.

• If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery
Printing and Parallel Printing cannot be used from the client.

• If you print under Windows XP/Vista or Windows Server 2003/2003 R2 print server, notification
functions of SmartDeviceMonitor may not be used with the client.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Click [Port:], and then click [Add].
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11. Click [Network Printer], and then click [OK].

12. Double-click the computer name you want to use as a print server in the [Browse for Printer]
window.

13. Select the printer you want to use, and then click [OK].

14. Check that the port of the selected printer is displayed in [Port:].

15. Configure the User Code as necessary.

For an RPCS printer driver, a User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

The printer driver installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client
cannot use Recovery Printing and Parallel Printing.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Network printer], and then click [Next >].

7. Select the location method from the [Locate Your Printer] screen, and then click [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers:]
box.

9. Select the printer you want to use, and then click [Next >].

10. The printer driver installation starts.

11. Click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client
cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows XP/Vista or Windows Server 2003/2003 R2 print server,
SmartDeviceMonitor notification functions may not be possible for the client.

1. Quit all applications currently running.
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2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [A network printer, or a printer attached to another computer], and then click [Next
>].

If you are using Windows Vista, you do not need to click [Next >].

7. Select [Browse for a printer], and then click [Next >].

8. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

9. Select the printer you want to use, and then click [Next >].

10. The printer driver installation starts.

11. Click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Using as the NetWare Print Server/Remote
Printer
This explains how to set up the Windows computer used as the NetWare client.

• To install this printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, Netware servers cannot be used.

The following explanation assumes NetWare Client is installed on the client computer and the NetWare
server environment is correctly set up. Install all necessary client applications before following this
procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PCL/RPCS Printer Drivers].

4. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

5. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

6. Click [Next >].

7. Select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].

10. Click [Network Printer], and then click [OK].
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11. Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

12. Select the print queue, and then click [OK].

13. Check that the port of the selected printer is displayed in [Port:].

14. Click [Continue].

The printer driver installation starts.

15. Click [Finish] in the [Select Program] dialog box.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

17. After restarting the computer, open the printer properties from the [Printers and Faxes]
window.

Under Windows 2000 or Windows Server 2003 R2, launch the [Printers] window, and then open
the printer properties.

18. Click the [NetWare setting] tab.

Under Windows Vista or Windows Server 2003 R2, on the [Printer Settings] tab, clear the [Form
Feed] and [Enable Banner] check boxes.

Do not select these check boxes since they are automatically selected by the printer driver. If you
select the check boxes, the printer may not print correctly.

19. Click [OK] to close the printer properties dialog box.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet.

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

• In an IPv6 environment, Netware servers cannot be used.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.

2. Click the [Device Settings] tab.

3. Select [Yes] for [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].
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4. Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If
NetWare form feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to the operating system used:

• Under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2, clear the [Form feed] check
box on the [NetWare Settings] tab in the printer properties dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating system used:

• Under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the printer is reset. During this
period, jobs may be accepted (depending on NetWare specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server that the remote printer is
disconnected, or wait for two minutes before trying to print.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the computer and no print jobs are in
progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows 2000 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the [Found New Hardware Wizard] display, click [Search for a suitable driver for my
device [recommended]], and then click [Next >].

5. Select the [Specify location] check box, and then click [Next >].

6. Insert the CD-ROM into the CD-ROM drive.

When Auto Run starts, click [Exit].

7. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

• RPCS

D:\DRIVES\RPCS\XP_VISTA\(Language)\DISK1

• PCL 5e

D:\DRIVES\PCL5E\XP_VISTA\(Language)\DISK1

• PCL 6

D:\DRIVES\PCL6\XP_VISTA\(Language)\DISK1
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• PostScript 3

D:\DRIVES\PS\XP_VISTA\(Language)\DISK1

8. Check the printer driver location, and then click [OK].

9. Click [Next >].

10. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows XP, Windows Server 2003/2003 R2 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers and Faxes] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

• RPCS
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D:\DRIVES\RPCS\XP_VISTA\(Language)\DISK1

• PCL 5e

D:\DRIVES\PCL5E\XP_VISTA\(Language)\DISK1

• PCL 6

D:\DRIVES\PCL6\XP_VISTA\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS\XP_VISTA\(Language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows Vista - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using a USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].
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5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVES\RPCS\XP_VISTA\(language)\DISK1

• PCL5e

D:\DRIVES\PCL5E\XP_VISTA\(language)\DISK1

• PCL6

D:\DRIVES\PCL6\XP_VISTA\(language)\DISK1

• PostScript 3

D:\DRIVES\PS\XP_VISTA\(language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If the installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Troubleshooting USB

Problem Solutions

The printer is not recognized
automatically.

Turn off the power of the printer, reconnect the USB cable, and then
turn it on again.

Windows has already configured
the USB settings.

Open Windows' Device Manager, and then, under [Universal
Serial Bus controllers] or [USB Controller], remove any conflicting
devices. Conflicting devices have a [!] or [?] icon by them. Take
care not to accidentally remove required devices. For details, see
Windows Help.
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Printing with Parallel Connection
To use a printer connected using a parallel interface, click [LPT1] when installing the printer driver.

The optional IEEE 1284 interface board must be installed on the printer.

Installing the PCL or RPCS Printer Driver

• To install this printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Check that [LPT1:] is shown in [Port:].

11. Select the [Default Printer] check box to configure the printer as default.

12. Click [Finish].

The printer driver installation starts.

13. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].
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• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer].

• p.57 "Having Problems Installing the Printer Driver from the CD-ROM"

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

7. Select [LPT1:] at the [Printer Port] dialog box, and then click [Next >].

8. Select the name of the printer whose driver you want to install, and then click [Next >].

9. Change the printer name if you want, and then click [Next>].

Select the [Yes] check box to configure the printer as default.

10. Select whether or not to share the printer, and then click [Next >].

11. Specify whether or not to print a test page, and then click [Next >].

12. Click [Finish].

The printer driver installation starts.

13. Restart the computer to complete installation.
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• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

Step 5 does not apply for Windows Vista users.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

If the [Automatically detect and install Plug and Play Printer] check box is selected, clear it.

If you are using Windows Vista, you do not need to click [Next >].

7. Select the port you want to use, and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

8. Select the name of the printer whose driver you want to install, and then click [Next >].

9. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

Step 10 does not apply for Windows Vista users.

10. Select whether or not to share the printer, and then click [Next >].
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11. Specify whether or not to print a test page, and then click [Next >].

If you are using Windows Vista, you do not need to click [Next >].

12. Click [Finish].

The printer driver installation starts.

13. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.
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Having Problems Installing the Printer Driver
from the CD-ROM
If Quick Install fails, refer to "Using the SmartDeviceMonitor for Client" and proceed with the installation.
If the installation procedures explained in "Installing PCL/RPCS Printer Drivers" or "Installing PostScript3
Printer Driver" fails, follow the procedure below.

For Windows 2000:

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. Double-click the Add Printer icon.

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS
\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

4. Change the port settings.

Refer to the port description for the procedure.

For Windows XP Professional and Windows Server 2003/2003 R2:

1. On the [Start] menu, click [Printers and Faxes].

2. Click [Add a printer].

3. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS
\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

4. Change the port settings.

Refer to the port description for the procedure.

For Windows XP Home Editions:

1. On the [Start] menu, click [Control Panel].

2. Click [Printers and Other Hardware].

3. Click [Printers and Faxes].

4. Click [Install Printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS
\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

6. Change the port settings.

Refer to the port description for the procedure.
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For Windows Vista

1. On the [Start] menu, click [Control Panel].

2. Click [Hardware and Sound].

3. Click [Printers].

4. Click [Add a printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, PCL5E, or
PS)\XP_VISTA\(language)\DISK1. If the installer starts, click [Cancel] to quit.

6. Specify a port.

• Available ports may change depending on the combination of Windows operating system version
and the interface. For details about how to find an available port, see "Confirming the Connection
Method".

• p.19 "Confirming the Connection Method"

• p.23 "Using the SmartDeviceMonitor Port"

• p.34 "Using the Standard TCP/IP Port"

• p.38 "Using the LPR Port"
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Making Option Settings for the Printer
Make option settings for the printer using the printer driver when bidirectional communication is disabled.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direction settings to be
automatically sent to the printer. You can check printer status from your computer.

• Bidirectional communication is supported by Windows 2000/XP/Vista, and Windows Server
2003/2003 R2.

• If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000,
the [Change Accessories] tab is unavailable.

• The RPCS printer driver supports bidirectional communications and updates the printer status
automatically.

• The PCL printer driver supports bidirectional communications. You can update printer status manually.

• The PostScript 3 printer driver does not support bidirectional communications.

To support bidirectional communication, the following conditions must be met:

When connected with parallel cables

• The computer must support bidirectional communication.

• The printer must support bidirectional communication.

• The interface cable must support bidirectional communication.

• The printer must be connected to the computer using the standard parallel cables and parallel
connectors.

• Under Windows 2000, [Enable bidirectional support] must be selected, and [Enable printer
pooling] must not be selected on the [Port] tab with the RPCS printer driver.

When connected with the network

• DeskTopBinder Lite must be installed, or the Standard TCP/IP port must be used.

• Under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected on the [Ports] tab
with the RPCS printer driver.

If the Standard TCP/IP port is not being used, one of the following conditions must be met in addition
to the two above:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be used.

• The standard TCP/IP port must be used without changing the default port name (for Windows
2000/XP/Vista and Windows Server 2003/2003 R2).
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• When using IPP protocol with the PCL printer driver, the IPP port name must include the IP address.

When connected with USB

The printer must be connected to the computer's USB port using the USB interface cable.

The computer must support bidirectional communication.

• Install SmartDeviceMonitor for Client from the CD-ROM provided.

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

• Under Windows 2000/XP/Vista and Windows Server 2003/2003 R2, Manage Printers permission
is required to change the printer properties in the [Printers] folder. Log on as an Administrators or
Power Users group member.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

When using Windows Vista, click [Control Panel] on the [start] menu, and then click [Printer].

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

4. Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection is enabled. In this
case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

If you are using the PS printer driver, click the [Device Settings] tab.

5. Select options installed from the [Select printer options:] area, and then make the necessary
settings.

6. Select the total amount of the memory in [Total Memory:], when the optional SDRAM module
is added.

7. Under [Paper source tray settings:], click and highlight the tray to be used, and then select
the appropriate size, position, and type for the tray. Select the [Tray locking] check box to
exclude the tray from the targets of automatic tray selection.

8. Click [OK] to close the printer properties dialog box.
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Memory Capacity and Paper Size
Additional memory apart from standard memory may be required depending on the paper size and data
type.

• Available paper sizes change depending on the selection you made for [Memory Usage] in the
System menu.

• Only single-sided printing is possible on paper fed from the bypass tray. Duplex printing is not possible
on paper that is fed from the bypass tray.

The table below shows the total SDRAM module capacities.

Standard Extended Total

192 MB - 192 MB

128 MB*1 128 MB 256 MB

128 MB*1 256 MB 384 MB

*1 Remove the default SDRAM module (64 MB) before installing the optional SDRAM module.

Font Priority

• Only single-sided printing (600 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, Legal, and maximum custom sized paper can be printed on.

• Only single-sided printing (1200 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, Legal, and maximum custom sized paper can be printed on.

• Duplex printing (600 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, and Legal sized paper can be printed on.

• Duplex printing (1200 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, and Legal sized paper can be printed on.

Frame Priority

• Only single-sided printing (600 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, Legal and maximum custom sized paper can be printed on.

Memory Capacity and Paper Size
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• Only single-sided printing (1200 × 600 dpi)

192/256 MB:

• A4, B5 JIS, A5, Letter, and Legal sized paper can be printed on.

• Complex images might fail to print out properly on maximum custom sized paper.

384 MB:

• A4, B5 JIS, A5, Letter, Legal, and maximum custom sized paper can be printed on.

• Duplex printing (600 × 600 dpi)

192/256/384 MB:

• A4, B5 JIS, A5, Letter, and Legal sized paper can be printed on.

• Duplex printing (1200 × 600 dpi)

192 MB:

• B5 JIS and A5 sized paper can be printed on.

• Complex images might fail to print out properly on A4, Letter, and Legal sized paper.

256 MB:

• B5 JIS and A5 sized paper can be printed on.

• Complex images might fail to print out properly on A4, Letter, and Legal sized paper.

384 MB:

• A4, B5 JIS, A5, and Letter sized paper can be printed on.

• Complex images might fail to print out properly on Legal sized paper.

• When printing from bypass tray, duplex printing will not be supported regardless of the memory
capacity, and only one-side will be printed.
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2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

63

2



2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

2. Setting Up the Printer Driver

64

2



• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP

PCL - Accessing the Printer Properties
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1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

2. The [Control Panel] window appears.

3. In "Hardware and Sound", click [Printer].

4. Right-click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

5. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.
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Making printer default settings - printing preferences

• You cannot change the printer default settings for individual user. Settings made in the [Printing
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows Vista Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.

PCL - Accessing the Printer Properties

67

2



RPCS - Accessing the Printer Properties
There are two dialog box types of the [Printer Properties] dialog box. "Multi-tab" is used as an example in
this manual. For details about changing the dialog box types, see the printer driver Help.

Multi-tab

This dialog box type is designed for users who often change print settings to perform various printing
operations.

Custom Setting

This dialog box type is designed for users who rarely change print settings. This type of dialog box
may vary depending on the installed options.

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

This describes how to launch printer driver's properties.
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Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

3. Right-click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

RPCS - Accessing the Printer Properties
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• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Pinter
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".

3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains making printer settings for Windows Vista WordPad as an
example of how to make printer settings for a specific application.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.
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• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.
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PostScript 3 - Setting Up for Printing

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.
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3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.
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1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.
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3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.
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Making Printer Default Settings - Default

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows Vista.

1. On the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name:] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.
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• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Mac OS - Setting Up for Printing

Making Paper Settings from an Application

1. Open the file you want to print.

2. On the [File] menu, click [Page Setup].

3. Check that the printer you want to use is displayed in [Printer:], and then select the paper
size you want to use in [Paper:].

Under Mac OS X, select the paper size in [Paper Size].

If the printer you want to use is not displayed in [Printer:], select the printer you want to use.

4. Configure the settings, and then click [OK].

• The [Page Setup] dialog box varies depending on the application you use. For details, see the manuals
provided with the Mac OS.

Setting up for Printing from an Application

1. Open the file you want to print.

2. On the [File] menu, click [Print].

3. Check that the printer is selected in the [Printer] list, and then make the printer settings.

4. Configure the settings, and then click [OK].

PostScript 3 - Setting Up for Printing
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3. Other Print Operations

Printing a PDF File Directly
You can send PDF files directly to this printer for printing, without having to open a PDF application.

• The function can be used with genuine Adobe PDF files only.

• This function supports version 1.3, 1.4, and 1.5 PDF files.

• Transparency (function of PDF version 1.4) may not be printed.

• PDF files created using Crypt Filter and/or the 16bit color image function of PDF version 1.5 cannot
be printed.

• PDF version 1.6 (Acrobat 7.0) files created without any functions that are exclusive to PDF version
1.6 can be printed.

• Some types of High Compression PDF files may not be printed.

• Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - using DeskTopBinder Lite or by
entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [DeskTopBinder - SmartDeviceMonitor for Client] , and then click [Next >].

5. Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder Lite, restart the computer
and continue the configuration.
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• Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

DeskTopBinder Lite Enhancements

1. On the [Start] menu, point to [Programs], [DeskTopBinder], and then click [Extended
Features Wizard].

2. When [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Function2] screen appears.

3. On the [Printing Function2] screen, click [Add...] to display [PDF Direct Print Properties].

4. Select the driver for this printer, click [OK], and then click [Next >] repeatedly until [Finish]
is displayed.

5. Click [Finish].

Function Palette

1. Right-click the icon that is added to the task bar, and then click [Properties...] to display the
[Properties] screen.

2. Click the [Contents] tab, select the [PDF Direct Print] check box at the center, and then click
[OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

• The Function palette contains buttons for functions that are already configured through DeskTopBinder
Lite enhancement. Using these buttons, you can print Windows files, preview printouts, convert images,
and register scanners for documents without having to open DeskTopBinder Lite. You can also use
these functions simply by dragging a target file to the button corresponding to the required function
and dropping it there.

PDF Direct Printing

1. Drag the PDF file you want to print to the [PDF Direct Print] icon in the palette and drop it
there.

2. [Output File List - PDF Direct Print] is displayed.

Highlight the PDF you want to print, and then click [OK].

The PDF file is printed.

Printing PDF Password-Protected Documents

1. On the [Start] menu, point to [Programs], [DeskTopBinder], and then click [Extended
Features Wizard].

3. Other Print Operations
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2. When [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Function2] screen appears.

3. On the [Printing Function2] screen, click [Properties] to display [PDF Direct Print Properties].

4. Select the [Use PDF Password] check box at the bottom right of the screen, and then click
[OK].

Click [Next>] repeatedly until [Finish] appears.

Click [Finish] to close the [Extended Features Wizard] screen.

5. Move the PDF file you want to print to the [PDF Direct Print] icon on the palette using a drag-
and-drop operation.

6. [Output File List - PDF Direct Print] is displayed.

Select the PDF file you want to output to make it reverse video, and then click [OK].

7. The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password:] field at the bottom right
of the screen, and then click [OK].

The password-protected PDF file is printed.

• Before printing a password-protected PDF file, perform one of the following:

• Enter the PDF password in the [PDF Direct Print Properties] screen

• Specify a PDF password by selecting [PDF: Change PW] in the [PDF Menu] on the control panel
of this printer.

• If a [PDF Group PW] for the [PDF Menu] is assigned to either DeskTopBinder Lite or the control panel
of this printer, a same group password needs to be assigned to the other.

PDF Direct Print Properties
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1. Setting name:

Displays the plug-in configuration name (up to 63 single byte characters)

2. Change Icon...

Change the icon displayed on the tool bar.

3. Printer:

Displays a list of RPCS drivers that support PDF direct printing.

4. Duplex

Print on both sides of sheets.

5. Layout

Print multiple pages on a single sheet.

6. Punch (not selectable on this printer)

Punches holes in printed output.

7. Staple (not selectable on this printer)

Staples printed output together.

8. Display this dialog box before printing

Appears in PDF direct printing mode if this check box is selected.

9. Orientation:

Specify the original's orientation.

10. Number of copies

Specify the number of copies to print.

11. Collate

Use to sort prints.

12. Range:

Specify the print area on each page.

13. Resolution:

Specify a print resolution.

14. PDF Password:

If the PDF file is password-protected, enter the password in this field. Otherwise, the file cannot be printed.

15. Group Password:

If a group password is assigned to DeskTopBinder Lite and this printer, enter the group password in this field.
Otherwise, printing cannot start.

Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands such as "ftp" "sftp" and
"lpr".

3. Other Print Operations
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• p.261 "Printing Files Directly from Windows"
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Unauthorized Copy Control
You can embed patterns and text under printed text to prevent unauthorized copying of the document.
Unauthorized Copy Control consists of two functions: [Data security for copying] and [Mask type:].

• This function is designed to discourage copying of confidential documents; it does not prevent
unauthorized use of information.

• This function can be used with the RPCS printer driver.

Opening the Unauthorized Copy Control Window

1. In the RPCS printer driver, open the [Printing Preferences] window.

2. Click [Add/Change Custom Settings...].

3. Select the [Unauthorized copy...] check box.

4. Click [Control Settings...].

5. A confirmation message appears. Click [OK].

The Unauthorized Copy Control window appears.

• For details, see the printer driver Help.

Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

Setting [Data security for copying] in the printer driver

• Select the [Data security for copying] checkbox. You can also enter the text in the [Text:] box.

• You cannot select the [Mask type:] checkbox at the same time.

• To print a document protected by gray overprint, the printer must be set up correctly. Consult an
administrator.

3. Other Print Operations
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Printing a document using [Data security for copying]
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1. The pattern and text you have set is printed.

2. The document is copied in copiers/multifunction machines which the supplier's optional Copy
Data Security unit is installed.

3. The document is blanked by gray overprint.

• When printing a document that is set with [Data security for copying], the printer does not require the
optional Copy Data Security unit to be installed. The Copy Data Security unit is required when copying
or storing a document protected by gray overprint.

• Only the RPCS printer driver is supported.

• You cannot partially embed a pattern and text in a document.

• Use 182 × 257 mm (71/4×101/2 in.) or larger paper.

• Use ordinary or recycled paper of at least 70% whiteness.

• Duplex printing may interfere with this function as a result of text and patterns being visible through
the paper.

• The optional Copy Data Security Unit is for the supplier's copiers/multifunction machines. It cannot
be installed on this printer.

• For details about setting [Data security for copying], see the printer driver Help.

Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver to prevent unauthorized
copying.

Unauthorized Copy Control
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Setting [Mask type:] in the printer driver

• Select a pattern from [Mask type:], and then enter text in the [Text:] box.

• You can set only [Text:], but [Mask type:] and [Text:] must be set together.

Printing a document using [Mask type:]

AJL031S

1. The pattern and text you have set is printed palely.

2. The document is copied in copiers/multifunction machines.

3. The pattern and text you have set appear clearly.

• Only the RPCS printer driver is supported.

• You cannot partially embed patterns and text strings in a document.

• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.

• Printing with background patterns and text may be slower than normal printing.

• For details about setting [Mask type:], see the printer driver Help.
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Important Notice

• The supplier does not provide warranty regarding the appearance of print patterns and other copy
protection features. The appearance of the print patterns and the performance of Unauthorized Copy
Control may vary depending on the quality of paper used and the printer model and settings.

• The supplier takes no responsibility for any damages sustained in connection with use of or inability
to make use of Unauthorized Copy Control print patterns.

Unauthorized Copy Control
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Sample Print
Use this function to print only the first set of a multiple-set print job. After you have checked the result,
remaining sets can be printed or canceled using the printer's control panel. This can reduce misprints due
to mistakes in content or settings.

• To use this function, the optional hard disk must be installed on the printer.

• A Sample Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 1,000 pages in total.

• If a Sample Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Del.
Temp] or [Auto Del. Stored] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Sample Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's [Print] dialog box, more prints than intended may be produced.

• If the first set of the Sample Print files is not as you expected and you do not want to print remaining
sets, delete the Sample Print file using the display panel. If you print the remaining sets of the Sample
Print file, the job in the printer is deleted automatically.

• Sample Print files printed or deleted using Web Image Monitor, after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• p.111 "Checking the Error Log"

• p.141 "System Menu"
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Printing the First Set

The following procedure describes how to print a Sample Print file with the PCL 6/5e and the RPCS printer
driver. For information about how to print a Sample Print file with the PostScript 3 printer driver, see Postscript
3 Supplement.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. From an application, select a command to print.

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

3. In the [Job Type:] box, click [Sample Print].

When printing with the PostScript 3 printer driver, click [Sample Print] in the [Job Type:] box on the
[Job Log] tab.

4. Click [Details...], and then enter a User ID in the [User ID:] box.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

5. Execute a command to print.

Make sure to set more than two copies.

The Sample Print job is sent to the printer, and the first set is printed.

Printing the Remaining Sets

Printing a selected Sample Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

5. Enter the number of sets you want to print using the [ ] or [ ] keys.

You can enter up to 999 sets.

Sample Print
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If the number of sets to be printed is not specified, one less set than the smallest number specified on
the machine is printed for every selected document. If the smallest number of sets specified on the
machine is "1", one set each is printed for every document.

To cancel printing, press the [Escape] key.

6. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.

Printing all Sample Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print All File], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to print, and then press the [  Enter]
key.

5. The number of documents selected for printing is displayed. Check the number, and if it is
correct, press the [  Enter] key.

6. Enter the number of sets you want to print using the [ ] or [ ] keys.

You can enter up to 999 sets.

If the number of sets to be printed is not specified, one less set than the smallest number specified on
the machine is printed for every selected document. If the smallest number of sets specified on the
machine is "1", one set each is printed for every document.

To cancel printing, press the [Escape] key.

7. Press the [  Enter] key.

The "To print, press [ESC] 1 - 4 times" message appears. Then the file selection screen reappears.

8. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

3. Other Print Operations

92

3



Deleting Sample Print Files

If you are not satisfied with the sample printout, you can delete the Sample Print file, revise it and print it
again until the settings are suitable.

Deleting a selected Sample Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Sample Print file, press the [Escape] key.

5. Check the file you want to delete is displayed, and then press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.

Deleting all Sample Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to delete, and then press the [
Enter] key.

To cancel deleting a Sample Print file, press the [Escape] key.

5. The number of documents selected for deletion is displayed. Check the number, and if it is
correct, press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.

Sample Print
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Locked Print
Use this function to maintain privacy when printing confidential documents on the printer over a shared
network. Usually, it is possible to print data using the display panel once it is stored in this printer. When
using Locked Print, it is not possible to print unless a password is entered on the printer's display panel.
Your confidential documents will be safe from being viewed by other people.

• To use this function, the optional hard disk must be installed on the printer.

• A Locked Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 1,000 pages in total.

• If a Locked Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents remain. However, the [Auto Del. Temp] or [Auto
Del. Stored] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. Locked
Print jobs are automatically collated by the printer driver as default. If a collate option is selected in
the application print dialog box, more sets than intended may be printed.

• After the Locked Print file is printed, the job is automatically deleted.

• Locked Print files printed or deleted using Web Image Monitor, after you select [Locked Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Locked Print files.

• p.111 "Checking the Error Log"

• p.141 "System Menu"

Sending a Locked Print File

The following procedure describes how to print a Locked Print file with the PCL 6/5e and the RPCS printer
driver. For information about how to print a Locked Print file with the PostScript 3 printer driver, see Postscript
3 Supplement.

• Applications with their own drivers, such as PageMaker, do not support this function.
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1. From an application, select a command to print.

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. In the [Job Type:] box, click [Locked Print].

When printing with the PostScript 3 printer driver, click [Locked Print] in the [Job Type:] box on the
[Job Log] tab.

4. Click [Details...], and then enter a User ID in the [User ID:] box.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

5. In the [Password:] box, enter a four to eight digit password (0-9).

6. Execute a command to print.

The job is saved on the hard disk.

Printing a Locked Print File

Printing a selected Locked Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

The password screen appears.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

Check that the file you want to print is displayed

To cancel printing, press the [Escape] key.

6. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.

Locked Print
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Printing all Locked Print file

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print All File], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to print, and then press the [  Enter]
key.

The password screen appears.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

6. The number of documents selected for printing is displayed. Check the number, and if it is
correct, press the [  Enter] key.

The printer prints files that correspond to the entered password. The number of files to be printed is
displayed on the confirmation screen.

The printer prints documents that correspond to the entered password. To print documents that do not
correspond to the entered password, repeat the procedure and specify the appropriate password.

7. Check the file you want to print is displayed, and then press the [  Enter] key.

The "To print, press [ESC] 1 - 4 times" message appears. Then the file selection screen reappears.

8. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• You can change a password after sending files to the printer using Web Image Monitor. For details
about changing the password, consult your administrator.

Deleting Locked Print Files

Deleting a selected Locked Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.
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3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

The password screen appears.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

6. Check the file you want to delete is displayed, and then press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.

Deleting all Locked Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to delete, and then press the [
Enter] key.

The password screen appears.

To cancel deleting a Locked Print file, press the [Escape] key.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

The printer deletes files that correspond to the entered password. The number of files to be deleted is
displayed on the confirmation screen.

The printer deletes documents that correspond to the entered password. To delete documents that do
not correspond to the entered password, repeat the procedure and specify the appropriate password.

6. The number of documents selected for deletion is displayed. Check the number, and if it is
correct, press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.
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Hold Print
Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's control
panel later.

• To use this function, the optional hard disk must be installed on the printer.

• A Hold Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 1,000 pages in total.

• If a Hold Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Del.
Temp] or [Auto Del. Stored] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Hold Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Hold Print files printed or deleted using Web Image Monitor, after you select [Hold Print] using the
control panel will appear on the display panel. However, an error message will appear if you try to
print or delete those Hold Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily. If you enter the
document name on the printer driver's [Details...], that name appears on the display panel.

• The document name can be set for Hold Print Files, but they are not mandatory.

• p.111 "Checking the Error Log"

• p.141 "System Menu"

Hold Print Job to the Printer

The following procedure describes how to print a Hold Print file with the PCL 6/5e and the RPCS printer
driver. For information about how to print a Hold Print file with the PostScript 3 printer driver, see Postscript
3 Supplement.
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• Applications with their own drivers, such as PageMaker, do not support this function.

1. From an application, select a command to print.

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. In the [Job Type:] box, click [Hold Print].

When printing with the PostScript 3 printer driver, click [Hold Print] in the [Job Type:] box on the [Job
Log] tab.

4. Click [Details...], and then enter a User ID in the [User ID:] box.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

You can also set a file name.

5. Execute a command to print.

Make sure to set more than two copies.

The Hold Print job is sent to the printer.

Printing a Hold Print File

Printing a selected Hold Print file only

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] to display key [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] to display key [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

To cancel printing, press the [Escape] key.

5. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

Hold Print
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6. Press the [Online] key.

The initial screen appears.

Printing all Hold Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print All File], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to print, and then press the [  Enter]
key.

5. The number of documents selected for printing is displayed. Check the number, and if it is
correct, press the [  Enter] key.

6. Check the file you want to print is displayed, and then press the [  Enter] key.

The "To print, press [ESC] 1 - 4 times" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file is deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file is deleted.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a Hold
Print file from Web Image Monitor. For details, see Web Image Monitor Help.

Deleting Hold Print Files

Deleting a selected Hold Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.
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4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Hold Print file, press the [Escape] key.

5. Check the file you want to delete is displayed, and then press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.

Deleting all Hold Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to delete, and then press the [
Enter] key.

To cancel deleting a Hold Print file, press the [Escape] key.

5. The number of documents selected for deletion is displayed. Check the number, and if it is
correct, press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.
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Stored Print
Use this function to store a file in the printer, and then print it from the computer or the printer's control panel
later. Jobs are not deleted after they are printed, so the same job need not be resent in order to print multiple
copies.

• To use this function, the optional hard disk must be installed on the printer.

• A Stored Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 1,000 pages in total.

• If a Stored Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents remain. However, the [Auto Del. Temp] or [Auto
Del. Stored] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Stored Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Stored Print files deleted using Web Image Monitor, after you select [Stored Print] using the control
panel will appear on the display panel. However, an error message will appear if you try to delete
those Stored Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• If you enter the document name on the printer driver's [Details...], that name appears on the display
panel.

• A password and document name can be set for Stored Print Files, but they are not mandatory.

• p.111 "Checking the Error Log"

• p.141 "System Menu"
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Stored Print Job to the Printer

The following procedure describes how to print a Stored Print file with the PCL 6/5e, RPCS and Postscript
3 printer driver. For information about how to print a Stored Print file with the PostScript 3 printer driver,
see Supplement included.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. From an application, select a command to print.

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

3. Start printing from the application's [Print] dialog box.

You can select two ways for Stored Print:

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Store and Normal Print] (or [Stored and Print])

Prints the file at once and also stores the file in the printer.

For details about configuring the printer drivers, see the relevant Help files.

4. Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a password. The same password must be entered when printing or deleting.

You can set a file name.

5. Execute a command to print.

The Stored Print job is sent to the printer and stored.

Printing a Stored Print File

Printing a selected Stored Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

To cancel printing, press the [Escape] key.

Stored Print
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4. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

If you set a password in the printer driver, a password confirmation screen appears. Enter the
password.

5. Enter the number of sets you want to print using the [ ] or [ ] keys.

You can enter up to 999 sets.

If the number of sets to be printed is not specified, one less set than the smallest number specified on
the machine is printed for every selected document. If the smallest number of sets specified on the
machine is "1", one set each is printed for every document.

To cancel printing, press the [Escape] key.

6. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

7. Press the [Online] key.

The initial screen appears.

Printing all Stored Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Print All File], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to print, and then press the [  Enter]
key.

5. The number of documents selected for printing is displayed. Check the number, and if it is
correct, press the [  Enter] key.

6. Enter the number of sets you want to print using the [ ] or [ ] keys.

You can enter up to 999 sets.

If the number of sets to be printed is not specified, one less set than the smallest number specified on
the machine is printed for every selected document. If the smallest number of sets specified on the
machine is "1", one set each is printed for every document.

To cancel printing, press the [Escape] key.

7. Press the [  Enter] key.

The "To print, press [ESC] 1 - 4 times" message appears. Then the file selection screen reappears.

8. Press the [Online] key.

The initial screen appears.
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• The machine prints files that correspond to the entered password and files that do not require a
password.

• To stop printing after printing has started, press the [Job Reset] key. A Stored Print file is not deleted
even if the [Job Reset] key is pressed.

• The Stored Print file that sent to the printer is not deleted unless you delete a file or select [Auto Del.
Stored].

• You can change a password after sending files to the printer using Web Image Monitor. For details
about changing the password, consult your administrator.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a
Stored Print file from Web Image Monitor. For details, see Web Image Monitor Help.

• p.141 "System Menu"

Deleting Stored Print Files

Deleting a selected Stored Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Stored Print file, press the [Escape] key.

If you set the password in the printer driver, enter the password to delete.

If you forget your password, ask your administrator for help.

5. Check the file you want to delete is displayed, and then press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.
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Deleting all Stored Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID when the job was stored appear.

4. Press the [ ] or [ ] key to display the user ID you want to delete, and then press the [
Enter] key.

To cancel deleting a Stored Print file, press the [Escape] key.

If you set the password in the printer driver, enter the password to delete.

If you forget your password, ask your administrator for help.

5. The number of documents selected for deletion is displayed. Check the number, and if it is
correct, press the [  Enter] key.

The "Deleted" message appears. Then the file selection screen reappears.

6. Press the [Online] key.

The initial screen appears.

• If a password is assigned to the file, the password screen appears. Enter the password. The machine
deletes files that correspond to the entered password and files that do not require a password. To
delete files that do not correspond to the entered password, repeat the procedures and specify the
appropriate password.
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Form Feed
This section gives instructions for operating the printer when there is no tray for the selected paper size or
type, or when paper loaded in the printer has run out.

• The tray cannot be changed if the following functions are set:

• Duplex Print from a tray that does not support duplex printing

• Cover Sheet

• Slip Sheet

• If form feed is selected for a tray with the following settings, you can change the tray by canceling
the settings:

• Duplex Print

• p.141 "System Menu"

Printing from a Selected Tray

If the printer does not have a tray for the selected paper size or paper type, or if the selected paper loaded
in the printer has run out, a caution message appears. If this message appears, do the following procedure.

1. Press the [Form Feed] key, and then select the paper tray on the screen.

2. Press the [  Enter] key.

The job is printed from the selected tray.

• If a tray with a smaller paper size is selected, the print job may be cut short, or other problems may
occur.

Form Feed
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Canceling a Print Job
You can cancel printing from either the printer or a client computer. Since canceling procedures vary
depending on the print job status, check the job status and cancel printing according to the following
procedure.

Windows - Canceling a Print Job

• When the printer is connected to multiple computers, be careful not to accidentally cancel other users'
print jobs.

If the print job you want to cancel is being printed

1. Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the Data In indicator is lit
or blinking.

2. Press the [Job Reset] key.

The "Job Reset?" screen appears.

3. Select the current job or all jobs (including the current job) using the [ ] or [ ] key.

It is also possible to annul the cancellation. Printing resumes if you select [Resume Print], and then
press the [  Enter] key.

4. Press the [  Enter] key.

A confirmation message appears.

Printing resumes if you press the [Escape] key after the message appears.

5. Press the [  Enter] key.

The job is canceled. When the cancellation procedure is complete, a message appears.

• A print job that contains a large volume of data may take considerable time to cancel.

• If printing resumes after being canceled, the period of time set for [I/O Timeout] is too short. Set a
longer period of time for [I/O Timeout] on the [Host Interface] menu.

If the print job you want to cancel is not being printed

1. Double-click the printer icon on the Windows task tray.

A window appears showing all print jobs that are currently queuing to be printed. Check the current
status of the job you want to cancel.
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You can also open the print job queue window by double-clicking the printer icon in the [Printer]
window.

2. Select the name of the job you want to cancel.

3. On the [Document] menu, click [Cancel Printing].

• When this printer is used as a network printer, other users' print jobs cannot be canceled from a client
computer.

• Clicking [Purge Print Documents] on the [Printer] menu deletes all currently queued print jobs.
However, when this printer is used as a network printer, print jobs from other users' computer cannot
be canceled from a client computer.

• When the print job you selected starts printing, it takes some time before the print job disappears from
the printer window.

Mac OS - Canceling a Print Job

• When the printer is connected to multiple computers, be careful not to accidentally cancel other users'
print jobs.

If the print job you want to cancel is being printed

1. Check if the print job you want to cancel is currently being printed.

While the print job may not be being printed, the printer is receiving data if the Data In indicator is lit
or blinking.

2. Press the [Job Reset] key.

The "Job Reset?" screen appears.

3. Select the current job or all jobs (including the current job) using the [ ] or [ ] key.

It is also possible to annul the cancellation. Printing resumes if you select [Resume Print], and then
press the [  Enter] key.

4. Press the [  Enter] key.

A confirmation message appears.

Printing resumes if you press the [Escape] key after the message appears.

5. Press the [  Enter] key.

The job is canceled. When the cancellation procedure is complete, a message appears.

• A print job that contains a large volume of data may take considerable time to cancel.

Canceling a Print Job
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• To secure enough time for sending a command to cancel printing, set a long period of time in [I/O
Timeout] on the [Host Interface] menu.

If the print job you want to cancel is not being printed

1. Double-click the printer icon on the desktop.

A window appears showing all print jobs that are currently queuing to be printed. Check the current
status of the job you want to cancel.

Under Mac OS X, start Print Center.

2. Select the name of the job you want to cancel.

3. Click the pause icon, and then click the trash icon.

• When this printer is used as a network printer, other users' print jobs cannot be canceled from a client
computer.

3. Other Print Operations

110

3



Checking the Error Log
If files could not be stored due to printing errors, identify the cause of the errors by checking the error log
on the control panel.

• The most recent 30 errors are stored in the error log. If a new error is added when there are 30 errors
already stored, the oldest error is deleted. However, if the oldest error belongs to one of the following
print jobs, it is not deleted. The error is stored separately until the number of those errors reaches 30.
You can check any of these print jobs for error log information.

• Sample Print

• Locked Print

• Hold Print

• Stored Print

• If the main power switch is turned off, the log is deleted.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display the print type you want to check, and then press the [
Enter] key.

3. Press the [ ] or [ ] key to display [Error File(s)], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to check the log.

• Press the [Online] key until the initial screen appears after checking the log.

• To print files that appear in the error log, resend them after stored files have been printed or deleted.

Checking the Error Log
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Collate
The Collate function allows you to print while sorting printouts into page-ordered sets, such as when printing
multiple copies of meeting materials.

• Up to 100 pages can be sorted using RAM. If the optional hard disk drive is installed, up to 1,000
pages can be sorted.

Output can be assembled as sets in sequential order.

• If Auto Continue occurs on the first set, Collate will be canceled.

• If forced printing occurs on the first set, Collate will be canceled.

• When setting Collate in the printer driver settings, make sure that a collate option is not selected in
the application's print settings. If a collate option is selected, printing will not be as intended.

• For details about printing method, see the printer driver Help.
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Spool Printing
With Spool Printing, the print data is saved in the hard disk before printing. To use this function, set it from
the menu. See Remote Maintenance by telnet.

• Use the "spoolsw clear job" telnet command to clear a spooled print job. Do not turn off the printer
or computer while a print job is being spooled and the Data In is flashing. Print jobs that are interrupted
in this way remain on the printer's hard disk and will finish printing out when the printer is turned back
on.

• The Spool Printing function is available when the optional hard disk is installed.

• The Spool Printing function is available for data received using diprint, lpr, ipp and ftp (TCP/IP (IPv6)).

• When using diprint, the Spool Printing function cannot be used with bidirectional communication.

• The domain reserved for spool printing is about 1 GB.

• Up to 150 jobs can be spool printed at a time.

• When Spool Printing is on, the size of a single print job cannot exceed 500 MB.

• When receiving jobs from multiple computers, the printer can spool a maximum of ten lpr jobs, and
only one diprint, ipp, ftp, sftp, or smb job. If the printer's spooling capacity is exceeded, newer jobs
cannot be printed. You must wait before sending further jobs.

• Printing the first page with Spool Printing will be slow.

• The computer requires less print processing time when large amounts of data are spooled.

• Stored spool jobs can be viewed or deleted using Web Image Monitor.

• The list of spool jobs cannot be viewed from the printer's control panel.

• p.188 "Remote Maintenance by telnet"

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

• Using Web Image Monitor

In [System] on the [Configuration] menu, click [Active] in [Spool Printing].

• Using telnet

Enter "spoolsw spool on".

Spool Printing
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• p.188 "Remote Maintenance by telnet"

• p.163 "Using Web Image Monitor"

• Web Image Monitor Help

Viewing or Deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image Monitor.

1. Open a Web browser.

2. Enter "http://(printer's address)/" in the address bar to access the printer whose settings
you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The window for entering the login user name and password appears.

4. Enter the login user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the menu area, click [Job].

A submenu will appear.

6. On the [Printer] menu, click [Spool Printing].

A list of spooled jobs appears.

7. To delete a job, select the check box of the job you want to delete, and then click [Delete].

The selected job is deleted.

8. Click [Logout].

9. Quit Web Image Monitor.

• p.163 "Using Web Image Monitor"

• Web Image Monitor Help
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Cover
Using this function, you can insert cover fed from a different tray to that of the main paper, and print on
them.

• To use this function, Collate must be set.

• The cover sheets should be the same size and orientation as the body of the paper.

Cover sheet

Prints the first page of the document on the sheet for the cover page.

• Print on one side

Prints on one side of the cover sheet only, even when duplex printing is selected.

AEV016S

• Print on both sides

Prints on both sides of the cover sheet when duplex printing is selected.

• Cover sheet printed on both sides

AEV017S

• Cover sheet printed on one side

AEV032S

• Blank

• When printing one side

Cover
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AEV018S

• When printing both sides

AEV033S

• If Auto Tray Select is set for the body paper feed tray, body paper will be delivered from a tray that
contains paper set in portrait orientation. Therefore, if the cover paper is set to landscape orientation,
the orientation of the cover and body paper will be different.

• For printing methods, see the printer driver Help.
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Slip Sheets
This section explains the Slip Sheet Function that inserts a slip sheet between each page. When this function
is enabled, paper is fed alternately from two trays.

• This function is available only if two or more paper trays are installed on the machine.

• When duplex or cover printing is set, you cannot insert slip sheets.

Inserting a slip sheet between each page

• Print

AEV019S

• Blank

AEU023S

Inserting a slip sheet between OHP transparencies

• Print

AEV020S

• Blank

Slip Sheets
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AEU024S

• Collate cannot be set when using slip sheets.

• The slip sheet should be the same size and orientation as the main paper.

• If "Auto Tray Select" has been set as the paper feed tray for the body paper, the paper will be delivered
from a tray containing paper in  orientation. Therefore, when the cover paper has been set to 
orientation, the orientation of the output cover paper and body paper will be different.

• The same paper feed tray cannot be set for the main paper and slip sheets.
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4. Using Paper Types that Have Unique
Names

From Registration of User Paper Types to Use
This section explains the procedures for selecting the paper type according to usage, registering the paper
type under a unique name, and printing a file using the registered paper type.

• This function can be used

• when the machine is operating in a network,

• in conjunction with the RPCS printer driver, and

• under Windows 2000 or higher (under earlier systems, registered paper types appear as [Plain]
in the printer driver).

• This function cannot be used

• with the printer driver's [Save/Restore Settings] function (registered paper types appear as
[Plain] in the printer driver) and

• if the machine and computer are not using bi-directional communication.

• Also, be aware that

• the printer driver might not display the paper type name correctly if it is registered using an
unsupported language,

• the control panel might not display the paper type name correctly if it is registered using non-
alphanumeric characters (i.e., other than a-z, A-Z, or 0-9), and

• the machine's logs do not record names of user paper types.

The example below explains setting a custom size paper under the name "Invoice A" and feeding it from
a bypass tray.

1. Using Web Image Monitor, register the name under [User Paper Type].

• Enter "Invoice A" for [Paper Name] and select [Plain Paper] for [Paper Type].

• When printing a file, the paper type is automatically set by selecting [User Paper Types] on the
printer driver setting screen.

• For details about this procedure, see p.121 "Registering Names to Paper Types".

2. In Web Image Monitor, set [User Paper Type] for the bypass tray.

• Set [Paper Type] for the tray to "Invoice A".

• For details about this procedure, see p.122 "Setting User Paper Types to Trays".

3. Load the paper you want to use on the bypass tray.
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• Set an unprinted paper on the bypass tray.

• For details about this procedure, see "Loading Paper", Hardware Guide.

4. Using RPCS Printer Driver, print a document on the registered custom size paper.

• Select [Invoice A] for [Paper type:], then proceed with the printing. When [Paper type:] is set to
[Invoice A], Plain paper that is suitable for "Invoice A" is selected automatically. Registering a
descriptive name makes selecting a paper type from the [Paper type:] list easier.

• For details about this procedure, see p.123 "Printing Using Registered Paper Types".

• You can register up to eight user paper types.

4. Using Paper Types that Have Unique Names
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Registering Names to Paper Types
Log on to Web Image Monitor in the administrator mode.

• The control panel might not display the paper type name correctly if it is registered using non-
alphanumeric characters (i.e., other than a-z, A-Z, or 0-9).

1. Start your Web browser.

2. Enter "http://(printer's address)/" in the address bar of the Web browser.

The Top of Web Image Monitor appears.

If the printer's host name has been registered on the DNS or WINS server, you can enter it in the
address bar.

If SSL (encrypted HTTP) is running in a server authentication environment, enter "https://(printer's
address)".

3. On the Top Page, click [Login].

A dialog box for entering the user name and password appears.

4. Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

5. In the menu area, click [Configuration].

6. On the [Device Settings], click [User Paper Type], and then change the settings as necessary.

The screen for selecting [User Paper Type] appears.

7. Make changes to the following settings:

Paper Name: Enter a descriptive name for easier recognition.

Paper Type: Select a suitable paper type from the list.

The example below is for printing invoices.

• Enter "Invoice A" for [Paper Name].

• Select [Plain Paper] for [Paper Type]. If the setting is incorrect, the paper might become jammed
or print quality could be affected.

• For details about combinations of paper sizes types, paper type, see "Types of Paper and Other
Media", Hardware Guide.

8. Click [OK].

• You can register up to eight user paper types.

Registering Names to Paper Types
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Setting User Paper Types to Trays
Before printing, set the paper registered on the user paper type to the paper tray, and then set the paper
type already registered. Paper types can be set either from Web Image Monitor or from the printer's control
panel.

1. Log on to Web Image Monitor in administrator mode.

2. In the menu area, click [Configuration].

3. On the [Device Settings], click [Paper].

4. Set the paper tray you want to use as a user paper type, and then select the registered paper
type.

The example below is for printing invoices.

The registered paper type "Invoice A" is displayed as [+ Invoice A (Custom x)] on this screen. Select
[+ Invoice A (Custom x)] for [User Paper Type]. Make the appropriate changes to other settings as
required.

5. Click [OK].

6. Click [Logout].

7. Quit Web Image Monitor.

• For details about loading paper, see "Loading Paper", Hardware Guide.

• For details about setting the paper type from control panel, see "Specifying a Paper Type for Tray 1
and the Optional Paper Feed Unit" and "Specifying a Paper Type for the Bypass Tray", Hardware
Guide.
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Printing Using Registered Paper Types
Select a registered paper type to print onto.

• This function can be used when the machine is operating in a network, in conjunction with the RPCS
printer driver, and under Windows 2000 or higher (under earlier systems, registered paper types
appear as [Plain] in the printer driver).

• This function cannot be used with the printer driver's [Save/Restore Settings] function (registered paper
types appear as [Plain] in the printer driver) and if the machine and computer are not using bi-
directional communication.

• Also, be aware that the printer driver might not display the paper type name correctly if it is registered
using an unsupported language, the control panel might not display the paper type name correctly
if it is registered using non-alphanumeric characters (i.e., other than a-z, A-Z, or 0-9), and the
machine's logs do not record names of user paper types

1. Select your application's print command.

2. On the tab in the properties dialog box that appears, select a registered paper type under
[Paper type:].

If you select Custom Setting, click the [Print Settings] tab.

3. Execute the print command.

The preregistered settings are applied and print is performed.

• For details about printer driver settings, see the printer driver Help.

Printing Using Registered Paper Types
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5. Making Printer Settings Using the
Control Panel

Menu Chart
This section explains how to change the default settings of the printer and provides information about the
parameters included in each menu.

Sample Print

Menu

Print One File

Print All Files

Delete One File

Del. All Files

Error File(s)

• This menu appears only if the optional hard disk is installed.

Locked Print

Same as the [Sample Print] menu.

Hold Print

Same as the [Sample Print] menu.

Stored Print

Same as the [Sample Print] menu.

Paper Input

Menu

Bypass Size

Tray Paper Size

Paper Type

Duplex Setting
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Menu

Aut.Tray Select

Tray Priority

• [Duplex Setting] appears when the optional duplex unit is installed.

List/Test Print

Menu

Multiple Lists

Config. Page

Error Log

Network Summary

Menu List

PCL Config.Page

PS Config. Page

PDF Config.Page

Hex Dump

Maintenance

Menu

Image Density

Registration

Curl Prevention

Del. All Temp

Del. All Stored

HD Format

Date/Time

5. Making Printer Settings Using the Control Panel
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Menu

WL.LAN Signal

WL.LAN Defaults

Panel Key Sound

Warm-Up Beeper

• [Del. All Temp] [Del. All Stored] [HD Format] appear when the optional hard disk is installed.

• [WL.LAN Signal] and [WL.LAN Defaults] appear when the optional wireless LAN interface unit is
installed.

System

Menu

Prt. Err Report

Auto Continue

Memory Overflow

Copies

Printer Lang.

Sub Paper Size

Page Size

Edge-Edge Print

Def.Print Lang.

Duplex

Blank Pages

Rotate 180 Deg.

Energy Saver

Auto Reset Time

Auto Del. Temp

Menu Chart
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Menu

Auto Del.Stored

Memory Usage

Unit of Measure

Edge Smoothing

Toner Saving

Spool Printing

Letterhead Mode

Bypass Priority

Auto Tray SW

RAM Disk

Auto Email Ntfy

• [Auto Del. Temp] [Auto Del.Stored] [Spool Printing] appear when the optional hard disk is installed.

• [RAM Disk] will not appear when the optional hard disk is installed.

Host Interface

Menu

I/O Buffer

I/O Timeout

Network Setup

IEEE 802.11b

Fixed USB Port

• [Network Setup] appears when the optional Ethernet interface unit or wireless LAN interface unit is
installed.

• [IEEE 802.11b] appears when the optional wireless LAN interface unit is installed.
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PCL Menu

Menu

Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Courier Font

Ext. A4 Width

Append CR to LF

Resolution

PS Menu

Menu

Data Format

Resolution

PDF Menu

Menu

PDF: Change PW

PDF Group PW

Resolution

Menu Chart
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Language

Menu

English

German

French

Italian

Dutch

Swedish

Norwegian

Danish

Spanish

Finnish

Portuguese

Czech

Polish

Hungarian

5. Making Printer Settings Using the Control Panel

130

5



Paper Input Menu
This section explains about paper settings on the Paper Input menu such as paper sizes and types on each
tray.

Changing the Paper Input Menu

Auto Tray Select

Follow the procedure below to set Aut.Tray Select.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Aut.Tray Select], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to display the tray you want to select, and then press the [  Enter]
key.

5. Press the [ ] or [ ] key to display [On], and then press the [  Enter] key.

Wait two seconds. The [Aut.Tray Select] screen appears.

6. Press the [Online] key.

The initial screen appears.

Tray Priority

Follow the procedure below to change the tray priority.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Tray Priority], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to select a tray you want to use, and then press the [  Enter] key.

Wait two seconds. The [Paper Input] screen appears.

5. Press the [Online] key.

The initial screen appears.
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Paper Input Menu Parameters

This section explains about parameters that can be set on the Paper Input menu.

Bypass Size

You can specify the paper size for Bypass Tray.

A4 (210×297), A5 (148×210): Vert., A5 (148×210): Horiz., A6 (105×148), B5 JIS (182×257),
C5 Env (162×229), C6 Env (114×162), DL Env (110×220), 81/2"×14", 81/2"×13", 81/2"×11",
81/4"×13", 8"×13", 71/4"×101/2", 51/2"×81/2": Vert., 51/2"×81/2": Horiz., 41/8"×91/2",
37/8"×71/2", 16K (195×267), Custom Size

81/2" ×14", 81/2" ×13", 81/2" ×11", 81/4"×13", 8"×13", 71/4"×101/2", 51/2" ×81/2": Vert.,
51/2" ×81/2": Horiz., 41/8"×91/2", 37/8"×71/2", A4 (210×297), A5 (148×210): Vert., A5
(148×210): Horiz., A6 (105×148), B5 JIS (182×257), C5 Env (162×229), C6 Env (114×162),
DL Env (110×220), 16K (195×267), Custom Size

•  Default: A4 (210×297)

•  Default: 81/2" ×11"

• JIS stands for "Japanese Industrial Standard".

Tray Paper Size

Tray 1

You can specify the paper size for Tray 1.

A5 (148×210): Horiz., 81/2"×13", 81/4" ×13", 8" ×13", 51/2" ×81/2": Horiz., 16K
(195×267), Custom Size

81/2"×13", 81/4"×13", 8"×13", 51/2"×81/2": Horiz., A5 (148×210): Horiz., 16K
(195×267), Custom Size

•  Default: A5 (148×210): Horiz.

•  Default: 8"×13"

Tray 2, Tray 3

You can specify the paper size for Tray 2 and Tray 3.
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C5 Env (162×229), C6 Env (114×162), DL Env (110×220), 81/2"×13", 81/4"×13", 8"×13",
71/4"×101/2", 41/8"×91/2", 37/8"×71/2", 16K (195×267), Custom Size

81/2"×13", 81/4"×13", 8"×13", 71/4"×101/2", 41/8"×91/2", 37/8"×71/2", C5 Env
(162×229), C6 Env (114×162), DL Env (110×220), 16K (195×267), Custom Size

•  Default: Custom Size

•  Default: 8"×13"

Paper Type

Tray 1

Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Preprinted, Thick Paper,
Custom Type 1-8

• Default : Plain Paper

• For details about the type of paper loaded in each tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result
might not be proper.

Tray 2, Tray 3

Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Envelope, Preprinted,
Thick Paper, Custom Type 1-8

• Default : Plain Paper

• For details about the type of paper loaded in each tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result
might not be proper.

Bypass Tray

Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Transparency, Envelope,
Preprinted, Thick Paper, Custom Type 1-8

• Default : Plain Paper

• For details about the type of paper loaded in each tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result
might not be proper.

Duplex Setting

Whether duplex printing is done in each tray is set.
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• Duplex

• Do not duplex

• Default : Duplex

Aut.Tray Select

You can select whether to assign each tray to automatically print the paper size and type set by printer
driver.

• Default : On

• When using custom size paper, if [On] is selected in [Aut.Tray Select], the size selected on the
control panel has priority, if [Off] is selected, the size selected from the printer driver has priority.

• Only installed trays appear on the display panel.

• You can select multiple trays.

• If you need to have a tray locked, you must select the tray using both printer driver and control
panel.

Tray Priority

You can set a tray to be checked first when [Aut.Tray Select] is selected from the printer driver. The
tray selected here is used when no tray is selected for a print job.

• Default : Tray 1

• Only installed trays appear on the display panel.

• It is recommended that you load paper of the size and orientation you use most frequently in the
tray selected in [Tray Priority].
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List/Test Print Menu
You can print lists of configurations on printer or the paper printings.
Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

• The configuration page is printed on A4 or Letter (81/2"×11") size paper, so load them in the same
paper tray.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [List/Test Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Config. Page], and then press the [  Enter] key.

The configuration page is printed. The [List/Test Print] menu screen returns on completion of printing.

4. Press the [Online] key.

The initial screen appears.

Interpreting the Configuration Page

System Reference

Printer ID

The serial number assigned to the board by its manufacturer is displayed.

Pages Printed

The total number of pages printed by the printer to date is displayed.

Firmware Version

• Firmware

The version number of the printer controller firmware is displayed.

• Engine

The version number of the printer engine firmware is displayed.

• NCS

The version number of the network interface board is displayed.
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Device Connection

The items are displayed when the device options are installed.

HDD:Font/Macro Download

You can print the hard disk status when the optional hard disk when the optional hard disk is
installed.

Printer Language

The version number of the printer language is displayed.

Connection Equipment

The options installed are displayed.

Paper Input

Settings made on the [Paper Input] menu are displayed.

• p.131 "Paper Input Menu"

Maintenance

Settings made on the [Maintenance] menu are displayed.

• p.138 "Maintenance Menu"

System

Settings made on the [System] menu are displayed.

• p.141 "System Menu"

PCL Menu

Settings made on the [PCL Menu] are displayed.

• p.155 "PCL Menu"

PS Menu

Settings made on the [PS Menu] are displayed.

• p.158 "PS Menu"

PDF Menu

Settings made on the [PDF Menu] are displayed.

• p.160 "PDF Menu"
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Host Interface

Settings made on the [Host Interface] menu are displayed.

When DHCP is active on the network, the IPv4 address, subnet mask and gateway address appear
in parentheses on the configuration page.

• p.149 "Host Interface Menu"

Interface Information

Interface information is displayed.

User Paper Type

Registered user paper types are displayed.

• p.119 "From Registration of User Paper Types to Use"

List/Test Print Menu Parameters

This section explains about parameters that can be set on the List/Test Print menu.

Multiple Lists

You can print the configuration page, error log and network summary.

Config. Page

You can print the current configuration of the printer.

Error Log

You can print an error report.

Network Summary

You can print the network device status.

Menu List

You can print a menu list showing all available menus.

PCL Config.Page

You can print the current configuration and installed PCL font list.

PS Config. Page

You can print the current configuration and installed PostScript font list.

PDF Config.Page

You can print the current configuration and installed PDF font list.

Hex Dump

You can print the data sent by the computer using Hex Dump.
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Maintenance Menu
You can set printing conditions such as density and calibration, and printer management such as formatting
the optional hard disk unit.

Changing the Maintenance Menu

This section explains changing the Maintenance menu using examples.

HD Format

Follow the procedure below to set HD Format.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Maintenance], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [HD Format], and then press the [  Enter] key.

4. Read the HD format confirmation message, and then press the [  Enter] key.

The hard disk unit is formatted, and the message appears.

5. Press the [  Enter] key.

The [HD Format] screen appears.

6. Press the [Online] key.

The initial screen appears.

• "Attaching Hard Disk Drive Type 2650", Hardware Guide.

Maintenance Menu Parameters

This section explains about parameters that can be set on the Maintenance menu.

Image Density

You can select the print image density.

-3 to 3

• "Adjusting the Image Density", Hardware Guide.
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Registration

You can adjust the starting position of the printing page.

• Prt. Test Sheet

You can print the registration test sheet.

Tray 1, Tray 2, Tray 3, Bypass Tray, Duplex Unit

• Only the installed trays appear on the display panel.

• Adjustment

You can select the start position for printing on a page.

Horiz.:Tray 1, Horiz.:Tray 2, Horiz.:Tray 3, Horiz.:Bypass, Horiz.:Dup.Back, Vert.:Std. Tray,
Vert.:Opt. Tray, Vert.:Bypass, Vert.:Dup.Back

• Only the installed trays appear on the display panel.

Curl Prevention

You can control the fuser temperature to prevent paper from curling.

• On

• Off

• Default: Off

• Use this mode only when paper misfeed occurs frequently during duplex printing.

Del. All Temp

This appears on the menu only when the hard disk is installed.

Use this function to delete all temporarily saved documents (Sample Print, Locked Print and Hold Print
data) at once.

Del. All Stored

This appears on the menu only when the hard disk is installed.

Use this function to delete all saved documents (Stored Print data) at once.

HD Format

Appears when the hard disk is installed.

Date/Time

Use this to set the date and time.

WL.LAN Signal

You can check the signal strength when using LAN.
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The menu appears when the 802.11b interface unit is installed.

WL.LAN Defaults

Reset the wireless LAN to default.

The menu appears when the 802.11b interface unit is installed.

Panel Key Sound

You can select whether or not to sound the beeper when the control panel is pressed.

• On

• Off

• Default: On

• "Panel Tone", Hardware Guide.

Warm-Up Beeper

You can select whether or not to sound the beeper when the warming up is completed.

• On

• Off

• Default: On
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System Menu
The System Menu allows you to set the printer's basic functions. Although you can operate the printer using
the default settings, you can also change its settings to better suit your printing needs. Changes made to
settings remain effective after power off.

Changing the System Menu

Follow the procedure below to change the settings for Energy Saver Timer.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press [ ] or [ ] key to display [System], and then press the [  Enter] key.

3. Press [ ] or [ ] key to display [Energy Saver], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to display [E. Saver Timer], and then press the [  Enter] key.

5. Press the [ ] or [ ] key to select the lead time needed to switch to the Energy Saver mode.

6. Press the [  Enter] key.

Wait two seconds. The [Energy Saver] screen appears.

7. Press the [Online] key.

The initial screen appears.

System Menu parameters

This section explains about parameters that can be set on the System menu.

Prt. Err Report

You can select [On] or [Off] to have an error report printed when a printer error or memory error
occurs.

• Off

• On

• Default: Off

Auto Continue

You can make the Auto Continue setting. When set to on, printing continues after a system error occurs.

• Off

• Immediate
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• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

• Default: Off

• If you set [Auto Continue] to On, a job might be cancelled if an error occurs while it is printing
out. When a job is cancelled due to error, the printer automatically begins the next job in the
queue.

Memory Overflow

You can specify whether or not to print a memory overflow error report.

• Do not print

• Error Info.

• Default: Do not print

Copies

You can specify the number of pages to print.

This setting is disabled if the number of pages to print is specified by command or the printer driver.

• 1-999

Printer Lang.

You can specify the printer language.

• Auto Detect

• PCL

• PS

• PDF

• Default: Auto Detect

Sub Paper Size

You can select [Off] or [Auto] to enable the Sub Paper Size function. When you select [Auto], the
printer uses an alternative paper size if the currently specified paper is not loaded. When you select
[Off], the printer uses any size paper in the current specified paper tray.

• Auto

• Off
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• Default: Off

Page Size

You can specify the default paper size.

A4 (210×297), A5 (148×210), A6 (105×148), B5 JIS (182×257), C5 Env (162×229), C6 Env
(114×162), DL Env (110×220), 81/2"×14", 81/2"×13", 81/2"×11", 81/4"×13", 8"×13", 71/

4"×101/2", 51/2"×81/2", 41/8"×91/2", 37/8"×71/2", 16K (195×267), Custom Size

81/2"×14", 81/2"×13", 81/2" ×11", 81/4"×13", 8"×13", 71/4"×101/2", 51/2"×81/2", 41/

8×91/2, 37/8"×71/2", A4 (210×297), A5 (148×210), A6 (105×148), B6 JIS (182×257), C5 Env
(162×229), C6 Env (114×162), DL Env (110×220), 16K (195×267), Custom Size

•  Default: A4 (210×297)

•  Default: 81/2" ×11"

• The initial paper size is applied when the paper size is not specified in the print data.

Edge-Edge Print

You can print on the complete area of a sheet leaving no border on any edge.

• Off

• On

• Default: Off

Def.Print Lang.

You can specify the initial printer language if the printer cannot detect the printer language.

• PCL

• PS

• PDF

• Default: PCL

Duplex

You can specify whether or not to print on both sides of a sheet.

• Off

• Short Edge Bind

• Long Edge Bind
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• Default: Off

• This menu appears only when the optional duplex unit is installed.

Blank Pages

You can specify whether or not to print blank pages.

• Print

• Do not print

• Default: Print

Rotate 180 Deg.

You can select whether or not to rotate the image by 180 degrees when printing.

• On

• Off

• Default: Off

Energy Saver

You can specify the number of minutes Energy Saver mode is applied.

E. Saver On/Off

You can specify whether or not to switch Energy Saver.

• On

• Off

• Default: On

• When the printer switches to Energy Saver mode, the Power indicator is unlit, but the Online
indicator remains lit.

E. Saver Timer

You can select the lead time needed to switch to the Energy Saver mode. The Energy Saver
mode reduces electric power consumption.

• 1 minute

• 5 minutes

• 15 minutes

• 30 minutes

• 45 minutes
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• 60 minutes

• Default: 5 minutes

Auto Reset Time

Auto Reset

Specify whether to revert to the initial configuration at certain interval. This also specifies the
interval to reset the configuration.

• On

• Off

• Default: On

Reset Time(sec)

• 10 to 999 sec by 1 sec.

• Default: 60 seconds

Auto Del. Temp

This appears on the menu only when the hard disk is installed.

Specify whether to automatically delete temporarily saved documents (Sample Print, Locked Print and
Hold Print data), such as sample print documents or confidential documents. Also specify the time
period to elapse before deletion.

Auto Delete

• On

• Off

• Default: Off

Hours to Delete

• 1 to 200 hours by 1 hour.

• Default: 8 hours

Auto Del.Stored

This appears on the menu only when the hard disk is installed.

Specify whether to automatically delete saved documents (Stored Print data).

Also specify the elapse time in days before deletion.
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Auto Delete

• On

• Off

• Default: On

Days to Delete

1 to 180 days by 1 day.

• Default: 3 days

Memory Usage

You can select memory to be used from "Font Priority" or "Frame Priority".

• Font Priority

• Frame Priority

• Default: Frame Priority

Unit of Measure

You can specify the unit of measurement in "mm" or "inch" for the custom paper size.

• mm

• inch

• Default value is destination dependant.

Edge Smoothing

• On

• Off

• Default: On

Toner Saving

• Off

• On

• Default: Off
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Spool Printing

You can select whether all of the print data is spooled to the hard disk drive before printing.

• On

• Off

• Default: Off

• Spooling stores a sent print job temporarily in the printer, and then prints it.

• This menu appears only when the optional hard disk is installed.

Letterhead Mode

You can select the letterhead printing mode.

• Off

• Auto Detect

• On (Always)

• Default: Off

Bypass Priority

When the different paper size or type is specified from the driver, you can specify which setting is
given priority to, machine setting or command.

• Machine

• Driver/Command

• Default: Driver/Command

• Appear only at network standard model.

Auto Tray SW

Specify the printer to change printing to the suitable tray, when printer driver specifies different paper
size or type from the current tray.

• Off

• On

• Default: Off

RAM Disk

If the optional hard disk is not installed for PDF Direct Print, select a value of 2 MB or higher.

This menu appears only when the optional hard disk is not installed.
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• 0 MB

• 2 MB

• 4 MB

• 8 MB

• 16 MB

• Default: 4 MB

• When the amount of SDRAM is small and RAM Disk is set to 16 MB, printing may not be possible
depending on the print job and duplex printing may be canceled. If this happens, increase the
amount of SDRAM, or set RAM Disk to 8 MB or less.

• For details about the optional SDRAM module, see Hardware Guide.

• "Attaching Memory Unit Type C 128MB/256MB (SDRAM Module)", Hardware Guide.

Auto Email Ntfy

You can specify whether or not to send an error message to a preset e-mail address when an error
occurs in the printer.

• On

• Off

• Default: On

• After changing the setting, turn off the power of the printer briefly, and then turn it on again.

• Web Image Monitor Help
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Host Interface Menu
You can set configurations about network connections and communication when using parallel connection
between the printer and the computer. The changed configuration holds even if the printer is turned off.

Changing the Host Interface Menu

Follow the procedure below to change the [I/O Timeout].

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Host Interface], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [I/O Timeout], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to select the lead time needed to end a printing operation, and then
press the [  Enter] key.

Wait two seconds. The [I/O Timeout] menu appears.

5. Press the [Online] key.

The initial screen appears.

Host Interface Menu Parameters

This section explains parameters that can be set on the Host Interface menu.

I/O Buffer

You can select the size of I/O Buffer. Normally it is not necessary to change this setting.

• 128 KB

• 256 KB

• Default: 128 KB

I/O Timeout

You can set how many seconds the printer should wait before ending a print job. If printing operation
is frequently interrupted by data from other ports, you can increase the timeout period.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds
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• 60 seconds

• Default: 15 seconds

Network Setup

You can make network-related settings.

This menu appears only when the optional 802.11b interface unit is installed.

• For details about, see Hardware Guide.

IPv4 Settings

You can select whether to set the IPv4 address automatically or manually.

• DHCP

On/Off (Default: On)

• IPv4 Address

You can specify the IPv4 address.

When DHCP is set to on, the IPv4 address cannot be changed. To change it, set DHCP to
off. Contact your administrator for information about the network configuration.

• Default: 0.0.0.0

• Subnet Mask

You can specify the subnet mask.

When DHCP is set to on, the subnet mask cannot be changed. To change it, set DHCP to
off. Contact your administrator for information about the network configuration.

• Default: 0.0.0.0

• Gateway Address

You can specify the gateway address.

When DHCP is set to on, the gateway address cannot be changed. To change it, set DHCP
to off. Contact your administrator for information about the network configuration.

• Default: 0.0.0.0

IPv6 Settings

• Stateless Sett.

You can enable or disable IPv6.
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• Active

• Not Active

• Default: Active

Frame Type (NW)

You can select the frame type for NetWare.

• Auto Select

• Ethernet II

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

• Default: Auto Select

Active Protocol

You can select the effective protocol.

• IPv4

Active, Not Active

• Default: Active

• IPv6

Active, Not Active

• Default: Not Active

• NetWare

Active, Not Active

• Default: Active

• SMB

Active, Not Active

• Default: Active

• AppleTalk
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Active, Not Active

• Default: Active

Ethernet Speed

You can select the network speed to operate the printer.

• Auto Select

• 10Mbps Half D.

• 10Mbps Full D.

• 100Mbps Half D.

• 100Mbps Full D.

• Default: Auto Select

LAN Type

You can select Ethernet or IEEE 802.11b for LAN Type.

This menu appears only when the optional wireless LAN interface unit is installed.

• Ethernet

• IEEE 802.11b

• Default: Ethernet

IEEE 802.11b

You can make settings for wireless LAN. This menu appears only when the optional wireless LAN
interface unit is installed.

Comm. Mode

You can select the transmission mode for wireless LAN.

• 802.11 Ad hoc

• Infrastructure

• Ad hoc

• Default: 802.11 Ad hoc

• Comm. Mode can also be set using a Web Image Monitor. For details, see Web Image
Monitor Help.

• The optional wireless LAN interface unit supports 802.11 Ad hoc and Infrastructure modes.
Select [802.11 Ad hoc] or [Infrastructure] for [Comm.Mode].
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Channel

You can select channels:

1-11

• Default: 11

Trans. Speed

You can select the transmission speed for IEEE 802.11b.

• Auto

• 11 Mbps

• 5.5 Mbps

• 2 Mbps

• 1 Mbps

• Default: Auto

SSID

You can set an SSID in the infrastructure mode and the 802.11 Ad hoc mode.

• View

• Enter ID

• Default: blank (ASSID)

• Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the configuration page,
read it as [/].

• Characters used are ASCII 0x20-0x7e (32 bytes).

• An SSID is set automatically to the nearest access point if no SSID has been set.

• If no SSID has been set for the 802.11 ad hoc mode, an SSID is set automatically and the
same SSID is used for the 802.11 ad hoc mode and the infrastructure mode.

• If blank is specified in SSID for 802.11 ad hoc mode, "ASSID" appears.

• An SSID can also be set using Web Image Monitor. For details, see Web Image Monitor
Help.

Security Method

You can enable or disable encryption. You can also specify the security type when the encryption
is enabled.

• None

• WEP
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• Change (HEX): Enter the WEP key using a hexadecimal number sequence. When
using 64 bit WEP, enter 10 ASCII characters. When using 128 bit WEP, enter 26
ASCII characters.

• Change (ASCII): Enter the WEP key using an ASCII character sequence. When using
64 bit WEP, enter 5 ASCII characters. When using 128 bit WEP, enter 13 ASCII
characters.

• WPA

Encrypt. Meth.

• TKIP

• CCMP(AES)

Authent. Meth.

• WPA-PSK: From 8 to 63 ASCII characters can be entered.

• WPA: When selecting this method, obtain a certificate using Web Image Monitor.

• WPA2-PSK: Same as WPA-PSK, 8 to 63 ASCII characters can be entered.

• WPA2: A supplemental specification of WPA. Fully compatible with IEEE802.11i.

PSK Entry: 8 to 63 characters can be entered.

• Default: None

• The WEP key can also be set using Web Image Monitor. For details, see Web Image
Monitor Help.

Fixed USB Port

• On

• Off

• Default: Off

• The service engineer sets this function. Do not change this setting.
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PCL Menu
You can set conditions when using PCL for printing.

Changing the PCL Menu

Follow the procedure below to change the setting for Orientation.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [PCL Menu], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Orientation], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to select the orientation, and then press the [  Enter] key.

Wait two seconds. The [Orientation] screen appears.

5. Press the [Online] key.

The initial screen appears.

PCL Menu Parameters

This section explains about parameters that can be set on the PCL menu.

Orientation

You can select the page orientation.

• Portrait

• Landscape

• Default: Portrait

Form Lines

You can specify the number of lines per page between 5 and 128.

•  Default : 64

•  Default : 60

Font Source

You can set the location of the default font.

• Resident

PCL Menu
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• RAM

• HDD

• SD

• SD Font Dwnload

• Default: Resident

• When you select [RAM], you can select only fonts downloaded to the printer RAM.

• When you select [HDD], you can select only fonts downloaded to the optional hard disk.

• When you select [SD], you can select only fonts for downloaded to the SD card.

Font Number

Specify the ID of the default font you want to use.

• 0 to 63 (Internal)

• 1 to X (Download; "X" is the number of downloaded fonts)

Point Size

You can specify the point size you want to use for the default font between 4 and 999.75 in 0.25
increments.

• Default: 12.00 points

• This setting is effective only for a variable-space font.

Font Pitch

You can specify the number of characters per inch you want to use for the default font between 0.44
and 99.99 in 0.01 increments.

• Default: 10.00 pitch

• This setting is effective only for fixed-space fonts.

Symbol Set

You can specify the character set for the default font. Available sets are as follows:

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, Win L1, Win L2,
Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-8, PS Math, VN Math, Pifont, Legal, ISO
4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

• Default: PC-8

Courier Font

You can select a courier-type font.
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• Regular

• Dark

• Default: Regular

Ext. A4 Width

You can extend the width of the printable area of A4 sheets reducing side margin width.

• Off

• On

• Default: Off

Append CR to LF

You can specify whether or not to append a CR code to each LF code to print text data clearly.

• Off

• On

• Default: Off

Resolution

You can specify the print resolution in dots per inch.

• 300 dpi

• 600 dpi

• Default: 600 dpi

PCL Menu
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PS Menu
You can set conditions when using Postscript for printing.

Changing the PS Menu

Follow the procedure below to change the setting for date format.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [PS Menu], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Data Format], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to select [TBCP], and then press the [  Enter] key.

Wait two seconds. The [Data Format] screen appears.

5. Press the [Online] key.

The initial screen appears.

PS Menu Parameters

This section explains about parameters that can be set on the Postscript menu.

Data Format

You can select the data format.

• Binary Data

• TBCP

This setting is effective when using a parallel, USB, or EtherTalk connection.

When you use a parallel or USB connection, the print job is canceled if binary data is sent from
the printer driver.

When you use an Ethernet connection, the print job is canceled if:

• The printer driver data format is TBCP and the data format selected using the control panel
is Binary Data.

• The printer driver data format is binary and the data format selected using the control panel
is TBCP.

• Default: TBCP
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Resolution

You can select the resolution.

• 300dpi

• 600dpi Fast

• 600dpi Std.

• Default: 600dpi Fast

PS Menu
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PDF Menu
You can set conditions when using PDF printing.

Changing the PDF Menu

Follow the procedure below to change the resolution setting.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [PDF Menu], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Resolution], and then press the [  Enter] key.

4. Press the [ ] or [ ] key to select the resolution, and then press the [  Enter] key.

Wait two seconds. The [Resolution] screen appears.

5. Press the [Online] key.

The initial screen appears.

PDF Menu Parameters

This section explains about parameters that can be set on the PDF menu.

PDF: Change PW

You can specify the password for the PDF file executing PDF Direct Print.

• If you do not set a PDF password, this menu does not appear.

• The password can be set using Web Image Monitor, but must be sent through the network. For
increased security, use this menu on the control panel to set the password directly.

PDF Group PW

You can set a group password specified using DeskTopBinder Lite.

• If you do not set a PDF group password, this menu does not appear.

• When you use a group password, the optional data protection unit must be installed.

• The password can be set using Web Image Monitor, but must be sent through the network. For
increased security, use this menu on the control panel to set the password directly.
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• Default: no password set

Resolution

You can select the resolution for the PDF file executing PDF Direct Print.

• 300dpi

• 600dpi Fast

• 600dpi Std.

• Default: 600dpi Fast

PDF Menu
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Language Menu
You can set language displayed on the menu.

Changing the Language Menu

Follow the procedure below to change the language.

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Language], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to select the language, and then press the [  Enter] key.

Wait two seconds. The [Language] menu screen appears.

4. Press the [Online] key.

The initial screen appears.

Language Menu Parameters

You can select the language you use. Available languages are as follows:

English, German, French, Italian, Dutch, Swedish, Norwegian, Danish, Spanish, Finnish, Portuguese,
Czech, Polish, Hungarian.

• Default: English

5. Making Printer Settings Using the Control Panel

162

5



6. Monitoring and Configuring the
Printer

Using Web Image Monitor
Using Web Image Monitor, you can check the printer status and change settings.

Available operations

The following operations can be remotely performed using Web Image Monitor from a client
computer.

• Displaying printer status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book

• Making printer settings

• Making e-mail notification settings

• Making network protocol settings

• Making security settings

Configuring the printer

To perform the operations from Web Image Monitor, TCP/IP is required. After the printer is configured
to use TCP/IP, operations from Web Image Monitor become available.

Recommended Web browser

• Windows:

Internet Explorer 5.5 SP2 or higher

Firefox 1.0 or higher

• Mac OS:

Firefox 1.0 or higher

Safari 1.0, 1.2, 2.0 (412.2) or higher

Web Image Monitor supports screen reader software

We recommend JAWS 7.0 or a later version.

• Safari cannot be used on Mac OS X 10.4.1.
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• Display and operation problems can occur if you do not enable JavaScript and cookies, or if you are
using a non-recommended Web Browser.

• If you are using a proxy server, change the Web browser settings. Contact your administrator for
information about the settings.

• If you click your browser's back button but the previous page does not appear, click the browser's
refresh button and try again.

• Printer information is not automatically updated. To perform an update, click [Refresh] in the display
area.

• We recommend using Web Image Monitor in the same network.

• You cannot access to the printer from outside the firewall.

• When using the printer under DHCP, the IPv4 address may be automatically changed by the DHCP
server settings. Enable DDNS setting on the printer, and then connect using the printer's host name.
Alternatively, set a static IPv4 address to the DHCP server.

• If the HTTP port is disabled, connection to the printer using the printer's URL cannot be established.
SSL setting must be enabled on this printer. For details, consult your administrator.

• When using the SSL encryption protocol, enter "https://(printer's address)/". Internet Explorer must
be installed on your computer. Use the most recent available version. We recommend Internet Explorer
6.0 or later.

• When you are using Firefox, fonts and colors may be different, or tables may be out of shape.

• To use JAWS 7.0 under Web Image Monitor, you must be running Windows OS and Microsoft
Internet Explorer 5.5 SP2, or a later version.

Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

1. Start your Web browser.

2. Enter "http://(printer's address)/" in the address bar of a Web browser.

Top Page of Web Image Monitor appears.

If the printer's host name has been registered on the DNS or WINS server, you can enter it.

When setting SSL, a protocol for encrypted communication, under environment which server
authentification is issued, enter "https://(printer's address)/".

Every Web Image Monitor page is divided into the following areas:
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1

2 3

4

5

AUB900S

1. Menu area

If you select menu, it's content will be shown on the work area, or the sub area.

2. Tab area

Details about each menu appears.

3. Header area

The dialog box for switching to the user mode and administrator mode appears, and each mode's menu will be
displayed.

The link to help and dialog box for keyword search appears.

4. Help

Use Help to view or download Help file contents.

5. Display area

Displays the contents of the item selected in the menu area.

Machine information in the display area is not automatically updated. Click [Refresh] at the upper right in the
display area to update the machine information. Click the Web browser's [Refresh] button to refresh the entire
browser screen.

• For details the printer's host name has been registered on the DNS or WINS server, see "Cautions to
Take When Using in a Network".

• p.311 "Cautions to Take When Using in a network"

About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and administrator mode.

Displayed items may differ depending on the printers.

Using Web Image Monitor
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About Guest Mode

In the guest mode, printer status, settings, and print job status can be viewed, but the printer settings
cannot be changed.

1

3
2

4

AUB901S

1. Home

The [Status], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed on the work
area.

2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs. Appear only when the
optional hard disk is installed.

3. Job

Display all print files.

4. Configuration

Display current printer and network settings.

Administrator Mode

In the administrator mode, you can configure various printer settings.

1
2

4
3

6
7

5

AUB902S

1. Home

The [Status], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed on the work
area.
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2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs. Appear only when the
optional hard disk is installed.

3. Job

Display all print files.

4. Address Book

User information can be registered, displayed, changed, and deleted.

5. Configuration

Make system settings for the printer, interface settings, and security.

6. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after the print job is completed.
This button is located on Top Page.

7. Reset Printer Job

Click to reset current print jobs and print jobs in queue. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator mode.

1. On Top Page, click [Login].

The dialog box for entering the user name and password appears.

2. Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the icon marked "?" in the
display area makes the following screen appear, in which you can view Help in two different ways, as
shown below:

Viewing Help on our Web site

Downloading Help to your computer

Downloading and Checking Help

You can download Help to your computer. To view Help without connecting to the Internet, enter the
path to your local Help files in your browser's URL bar.

• By clicking [Help] in the header area, the contents of Help appear.

• You can view Help for a setting by clicking "?", the Help icon, in the display area.

Using Web Image Monitor
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Downloading Help

1. In the [OS] list, select the operating system.

2. In the [Language] list, select the language.

3. Click [Download].

4. Download Help by following the instructions on the screen.

5. Store the downloaded compressed file in a location, and then decompress the file.

To view the downloaded Web Image Monitor Help, set the path to the location of the decompressed
file.

Linking the URL of the Help File to the Help Button

You can link the URL of the help file on a computer or Web server to the Help button.

1. Log on to Web Image Monitor in the administrator mode.

2. In the menu area, click [Configuration].

3. Click [Webpage].

4. In the [URL] box, enter the URL of the help file.

For example, if you saved the file to a Web server, and the URL of the index file is "http://a.b.c.d/
HELP/EN/index.html", enter "http://a.b.c.d/HELP/".

5. Click [OK].
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Using SmartDeviceMonitor for Admin
Using SmartDeviceMonitor for Admin, you can monitor the network printers. Also, you can change the
configuration of the network interface board using TCP/IP or IPX/SPX.

• IPv6 cannot be used on this function.

Protocol stack provided with Operating System

• Windows 2000

TCP/IP

IPX/SPX

NetWare

Novell Client for Windows NT/2000/XP

• Windows Server 2003/2003 R2

TCP/IP

IPX/SPX

• Windows XP

TCP/IP

IPX/SPX

Novell Client for Windows NT/2000/XP

• Windows Vista

TCP/IP

Novell Client for Windows NT/2000/XP/Vista

Available operations

The following functions are available:

• Printer Information function

• Display the network settings and detailed information of the printer.

• Display the number of pages printed under each user code.

• Display the status of print jobs sent from computers.

• Change the printer network settings.

• Device Settings function

• Lock some of the setting items on the control panel so that they cannot be changed using
the control panel.

• Select type of paper loaded in the paper trays.

• Energy Saver function

Using SmartDeviceMonitor for Admin
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• Enable or disable the Energy Saver mode.

• System Status function

• Display the information such as when paper is depleted during printing on a computer.

• Groups function

• Monitor multiple printers at the same time. When there are multiple printers to manage, you
can create groups and classify the printers to facilitate management.

• You can customize printer status according to groups, and send status notification e-mail
to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [SmartDeviceMonitor for Admin] installation, and then click Next >.

5. The software license agreement appears in the [License Agreement] dialog box.

After reading through its contents, click [Yes] if you agree, and then click [Next >].

6. Follow the instructions on the screen.

A message appears when the installation is complete.

7. Click [OK].

• Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

• If you are required to restart the computer after installing SmartDeviceMonitor for Admin, restart the
computer and continue the configuration.

• SmartDeviceMonitor for Admin supports following languages: Czech, Danish, German, English,
Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese , Finnish, Swedish,
Chinese Simple and Chinese Traditional.
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Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration using
SmartDeviceMonitor for Admin.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.Select the protocol of the printer whose
configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the user name and password for the Web
Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

6. Configure settings using Web Image Monitor.

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• p.163 "Using Web Image Monitor"

Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer.
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4. On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

5. Enter the user name and password, and then click [Login].

For details about the user name and password, consult your administrator.

The [System] page of Web Image Monitor appears.

6. Select [Level 1] or [Level 2] on [Protect Printer Display Panel] in "General Settings".

7. Click [OK].

8. Click [Logout].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

• For details about setting items, see Help in the [Device Settings] on [Configuration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

5. Enter the user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

The [Paper] page of Web Image Monitor appears.

6. Select a paper type in the [Paper Type] list for each tray.

7. Click [OK].

8. Click [Logout].

9. Quit Web Image Monitor.
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10. Quit SmartDeviceMonitor for Admin.

• For details about setting items, see Help in the [Device Settings] on [Configuration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDeviceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer you want to manage.

4. On the [Tools] menu, click [User Management Tool].

The dialog box for entering the user name and password appears.

5. Enter the user name and password, and then click [OK].

For details about the user name and password, consult your administrator.

User Management Tool starts.

• For details about User Management Tool, see SmartDeviceMonitor for Admin Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each user code.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user code appears.

3. Click [Exit] on the [File] menu to quit User Management Tool.
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Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages printed under each user
code as a ".csv" file.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [File] menu, click [Export User Statistics List].

4. Specify the save location and file name, and then click [Save].

5. Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0

Follow the procedure below to reset the number of pages printed under each user code to 0.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. Click the user whose information you want to reset.

4. On the [Edit] menu, click [Reset User Counters].

5. Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

6. Click [OK].

7. On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

8. Click [Exit] on the [File] menu to quit User Management Tool.

Restricting Functions

Follow the procedure below to restrict use of individual functions.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

4. Select the check box of the functions you want to restrict.

5. Click [OK].

A confirmation message appears.

6. Click [Yes].

The settings are applied.
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Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to them.

1. Start SmartDeviceMonitor for Admin.

2. Click the [Access Control List] tab of User Management Tool.

3. On the [Edit] menu, click [Add New User].

4. Enter the user code and user name.

5. Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function. For details, see
SmartDeviceMonitor for Admin Help.

6. Click [OK].

The new user is added.

7. On the [Edit] menu, click [Apply Settings].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

• For details about setting restrictions, see SmartDeviceMonitor for Admin Help.

Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select the printer whose settings you want to make.

To make settings for all printers in the selected group, select no printer.

4. On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to make the
settings for only the selected printer or point to [Set By Group] to make the settings for all
printers in the selected group, and then click [On] or [Off].

5. Quit SmartDeviceMonitor for Admin.
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• For details about the setting value for Energy Saver mode, see SmartDeviceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your administrator.

Top Page of Web Image Monitor appears.

6. Click [Configuration].

7. On the [Device Settings], click [Program/Change Administrator], and then change the
settings.

8. Click [OK].

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

The status of printers is indicated by icons in the list.
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If you are using IPv4 SNMPv3, enter the user authentication.

3. To obtain status details, click the printer in the list, and then click [Open] on the [Device]
menu.

The printer status appears in the dialog box.

4. Click [System] or [Printer].

5. Quit SmartDeviceMonitor for Admin.

• For details about status icons and items in the dialog box, see SmartDeviceMonitor for Admin Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3]. A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

The status of printers is indicated by icons in the list.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer in the list.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.

5. Enter the user name and password, and then click [Login].

Top Page of Web Image Monitor appears.

For details about the login user name and password, consult your administrator.

6. Click [Configuration].

7. Click [System] on the [Device Settings] area, and then change the settings.

8. Click [OK].

• In the [Device Name] box, enter a device name on the printer using up to 31 characters.

• In the [Comment] box, enter a comment on the printer using up to 31 characters.

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.
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Viewing and Deleting Spool Print Jobs
1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX] or [IPv4
SNMPv3].

A list of printer using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

3. Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the [Tools] menu.

A Web browser opens and the dialog box for entering the login user name and password for the
Web Image Monitor administrator appears.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

[Spool Printing Job List] appears in the Web Image Monitor.

To delete the Spool Printing Job, select the document you want to delete and then click [Delete].

• To display [Spool Printing Job List], spool must be set to [Active] on Web Image Monitor in advance.

• For details, see Help in the [Spool Printing Job List] area.

6. Monitoring and Configuring the Printer

178

6



Using SmartDeviceMonitor for Client
To view the status of printers using SmartDeviceMonitor for Client, configure SmartDeviceMonitor for
Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, point to [Properties], and then click
[Options...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

2. Select the printer you want to monitor, and then select the [To be Monitored] check box in
the Monitoring Information Settings area.

To display the printer status in the task tray using the SmartDeviceMonitor for Client icon, select the
[Displayed on Task Bar] check box.

3. Click [OK].

The dialog box closes and the configured printer is monitored.

• For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor for Client.

1. Start SmartDeviceMonitor for Client.

2. For status details, right-click the SmartDeviceMonitor for Client icon, and then click the
printer.

The printer status appears in the dialog box.

• For details about items in the dialog box, see SmartDeviceMonitor for Client Help.

When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:
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• The network printer can only receive one print job from SmartDeviceMonitor for Client at a time. While
the network printer is printing, another user cannot access it until the job is finished. In this case,
SmartDeviceMonitor for Client tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times out, it will stop sending
the print job. In this case, you should cancel the paused status from the print queue window.
SmartDeviceMonitor for Client will resume access to the network printer. You can delete the print job
from the print queue window, but canceling a print job printed by the network printer might cause the
next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the network printer cancels
the job because something went wrong, send the print job again.

• Print jobs sent from another computer do not appear in the print queue window, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to network printers, the printing
order might not be the same as that in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is used for the
SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environment which server
authentification is issued, enter "https://(printer's address)/". Internet Explorer must be installed on
your computer. Use the highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP to create or configure
an IPP port, or when printing, install the certificate. To select the certificate store location when using
Certificate Import Wizard, click [Place all certificates in the following store], and then click [Local
Computer] under [Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail
Whenever a paper tray becomes empty or paper jams, a notification e-mail is sent to the registered
addresses.

You can make the timing and content settings for notification e-mail.

• Call Service

• Out of Toner

• Toner Almost Empty

• Replacement Required: Maintenance Kit

• Paper Misfeed

• Cover Open

• Out of Paper

• Almost Out of Paper

• Paper Tray Error

• Output Tray Full

• Unit Connection Error

• Duplex Unit Error

• Waste Toner Bottle is Full

• Waste Toner Bottle is Almost Full

• Replace Cleaning Web Soon

• File Storage Memory Full Soon

• Log Error

1. Open a Web browser, and then enter "http://(printer's address)/" in the address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environment which server
authentification is issued, enter "https://(printer's address)/".

2. Click [Login] on Top Page of Web Image Monitor.

The window for entering the login user name and password appears.

3. Enter the user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. In the menu area, click [Configuration].

5. Click [E-mail] in "Device Settings".
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6. Make the following settings:

• Items in the Reception column: Make the necessary settings for sending and receiving e-mail.

• Items in the SMTP column: Configure the SMTP server. Check your mailing environment, and
then specify the necessary items. You can also perform mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check your mailing
environment, and then specify the necessary items. You can also perform mail authentication for
the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server. Check your mailing
environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be used for access to the
mail server.

• Items in the E-Mail Notification Account column: Specify these items if you want to use on-demand
e-mail notification.

7. Click [OK].

Auto E-mail Notification

1. In the menu area, click [Configuration], and then click [Auto E-mail Notification] in "Device
Settings".

The dialog box for making notification settings appears.

2. Make the following settings:

• Items in the Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.

• Items in the Groups to Notify column: E-mail notification addresses can be grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each notification type, such
as printer status and error.

To make detailed settings for these items, [Edit] next to [Detailed Settings of Each Item].

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

On-demand E-mail Notification

1. In the menu area, click [Configuration], and then click [On-demand E-mail Notification] in
"Device Settings".

The dialog box for making notification settings appears.
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2. Make the following settings:

• Notification Subject: Enter a text string to be added to the subject line of return e-mails.

• Items in the Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.

• Items in the Access Restriction to Information column: Select whether to restrict accesses based
on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column: Enter an e-mail address
or domain name to use for requesting information by e-mail and to receive its return e-mail.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

SMTP Authentication

Specify SMTP authentication.

When mail is sent to the SMTP server, authentication is performed using the SMTP AUTH protocol by
prompting the mail originator to enter the user name and password. This prevents illegal use of the
SMTP server.

1. In the menu area, click [Configuration], and then click [E-mail] in "Device Settings".

2. Make the following settings:

• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Auto Select]: If the authentication method is PLAIN, LOGIN, CRAM-MD5, or DIGEST-
MD5.

[Active]: If the authentication method is CRAM-MD5 or DIGEST-MD5.

[Inactive]: If the authentication method is PLAIN or LOGIN.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.
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POP before SMTP Authentication

Select whether to log on to the POP3 server before sending e-mail.

1. In the menu area, click [Configuration], and then click [E-mail] in "Device Settings".

2. Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before connecting to the SMTP
server after logging on to the POP server.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Sending On-demand E-mail

To use on-demand e-mail notification, perform the following configuration tasks in Web Image Monitor.

1. In the menu area, click [Configuration], and then click [E-mail] in "Device Settings".

2. Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail notification.

• E-mail Notification User Name: Enter the administrator's user name as the mail originator name.

• E-mail Notification Password: Enter the password of the mail notification user.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Format of on-demand e-mail messages

To use mail notification, you need to send an on-demand e-mail message to this printer.

Using your mail software, enter the following:

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For details,
see the table below.
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Item Description

From (Referred to as From) Specify a valid mail address. The device
information will be sent to the address specified
here.

• A mail message must be within 10 KB in size.

• E-mail may be incomplete if sent immediately after power on.

Subject field

Format: devicestatus?parametername=parameter[&=parameter][& =parameter]...

• The Subject field is case-insensitive.

• Parameter names can be written in any order.

Subject field coding examples

Coding example Action

devicestatus?request=sysconfig& format=text&
lang=en

The device's system configuration information
will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration information
will be sent in a preset format and language.

Parameters

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the format
preset for each mail address.

lang Language for mail body Mail will be sent in the
language preset for each mail
address.
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Parameters specifying the information to be obtained

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Parameters specifying the mail format

Mail format Parameter

Text text

HTML html

XML xml

• HTML and XML can be selected for subject field, but output is text only.

Parameters specifying the language for mail body

Language for mail body Parameter

English en

French fr

German de

Italian it

Spanish es

Dutch nl

Danish da

Finnish fi

Norwegian no
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Language for mail body Parameter

Portuguese pt

Swedish sv

Czech cs

Polish pl

Hungarian hu
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Remote Maintenance by telnet

• Remote Maintenance should be password-protected so that access is allowed to administrators only.

• The password is the same as the one of Web Image Monitor administrator. When the password is
changed using "mshell", other passwords change also.

• Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

• Only one user at a time can log on to perform remote maintenance.

1. Use the IP address or the host name of the printer to start telnet.

% telnet "IP_address"

2. Enter your user name and password.

Contact your administrator for information about the settings.

3. Enter a command.

4. Quit telnet.

msh> logout

The configuration message about saving the changes appears.

5. Enter "yes" to save the changes, and then press the [OK] key.

If you do not want to save the changes, enter "no", and then press the [OK] key. To make further
changes, enter "return" at the command line, and then press the [OK] key.

• If the message "Can not write NVRAM information" appears, the changes are not saved. Repeat the
procedure above.

• When the changes are saved, the network interface board is reset automatically with that changes.

• When the network interface board resets, the print job in print process will be printed. However, print
jobs in queue will be canceled.
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access

Use the "access" command to view and configure access control. You can also specify two or more access
ranges.

View settings

msh> access

IPv4 Configuration

msh> access [×] range "start-address end-address"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv4 addresses between 192.168.0.10 and 192.168.0.20:

msh> access 1 range6 192.168.0.10 192.168.0.20

IPv6 Configuration

msh> access [×] range6 "start-address end-address"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and 2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

IPv6 access mask Configuration

msh> access [×] mask6 "base-address prefixlen"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses to 2001:DB8::/32

msh> access 1 mask6 2001:DB8:: 32

Access control initialization

msh> access flush

• Use the "flush" command to restore the default settings so that all access ranges become "0.0.0.0"
for IPv4, and ":: " for IPv6.

• The access range restricts computers from use of the machine by IP address. If you do not need to
restrict printing, make the setting "0.0.0.0" for IPv4, and "::" for IPv6.

• Valid ranges must be from lower (start address) to higher (end address).

• If you are running IPv4 or IPv6, up to five access ranges can be registered and selected.

• IPv6 can register and select the range and the mask for each access ranges.

• IPv6 mask ranges between 1 - 128 can be selected.
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• Up to five access ranges can be specified. The entry is invalid if the target number is omitted.

• You cannot send print jobs, or access Web Image Monitor and diprint from a restricted IP address.

autonet

Use the "autonet" command to view and configure AutoNet parameters.

View settings

The following command displays the current AutoNet settings:

msh> autonet

Configuration

You can configure AutoNet settings.

msh> autonet {on|off}

• {on} means "active" and {off} means "inactive".

Current interface priority configuration display

msh> autonet priority

Interface priority configuration

msh> autonet priority "interface_name"

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

• If an interface is not selected, the current interface connection settings remain in effect.

• For details about AutoNet, refer to autonet parameters.

bonjour(rendezvous)

Use the "bonjour(rendezvous)" command to display bonjour(rendezvous)-related settings.

View settings

Bonjour settings are displayed.
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msh> bonjour

Bonjour service name setting

You can specify the bonjour service name.

msh> bonjour cname "computer name"

• The computer name can be entered using up to 63 alphanumeric characters.

Bonjour Installation location information setting

You can enter information about the location where the printer is installed.

msh> bonjour location "location"

• Information about location can be entered using up to 32 alphanumeric characters.

Setting order of priority for each protocol

• diprint

msh> bonjour diprint {0-99}

• lpr

msh> bonjour lpr {0-99}

• ipp

msh> bonjour ipp {0-99}

You can specify the order of priority for "diprint", "lpr", and "ipp". Smaller numbers indicate higher
priority.

IP TTL setting

msh> bonjour ipttl {1-255}

You can specify the IP TTL (the number of routers a packet can pass through).

• The default is 255.

Resetting the computer name and location information

You can reset the computer name and location information.

msh> bonjour clear {cname | location}

• cname

Reset the computer name. The default computer name will be displayed when the computer is
restarted.

• location

Reset the location information. The previous location information will be deleted.

Interface configuration

msh> bonjour linklocal "interface_name"
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• If many types of interface are installed, configure the interface that communicates with linklocal
address.

• If the connected computer's IP address is a link local address specified by the DHCP's Autonet,
and multiple interfaces are connected to the printer, you can select an interface to communicate
through.

• If you do not specify an interface, the Ethernet interface is automatically selected.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Selecting the IPP port number

msh> bonjour ippport {ipp | ssl}

• Appears when SSL is enabled.

• If the "ipp" is selected, the port number is set to "631". If the "ssl" is selected, the port number is
set to "443".

devicename

Use the "devicename" command to display and change the printer name.

View settings

msh> devicename

Printer name configuration

msh> devicename name "string"

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

Printer name initialization

msh> devicename clearname

• Reset the printer name to its default.

dhcp

Use the "dhcp" command to configure DHCP settings.
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View settings

The following command displays the current DHCP settings.

msh> dhcp

Configuration

You can configure DHCP.

msh> dhcp "interface_name" {on|off}

• Click {on} to enable DHCP. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be sure to click {on}.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Current interface priority configuration display

msh> dhcp priority

Interface priority configuration

msh> dhcp priority "interface_name"

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server or use the address set
by a user.

• To obtain the DNS server address from the DHCP server, specify "dhcp". To use the address set
by a user, specify "static".

Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the domain name set
by a user.

• To obtain the domain name from the DHCP server, specify "dhcp". To use the domain name set
by a user, specify "static".
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diprint

The direct printing port enables direct printing from a network-connected computer.
Use the "diprint" command to change direct printing port settings.

View settings

The following command displays the current direct printing port settings:

msh> diprint

Example output:

port 9100

timeout=300(sec)

bidirect on

con multi

apl async

• The "port" specifies the port number of the direct printing port.

• The "bidirect" setting indicates whether the direct printing port is bidirectional or not.

Setting timeout

msh> diprint timeout {30 - 65535}

• You can specify the timeout interval to use when the printer is expecting data from the network.

• The default is 300 seconds.

Specifying the number of concurrent connections

msh> diprint conn {multi | single}

• The above command specifies the number of concurrent diprint connections. Specify "multi" for
multiple connections or "single" for a single connection.

• The default is "multi".

dns

Use the "dns" command to configure or display DNS (Domain Name System) settings.

View settings

The following command displays current DNS settings:

msh> dns

IPv4 DNS server configuration

The following command enables or disables the IPv4 DNS server address:

msh> dns "number" server "server address"
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The following command displays a configuration using the IP address 192.168.15.16 on a DNS 1
server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can register up to three IPv4 DNS server numbers.

• You cannot use "255.255.255.255" as the DNS server address.

IPv6 DNS server configuration

The following command enables or disables the IPv6 DNS server address:

msh> dns "number" server6 "server address"

• You can register IPv6 DNS Server address.

• You can register up to three IPv6 DNS server numbers.

Dynamic DNS function setting

msh> dns "interface_name" ddns {on|off}

• You can set the dynamic DNS function "active" or "inactive".

• {on} means "active" and {off} means "inactive".

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update

To delete old records and register new records.

• add

To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means "active" and {off} means "inactive".

• The CNAME registered is the default name beginning with rnp. CNAME cannot be changed.
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A records registration

msh> dns arecord {dhcp|own}

• {dhcp}

You can specify the method of registering an A record when the dynamic DNS function is enabled
and DHCP is used.

• {own}

To register an A record using the printer as the DNS client.

The DNS server address and the domain name already designated are used for the registration.

Record updating interval settings

msh> dns interval "time"

• You can specify the interval after which records are updated when using the dynamic DNS
function.

• The updating interval is specified hourly. It can be entered between 1 and 255 hours.

• The default is 24 hours.

domainname

Use the "domainname" command to display or configure the domain name settings.
You can configure the Ethernet interface or wireless LAN interface.

View settings

The following command displays the current domain name:

msh> domainname

Interface domain configuration

msh> domainname "interface_name"

Setting the Domain Name

msh> domainname "interface_name" name "domain name"

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and wireless LAN interface will have the same domain name.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface Interface set

ether Ethernet interface

wlan Wireless LAN interface
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Deleting the Domain Name

msh> domainname "interface_name" clear "name"

help

Use the "help" command to display the available command list and the procedures for using those
commands.

Command list display

msh> help

Display of procedure for using commands

msh> help "command_name"

hostname

Use the "hostname" command to change the printer name.

View settings

msh> hostname

IPv4 Configuration

msh> hostname "interface_name" "printer_name"

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name starting with "RNP" or "rnp"

• The Ethernet interface and wireless LAN interface will have the same printer name.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Initializing the printer name for each interface

msh>hostname "interface_name" clear "name"

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet mask, broadcast address,
default gateway address) for the printer.
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View settings

msh> ifconfig

IPv4 Configuration

msh> ifconfig "interface_name" "parameter" "address"

• If you did not enter an interface name, it is automatically set to the Ethernet interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet Interface

wlan Wireless LAN Interface

The following explains how to configure an IPv4 address 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16

IPv6 Configuration

msh> ifconfig ether inet6 "interface_name" "prefixlen"

The following explains how to configure a IPv6 address to 2001:DB8::100 with prefix length 64 on
the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

Netmask configuration

msh> ifconfig "interface_name" netmask "address"

The following explains how to configure a subnet mask 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

Broadcast address configuration

msh> ifconfig "interface_name" broadcast "address"

Changing the Interface

msh> ifconfig "interface" up

• You can specify either the Ethernet interface or wireless LAN interface when using the optional
wireless LAN interface unit is installed.

• To get the above addresses, contact your administrator.

• Use the default configuration if you cannot obtain setting addresses.

• The IP address, subnet mask and broadcast address are the same as that for the ethernet interface
and wireless LAN interface.

• TCP/IP configuration is the same for both Ethernet and wireless LAN interface. If interfaces are
changed, the new interface inherits the configuration.

6. Monitoring and Configuring the Printer

198

6



• Use "0x" as the initial two letters of a hexadecimal address.

info

Use the "info" command to display printer information such as paper tray, output tray, and printer language.

Printer information display

msh> info

• p.222 "Getting Printer Information over the Network"

ipp

Use the "ipp" command to view and configure IPP settings.

Viewing settings

The following command displays the current IPP settings:

msh> ipp

IPP timeout configuration

Specify how many seconds the computer waits before canceling an interrupted print job. The time
can be entered between 30 to 65535 seconds.

msh> ipp timeout {30 - 65535}

IPP user authorization configuration

Use IPP user authorization to restrict users to print with IPP. The default is "off".

msh> ipp auth {basic|digest|off}

• User authorization settings are "basic" and "digest".

• Use "off" to remove a user's authorization.

• If user authorization is specified, register a user name. You can register up to 10 users.

IPP user configuration

Configure IPP users according to the following messages:

msh> ipp user

The following message appears:

msh> Input user number (1 to 10):

Enter the number, user name, and password.

msh> IPP user name:user1

msh> IPP password:*******
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After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the "ipv6" command to display and configure IPv6 settings.

View Setting

msh> ipv6

IPv6 stateless address

msh> ipv6 stateless {on|off}

• If "on" is selected, IPv6 requests information required for maintaining stateful connection to the
router for as long as the printer power is turned on. This setting allows information from the router
to be obtained constantly, and periodically refreshes the effective period of the stateless address.

lpr

Use the "lpr" command to view and configure LPR settings.

View Setting

msh> lpr

Checking host name when deleting the job

msh> lpr chkhost {on|off}

• If "on" is selected, you can delete print jobs only from the IP address of the host that sent the print
job. If LPR is disabled, you can also delete print jobs sent from the IP addresses other than that
of the host.

netware

Use the "netware" command to configure the NetWare settings such as the print server name or file server
name.

Netware Printer Server Names

msh> netware pname "character string"

• Enter the NetWare print server name using up to 47 characters.

Netware File Server Names

msh> netware fname

• Enter the NetWare file server name using up to 47 characters.
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Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

Remote Printer Number

msh> netware rnum {0-254}

Timeout

msh> netware timeout {3-255}

Printer server mode

msh> netware mode pserver

msh> netware mode ps

Remote printer mode

msh> netware mode rprinter

msh> netware mode rp

NDS context name

msh> netware context "character string"

SAP interval

msh> netware "sap_interval"

Setting login mode for file server

msh> netware login server

Setting login mode for NDS tree

msh> netware login tree

Setting login mode for NDS tree name

msh> netware tree "NDS name"

File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

• If you do not specify the protocol, the current setting is displayed.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX
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passwd

Use the "passwd" command to change the remote maintenance password.

Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

Changing the Password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• You can delete the administrator password or set up a new one.

• Enter the new password.

• Renter the new password to confirm it.

• Be sure not to forget or lose the password.

• The password can be entered using up to 32 alphanumeric characters. Passwords are case-sensitive.
For example, "R" is not the same as "r".

pathmtu

Use the "pathmtu" command to display and configure the PathMTU Discovery service function.

View Setting

msh> pathmtu

Enabling / disabling the PathMTU Discovery service

msh> pathmtu {on | off}

• The default is "on".

• If the MTU size of the sent data is larger than the router's MTU, the router will declare it
impassable, and communication fails. If this happens, selecting the "pathmtu" to "off" optimizes
the MTU size and prevents data output failure.

• Depending on the environment, information might not be obtained from the router, and
communication will fail. If this happens, select the "pathmtu" to "off".

prnlog

Use the "prnlog" command to obtain printer log information.
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Print logs display

msh> prnlog

• Displays 16 previous print jobs.

msh> prnlog "ID Number"

• Specify the ID number of the displayed print log information to display additional details about
a print job.

• p.222 "Getting Printer Information over the Network"

route

Use the "route" command to view and control the routing table.

All route information display

msh> route get "destination"

• Specify the IPv4 address to destination.

• "0.0.0.0" cannot be specified as destination address.

• If you do not specify a destination address, all the information about the router is displayed.

Enabling/disabling Specified IPv4 Destination

msh> route active {host|net} "destination" {on | off}

• You can turn the specified destination on or off. Host becomes the default setting.

Adding IPv4 Routing Table

msh> route add {host|net} "destination" "gateway"

• Adds a host or network route to "destination", and a gateway address to "gateway" in the table.

• Specify the IPv4 address to destination and gateway.

• Host becomes the default setting.

Setting Default IPv4 Gateway

msh> route add default "gateway"

Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} "destination"

• Host becomes the default setting.

• IPv4 address of destination can be specified.

Setting IPv6 Default Gateway

msh> route add6 default "gateway"
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Adding a specified IPv6 destination to Routing Table

msh> route add6 "destination" "prefixlen" "gateway"

• Specify the IPv6 address to destination and gateway.

Deleting a specified IPv6 destination from Routing Table

msh> route delete6 "destination" "prefixlen"

• Specify the IPv6 address to destination and gateway.

Display information about a specified IPv6 route information

msh> route get6 "destination"

• Specify the IPv6 address to destination and gateway.

Enabling/disabling a specified IPv6 destination

msh> route active6 "destination" "prefixlen" {on | off}

Route initialization

msh> route flush

• The maximum number of IPv4 routing tables is 16.

• The maximum number of IPv6 routing tables is 2.

• Set a gateway address when communicating with devices on an external network.

• The same gateway address is shared by all interfaces.

• "Prefixlen" is a number between 1 and 128.

set

Use the "set" command to set the protocol information display "active" or "inactive".

View settings

The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Netware, SCSI print, and
SMB appears.

msh> set parallel
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msh> set usb

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

Configuration

• Enter "up" enable protocol, and enter "down" to disable protocol.

You can set the protocol to "active" or "inactive".

msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http, bonjour, and sftp.

Remote Maintenance by telnet

205

6



msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and sftp6.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set ssl {up | down}

msh> set ssl6 {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not available for the
printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set ssh {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}
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show

Use the "show" command to display network interface board configuration settings.

View settings

msh> show

• If "-p" is added, you can view settings one by one.

• p.228 "Understanding the Displayed Information"

slp

Use "slp" command to view and configure SLP settings.

msh> slp ttl "ttl_val"

• You can search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1 and
Netware 6/6.5. Using the "slp" command, you can configure the value of TTL which can be used by
SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local segment. If the router does not
support multicast, the settings are not available even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the "smb" command to configure or delete the computer or workgroup name for SMB.

Computer Name settings

msh> smb comp "computer name"

• Set computer name using up to 15 characters. Names beginning with "RNP" or "rnp" cannot be
entered.

Working Group Name settings

msh> smb group "work group name"

• Set workgroup name using up to 15 characters

Comment settings

msh> smb comment "comment"

• Set comment using up to 31 characters

Notify print job completion

msh> smb notif {on | off}
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• To notify print job completion, specify "on". Otherwise, specify "off"

Deleting Computer Nam

msh> smb clear comp

Deleting Group Name

msh> smb clear group

Deleting Comment

msh> smb clear comment

View Protocol

msh> smb protocol

snmp

Use the "snmp" command to display and edit SNMP configuration settings such as the community name.

View settings

msh> snmp

• Default access settings 1 is as follows:

Community name:public

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-only

Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:

Community name:admin

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-write

Effective Protocol:IPv4/IPv6/IPX

• If "-p" is added, you can view settings one by one.

• To display the current community, specify its registration number.

Display

msh> snmp ?
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Community name configuration

msh> snmp "number" name "community_name"

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor for
Client if "public" is not registered in numbers 1-10. When changing the community name, use
SmartDeviceMonitor for Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

Deleting community name

msh> snmp "number" clear name

Access type configuration

msh> snmp "number" type "access_type"

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages

Protocol configuration

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols "active" or "inactive": If you set a protocol "inactive",
all access settings for that protocol are disabled.

• Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.

• {on} means "active" and {off} means "inactive".

• All protocols cannot be turned off concurrently.

Configuration of protocol for each registration number

msh> snmp "number" active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command. However, if you have
disabled a protocol with the above command, activating it here has no effect.

Access configuration

msh> snmp "number" {ipv4|ipv6|ipx} "address"

• You can configure a host address according to the protocol used.
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• The network interface board accepts requests only from hosts that have IPv4, IPv6, and IPX
addresses with access types of "read-only" or "read-write". Enter "0" to have network interface
board accept requests from any host without requiring a specific type of access.

• Enter a host address to deliver "trap" access type information to.

• To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and then the IPv4 or IPv6
address.

• To specify IPX/SPX, enter "ipx" followed by a space, the IPX address followed by a decimal,
and then the MAC address of the network interface board.

sysLocation configuration

msh> snmp location

Deleting sysLocation

msh> snmp clear location

sysContact setting

msh> snmp contact

Deleting sysContact

msh> snmp clear contact

SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify "on" to enable, and "off" to disable.

Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}

• If a number from 1-5 is entered, settings are displayed for that number only.

Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} "address"
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Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account "account_name"

• Enter an account name using up to 32 alphanumeric characters.

Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}

Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

• Set "auto" for automatic encryption configuration

• Set "on" for mandatory encryption configuration.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Network Time Protocol (SNTP).
Use the "sntp" command to change SNTP settings.

View settings

msh> sntp

NTP server address configuration

You can specify the IP address of the NTP server.

msh> sntp server "IP_address"

Interval configuration

msh> sntp interval "polling_time"

• You can specify the interval at which the printer synchronizes with the operator-specified NTP
server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After
that, the printer does not synchronize with the NTP server.

Time-zone configuration

msh> sntp timezone "+/-hour_time"

• You can specify the time difference between the printer clock and NTP server clock. The values
are between -12:00 and +13:00.
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spoolsw

Use the "spoolsw" command to view and configure Job Spool settings.

You can only specify diprint, lpr, ipp, ftp, smb and sftp protocol.

• The "spoolsw" command for configuring Job Spool settings is available only when the optional hard
disk is installed.

View settings

The Job Spool setting appears.

msh> spoolsw

Job Spool setting

msh> spoolsw spool {on | off}

• Specify "on" to enable Job Spool, or "off" to disable it.

Resetting Job spool setting

msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines whether to reprint the spooled
job.

Protocol configuration

msh> spoolsw diprint {on | off}

msh> spoolsw lpr {on | off}

msh> spoolsw ipp {on | off}

msh> spoolsw smb {on | off}

msh> spoolsw ftp {on | off}

msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, smb and sftp.

ssdp

Use the "ssdp" command to view and configure SSDP settings.

View settings

msh> ssdp

Setting effective time

msh> ssdp profile {1801-86400}

• The default is 10800 seconds.
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Advertise packet TTL settings

msh> ssdp ttl {1-255}

• The default is 4.

ssh

Use the "ssh" command to view and configure SSH settings.

View settings

msh> ssh

Data compression communication settings

msh> ssh compression {on|off}

• The default is "on".

SSH/SFTP communication port setting

msh> ssh port {22, 1024-65535}

• The default is 22.

SSH/SFTP communication timeout setting

msh> ssh timeout {0-65535}

• The default is 300.

SSH/SFTP communication login timeout setting

msh> ssh logintimeout {0-65535}

• The default is 300.

Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"

• Create an open key for SSH/SFTP communication.

• Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".

• The default key length is 1024, and the character string is blank.

Deleting open key for ssh/sftp communication

msh> ssh delkey

• If you do not specify a character string, current setting is displayed.

status

Use the "status" command to display the printer status.
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Messages

msh> status

• p.222 "Getting Printer Information over the Network"

syslog

Use the "syslog" command to display the information stored in the printer's system log.

View message

msh> syslog

• p.239 "Message List"

upnp

Use the "upnp" command to display and configure the universal plug and play.

Public URL display

msh> upnp url

Public URL configuration

Msh< upnp url "string"

• Enter the URL string in the character string.

web

Use the "web" command to display and configure parameters on Web Image Monitor.

View Settings

msh> web

URL Configuration

You can set URLs linked by clicking URL on Web Image Monitor.

msh> web url http://"The URL or IP address you want to register"/

• Specify "1" or "2" for x as the number corresponding to the URL. Up to two URLs can be registered
and specified.

Deleting URLs registered as link destinations

msh> web x clear url
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• Specify "1" or "2" for x as the corresponding number to the URL.

Link name configuration

You can enter the name for URL that appears on Web Image Monitor.

msh> web name "Name you want to display"

• Specify "1" or "2" for x as the corresponding number to the link name.

Resetting URL names registered as link destinations

msh> web x clear name

• Specify "1" or "2" for x as the number corresponding to the link name.

Help URL Configuration

You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://"Help URL or IP address"/help/

Deleting Help URL

msh> web clear help

wiconfig

Use the "wiconfig" command to make settings for wireless LAN.

View settings

msh> wiconfig

View wireless LAN settings

msh> wiconfig cardinfo

• If wireless LAN is not working correctly, its information is not displayed.

Configuration

msh> wiconfig "parameter"

Parameter Value configured

mode {ap| 802.11adhoc} You can set infrastructure mode (ap) , or 802.11
ad hoc mode (802.11adhoc).

The default is 802.11 ad hoc mode.

ssid "ID value" You can make settings for the SSID in the
infrastructure mode.

Usable characters are ASCII 0x20-0x7e (32
bytes).
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Parameter Value configured

An SSID value is set automatically to the nearest
access point if no setting is made.

If no setting is made for the ad hoc mode, the
same value as for the infrastructure mode or an
ASSID value is automatically set. The default is
blank.

channel frequency "channel no." You can enable or disable the WEP function. To
enable the WEP function, specify [on]; to disable
it, specify [off].

To start the WEP function, enter the correct WEP
key. The default is "11".

key "key value" val {1|2|3|4} You can specify the WEP key when entering in
hexadecimal.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key, the WEP
specified by key phrase is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other. Put "0x" on the front of WEP key.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.
The default is blank.

keyphrase "phrase" val {1|2|3|4} You can specify the WEP key when entering in
ASCII.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key phrase, the
WEP specified by key is overwritten.
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Parameter Value configured

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.

encval {1|2|3|4} You can specify which of the four WEP keys is
used for packet encoding. "1" is set if a number
is not specified.

wepauth {open|shared} You can set an authorization mode when using
WEP. The specified value and authorized mode
are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate {auto|11m|5.5m|2m|1m} You can set the wireless LAN transmitting speed.

The speed you specify here is the speed at which
data is sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc  {tkip|ccmp} You can specify WPA encryption key when using
WPA encryption.

tkip: TKIP (default)

ccmp: CCMP (AES)

wpaauth {wpapsk | wpa} You can specify the WPA authentication mode
when using WPA encryption.

wpapsk: WPA-PSK authentication(default)
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Parameter Value configured

wpa: WPA(802.1X) authentication

psk "character string" You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63
bytes).

The default is blank.

eap {tls|ttls|leap|peap} {chap|mschap|
mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are
settings for the phase 2 method, and must be set
when using EAP-TTLS or PEAP.

Do not make these settings when using other EAP
authentication types.

If you select EAP-TTLS, you can select chap,
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or
tls.

username "character string" You can specify the login user name for the
Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes)
other than "@". The default is blank.

username2 "character string" You can specify the phase 2 username for EAP-
TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 bytes)
other than "@". The default is blank.

domain "character string" You can specify the login domain name for the
Radius server.

Usable characters: ASCII0x20-0x7e (31 bytes)
other than "@". The default is blank.

password "character string" You can specify the login password for the
Radius server.
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Parameter Value configured

Usable characters: ASCII 0x20-0x7e(128
bytes). The default is blank.

srvcert {on | off} You can set the server certificate. The default is
"off".

imca {on | off} You can enable or disable the certificate when
the intermediate certificate authority is present.
The default is "off".

srvid "character string" You can set the server ID and subdomain of the
certificate server.

• You can use this command only when the wireless LAN interface unit is installed.

wins

Use the "wins" command to configure WINS server settings.

Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 address, the DHCP address
is the valid address.

Configuration

msh> wins "interface_name" {on | off}

• {on} means "active" and {off} means "inactive".

• Be sure to specify the interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface

Address configuration

Use the following command to configure a WINS server IP address:

msh> wins "interface_name" {primary|secondary} "IP address"

• Use the "primary" command to configure a primary WINS server IPv4 address.
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• Use the "secondary" command to configure a secondary WINS server IPv4 address.

• Do not use "255.255.255.255" as the IPv4 address.

NBT (NetBIOS over TCP/IP) Scope ID Selection

You can specify the NBT scope ID.

msh> wins "interface_name" scope "scope ID"

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the wireless LAN interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan Wireless LAN interface
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SNMP
The SNMP agent operating on UDP and IPX is incorporated into the built-in Ethernet board and optional
wireless LAN interface unit of this printer.
Using the SNMP manager, you can get information about the printer.

• If you changed the printer's community name, change the configuration of the connected computer
accordingly, using SNMP Setup Tool. For details, see SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB information using these community
names.

Start SNMP Setup Tool

• Windows XP/Vista:

Click the [Start] button.

Point to SmartDeviceMonitor for Admin on the [All Programs] menu.

Click [SNMP Setup Tool].

Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network
This section explains details of each item displayed in the printer status and information.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the "lpq" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "status" command.

Messages Description

Access Restricted The job was canceled because user have no
authority.

Adjusting... The printer is initializing or calibrating.

Call Service Center There is a malfunction in the printer.

Canceled The job is reset.

Canceling Job... The job is being reset.

Configuring... Setting is being changed.

Cooling Down Fusing Unit... Fusing unit is cooling down.

Cover Open: Duplex Unit The cover of the duplex unit is open.

Cover Open: Front Cover The front cover is open.

Empty: Black Toner The black toner cartridge is almost empty.

Energy Saver Mode The printer is in Energy Saver Mode.

Error An error has occurred.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Optional Font An error has occurred in the font file of the printer.

Error: Parallel I/F Board An error has occurred in the parallel interface.
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Messages Description

Error: PDL An error has occurred in the page description
language.

Error: Rem. Certificate Renewal An error has occurred in the remote certificate
renewal.

Error: USB Board An error has occurred in the USB board.

Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Card Wireless card is not inserted during start up, or
taken out after start up.

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode.

Independent-supplier Toner Toner that is not recommended is set.

In Use: Input Tray Other functions is using the input tray.

Jobs Suspended All jobs are suspended.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Malfunction: Duplex Unit There is a problem with duplex unit.

Malfunction:Lower Paper Tray(s) There is a problem with the Lower Paper Tray.

Malfunction: Output Tray There is a problem with output tray.

Memory Low: Data Storage Memory shortage has occurred while the
document was being accumulated.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of
selected size and type.
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Messages Description

Mismatch: Paper Type Indicated paper tray does not contain paper of
selected type.

Near Replacing: Fusing Unit Prepare the new fusing unit.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

No Paper: Selected Tray There is no paper in specified tray.

No Paper: Tray 1 There is no paper in tray 1.

No Paper: Tray 2 There is no paper in tray 2.

No Paper: Tray 3 There is no paper in tray 3.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Duplex Feed Unit The duplex feed unit is not correctly set.

Not Detected: Duplex Unit The duplex unit is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.

Not Reached, Data Stored Unreached job is preserved.

Offline Printer is offline.

Operating Thermo-range Error Exceeded appropriate thermo range.

Panel Off Mode The printer is in Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit.

Paper Misfeed: Input Tray The paper has jammed in the input tray.

Paper Misfeed: Internal/Output The paper has jammed inside the printer.
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Messages Description

Print Complete The print was completed.

Printing Printing is in progress.

Processing Data is being processed.

Proxy Address/Port Incorrect Proxy address or Port No. is incorrect.

Proxy User/Password Incorrect Proxy user name or Password is incorrect.

RC Gate Connection Error Failed connection with RC Gate.

Ready The printer is ready to print.

Renewing Remote Certificate Remote Certificate is Renewing.

Replace Charger Kit It is time to replace the charger kit.

Replace Cleaning Web It is time to replace the Cleaning Web.

Replace Fusing Unit It is time to replace the fusing unit.

Replace Int. Transfer Unit It is time to replace the transfer unit.

Replace Transfer Cleaning Unit It is time to replace the transfer cleaning unit.

SD Card Authentication failed SD card authentication failed.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Transmission Aborted The transmission was interrupted.

Transmission Complete The transmission completion was completed.

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has
occurred because chaptering as well as the
normal paper use the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex
printing.
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Messages Description

Waiting for Job Suspension All jobs are being suspended.

Warming Up... The printer is warming up.

• For details about UNIX commands, see UNIX Supplement.

• Check the error contents that may be printed in the configuration page. For details about printing a
configuration page, see "List/Test Print Menu".

• p.135 "List/Test Print Menu"

Printer Configuration

You can check the printer configuration using telnet.
This section explains the checking procedure for input/output tray and printer language.

• UNIX: Use the "info" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "info" command.

Input Tray

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal:Normal

• NoInputTray: No tray

• PaperEnd:No paper

Output Tray

Item Description

No. ID number of the output tray

Name Name of the output tray
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Item Description

status Current status of the output tray

• Normal:Normal

• PaperExist:Paper exist

• OverFlow:Paper is full

• Error:Other errors

Printer Language

Item Description

No. ID number of the printer language used by the
printer

Name Name of the printer language used in the printer

Version Version of the printer language

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see "Remote Maintenance by telnet".

• p.188 "Remote Maintenance by telnet"
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Understanding the Displayed Information
This section explains how to read status information returned by the network interface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the "info" command and "rsh", "rcp", and "ftp" parameters.

• mshell: Use the "info" command.

Item Description

Rank Print job status.

• active

Printing or preparing for printing.

• Waiting

Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see "Remote Maintenance by telnet".

• p.188 "Remote Maintenance by telnet"

Print Log Information

This is a record of the most recent 16 jobs printed.
Use the following command to display print log information:

• UNIX: Use the "prnlog" command and "rsh", "rcp", and "ftp" parameters.
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• telnet : Use the "prnlog" command. See Remote Maintenance by telnet.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result Print Request Result

Communication Result

• OK

Print was completed normally. However, the
print result may not be as required due to
printer problems.

• NG

Printing was not completed normally.

• Canceled

An "rcp", "rsh", or "lpr" command print request
was canceled, possibly due to the printing
application. Not applicable to the "ftp" or
"rprinter" command.

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "prnlog" commands, see "Remote Maintenance by telnet".

• p.188 "Remote Maintenance by telnet"
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Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the "show" command.

Item Description

Common

Mode

Protocol Up/
Down

Protocol Settings

AppleTalk

IPv4

IPv6

NetWare

SMB

SCSI print

Device Up/Down Device Settings

Parallel

USB

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk Settings
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Item Description

Mode

Net

Object

Type

Zone

TCP/IP

Mode (IPv4)

Mode (IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

Bonjour

ssl

nrs

rfu

nbt

ssdp
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Item Description

ssh

sftp

IPv4 TCP/IP Settings

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless

Manual

Gateway

EncapType

Host name

DNS Domain

Access Control Access Control
Settings

IPv4

Access Entry [X]
X can be set
between 1 and 5.

IPv6

Access Entry [X]
X can be set
between 1 and 5.

Time server Time Settings

Time Zone
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Item Description

Time server polling
time

SYSLOG server Websys Settings

Home page URL1

Home page link
name1

URL of home page

Home page URL2

Home page link
name2

Help page URL

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name

Transfer Protocol
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Item Description

SMB SMB Settings

Switch

Mode

Direct print

Notification

Workgroup name

Computer name

Comment

Share name[1]

Protocol

SCSI print

Bidi

IEEE 802.11b
Wireless LAN
Settings

Host name

Communication
Mode

SSID

Channel range

Channel

TX Rate

Security

WEP
Authentication

WEP Encryption
key number
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Item Description

WEP Encryption
keys[X]

X can be set
between 1 and 5.

WPA Encryption

WPA
Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method
TTLS

Phase 2 Method
PEAP

Server cert

Intermediate CA

Server ID

DNS DNS Settings

IPv4

Server [X]
X can be set
between 1 and 3.

Select IPv4 DNS
Server

IPv6

Server [X]
X can be set
between 1 and 3.
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Item Description

Domain name

ether

wlan

DDNS

ether

wlan

WINS WINS Settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

SSDP SSDP Settings

Ad_Mode

UUID

Profile

TTL

UPnP UPnP Settings

URL

Bonjour
Bonjour
(Rendezvous)
Settings

Computer Name
(cname)
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Item Description

Local Hostname
(ether)

Local Hostname
(wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for
Multi I/F

IPP Port

SNMP SNMP Settings

SMNPv1v2

SMNPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2
Remote Setting

SNMPv3 Privacy

ssh ssh Settings

Compression

Port

Timeout
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Item Description

LoginTimeOut

AuthFree Authfree Settings

IPv4

AuthFree Entry [X] X can be set
between 1 and 5.

IPv6

AuthFree Entry [X] X can be set
between 1 and 5.

Parallel

USB

LPR

Iprm check host

lpr prnerrchk

Certificate

Verification

Shell mode
Remote
maintenance tool
mode
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Message List
This is a list of messages that appear in the printer's system log. The system log can be viewed using the
"syslog" command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the "syslog" command and "rsh", "rcp", "ftp", and "sftp" parameters.

• telnet : Use the "syslog" command.

Message Problem and solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print server
on the NetWare server or the password was
incorrect.

(In the print server mode) Login to the file server
failed. Make sure that the print server is registered
on the file server. If a password is specified for the
print server, delete it.

account is unavailable: Same account name be
used.

User account is disabled. This could be because it
use the same account name as the administrator
account.

account is unavailable: The authentication
password is not set up.

User account is disabled. This could be because the
authentication password is not set, and only the
encryption account is set.

account is unavailable: encryption is impossible. Encryption is not possible and account is disabled.
This could be because:

• Security option is not installed.

• Encryption password has not been specified.

add_sess_IPv4: bad trap<IPv4 address>,
community:<community name>

The IPv4 address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify the host
IPv4 address for the TRAP destination.

add_sess_IPv6: bad trap<IPv6 address>,
community:<community name>

The IPv6 address [::] is unavailable when the
community access type is TRAP. Specify the host
IPv6 address for the TRAP destination.

add_sess_IPv4: community<community name>
already defined.

The same community name already exists. Use
another community name.
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Message Problem and solutions

add_sess_IPv6: community <community name>
already defined.

The same community name already exists. Use
another community name.

add_sess_IPX: bad trap<IPX address>community
<community name>

The IPX address (00:00:00:00:00:00) is
unavailable when the community access type is
TRAP. Specify the host IPX address for the TRAP
destination.

add_sess_IPX: community <communityname>
already defined.

The same community name already exists. Use
another community name.

Attach FileServer= <file servername> Connection to the file server as the nearest server
has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the print
queue.

Authentication mode mismatch< SSID > Authentication mode is different to the AP. The
required SSID is the SSID of the access point
connected to when in infrastructure mode.

centrod is disabled. Communication via parallel connections
unavailable because centrod is disabled in the
security mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the file
server has not been established. The number of file
server users may have exceeded the maximum
capacity of the file server.

Cannot find rprinter (<print server name>/<printer
number>)

The printer with the number displayed on the print
server does not exist. Make sure that the printer
number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is
renewed. To always assign the same IP address,
set a static IP address to the DHCP server.

child process exec error! (process name) The network service failed to start. Turn the printer
off and then on. If this does not work, contact your
service or sales representative.
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Message Problem and solutions

Client password rejected The client's password was rejected. Check the client
password.

Client tls certificate rejected The client's TLS certificate was rejected. Check the
certificate.

Connected DHCP Server(<DHCP serveraddress>). The IP address was successfully received from the
DHCP server.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the file
server has not been established. The file server has
refused the connection. Check the file server
configuration.

Could not attach to PServer<print server> (In the remote printermode) Connection to the print
server has not been established. The print server
has refused the connection. Check the print server
configuration.

Current Interface Speed: xxxMbps Speed of the network (10Mbps, 100 Mbps, or
1Gbps).

Current IP address <currentIP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired. The printer tries to
discover the DHCP server again. The IP address
until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure that the
DHCP is on the network.

dhcpcd start. The DHCPCD service (dhcp client service) has
started.

Duplicate IP=<IP address>(from<MAC address>). The same IP address (IPv4, or IPv6 address) was
used. Each IP address (IPv4, or IPv6 address) must
be unique. Check the address of the device
indicated in [MAC address].

Established SPX Connection with PServer,
(RPSocket=<socketnumber>, connID=<connection
ID>)

(In the remote printer mode) Connection to the print
server has been established.
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Message Problem and solutions

exiting The lpd service has ended and the system is exiting
the process.

Exit pserver (In the print server mode) The print server function
is disabled because the necessary print server
settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used on
NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays wireless LAN communication mode.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Address (IP
address).

The same IP (IPv4 or IPv6) address was used. Each
IP address must be unique. Check the address of
the device indicated in [IP address].

< Interface > started with IP: < IP address > IP address (IPv4, or IPv4 address) has been set for
the interface and is operating.

< Interface >: Subnet overlap. The same IP address (IPv4, or IPv6 address) and
the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of the
user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or user
request.

LeaseTime=<lease time>(sec),
RenewTime=<renewtime>(sec).

The resource lease time received from the DHCP
server is displayed in [lease time] in seconds. The
renewal time is displayed in [renew time] in
seconds.

Login to fileserver <file server name> (<IPX|IPv4|
IPv6>,<NDS|BINDERY>)

(In the print server mode) Login to the file server is
in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained.

Disconnect the USB cable, and then connect it.
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Message Problem and solutions

Name registration success. WINS Server=<WINS
server address> NetBIOS Name=<NetBIOS
name>

Name registration of <NetBIOS Name> to <WINS
server address> was successful.

Name registration success in Broadcast
name=<NetBIOS Name>

Name registration by Broadcast name of
<NetBIOS Name> was successful.

Name registration failed. name=<NetBIOS name> Name registration of <NetBIOSName> failed.
Change to different NetBIOS name.

nbtd start. The nbtd service has started.

nprinter start (Netware) (In the remote printer mode) The NetWare service
has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting has
started.

Open log file <file name> (In the print server mode) The specified log file has
been opened.

phy release file open failed. Replacing the network interface board is required.
Contact your sales or service representative.

Print queue <print queue name> cannot be serviced
by printer 0, <print server name>

(In the print server mode) The print queue cannot
be established. Make sure that print queue exists
on the specified file server.

Print server <print servername>has no printer. (In the print server mode) The printer is not assigned
to the print server. Using NWadmin, assign the
printer, and then restart it.

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is not
assigned to the printer. Using NWadmin, assign the
print queue to the printer, and then restart it.

pserver start. (NetWare) (In the print server mode) The NetWare service has
started.

Required file server (<file servername>) not found The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.
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Message Problem and solutions

sap enable, saptype=<SAP type>, sapname=<SAP
name>

The SAP function has started. The SAP packet is
issued to advertise the service on the SAP table on
the NetWare server.

server identity invalid The server ID is disabled. Check the server
authentication.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session <community name> already defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

Set context to <NDS contextname> An NDS context name has been set.

smbd start. (NETBIOS) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be obtained.
This could be because:

• The specified DNS server could not be found.

• No connection to the network has been
established.

• The specified DNS server could not be found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address could
not be found in the DNS server.

SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to
timeout. This could be because the specified SMTP
server name is incorrect, or no connection to the
network has been established, or the network
configuration is incorrect, so there is no response
from the SMTP server. Check the SMTP server
name, or the network connection and
configuration.

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This could
be because server other than the SMTP server has
been specified, or the specified SMTP server port
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Message Problem and solutions

number is incorrect. Check the SMTP server name,
port number, or the SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to no
response from SMTP. This could be because a
server other than the SMTP server has been
specified, or the specified SMTP server port number
is incorrect. Check the SMTP server name, port
number, or the SMTP server port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This could be
because no connection to the network has been
established, or the network configuration is
incorrect, so there is no response from the SMTP
server, or the specified SMTP server name is
incorrect, or the specified SMTP server IP address
could not be found in the DNS server, or a server
other than the SMTP server has been specified, or
the specified SMTP server port number is incorrect.
Check the DNS Server's IP address and SMTP
server's IP address, or the SMTP server name and
SMTP port number, or the SMTP server's SMTP port
number, or the network connection and
configuration.

SMTPC: username or password wasn't correct.
[response code] (information)

Connection to the SMTP server failed, because the
specified SMTP user name is incorrect, or the
specified SMTP password is incorrect. Check the
SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over IPX is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The bonjour (rendezvous) function is enabled.

Terminated. The bonjour (rendezvous) function is disabled.
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Message Problem and solutions

The print server received error <error number>
during attempt to log in to the network. Access to
the network was denied. Verify that the print server
name and password are correct.

Login to the file server failed. The print server is not
registered or a password is specified. Register the
print server without specifying a password.

trap account is unavailable. v3Trap cannot be sent. This could be because the
Trap destination account is different from the
account specified by the printer.

usbd is disable. Plug and Play function and printing is disabled
because usbd is disabled in the security mode.

Enable usbd in the security mode.

WINS name registration: No response to
server<WINS server address>

There was no response from the WINS server.
Check the correct WINS server address is entered.
Alternatively, check the WINS server is functioning
properly.

WINS wrong scopeID=<Scope ID> An invalid scope ID was used. Use a valid scope
ID.

wpa authentication Failed WPA authentication failed. Check the WPA
configuration.

wpa authentication started WPA authentication has started.

wpa IEEE802.1X started WPA authentication has started.

wpa connecting to authenticator WPA is connecting to authenticator.

wpa link up WPA key exchange has finished, and
communication has been terminated.

wpa probe response doesn't have IE. WPA probe response does not have IE.

wpa success authenticated WPA authentication was successful.

wpa success key received WPA key reception was successful.

wpa waiting for key Waiting for WPA key.

wpasupd start wpasupd has started.

wpasupd stop wpasupd has ended.
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• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about "syslog" command, see Remote "Remote Maintenance by telnet".

• p.188 "Remote Maintenance by telnet"

Message List
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7. Using a Printer Server

Preparing Printer Server
This section explains how to configure the printer as a Windows network printer. The printer is configured
to enabling network clients to use it. When the network printer is connected via SmartDeviceMonitor for
Client, you can set the printing notification function to notify clients of the results of their print jobs.

• Under Windows 2000, Windows XP Professional, or Windows Server 2003/2003 R2, to change
printer properties in the [Printer] folder, you need Printer Management access authentication; under
Windows Vista, Full Control access authentication. Log on to the file server as an Administrator or
member of the PowerUsers group.

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties]. The printer
properties appear.

3. On the [Sharing] tab, click [Shared as:].

4. To share the printer with users using a different version of Windows, click [Additional
Drivers...].

If you have installed an alternative driver by selecting [Shared as:] during the printer driver installation,
this step can be ignored.

5. Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification function of
SmartDeviceMonitor for Client.

Setting the print server

• Under Windows 2000, Windows XP Professional, or Windows Server 2003/2003 R2, to change
printer properties in the [Printer] folder, you need Printer Management access authentication; under
Windows Vista, Full Control access authentication. Log on to the file server as an Administrator or
member of the PowerUsers group.
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1. On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Print Server Setting].

The print server setting dialog box appears.

2. Select the [Notify client PCs of printout/data-transmission] check box, and then click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog box content, and click
[OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting.

3. A dialog box for specifying clients appears. Click [OK].

The print server setting is complete. Clients must be specified in order to receive notification.

• Current printing jobs restart from the beginning after the spooler pauses briefly.

• When the expansion function is not used, the function is automatically set as available.

• If you log on using an account that does not have Administrator privileges, the client may not be
notified.

Setting a Client

1. On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor for
Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

2. Select the [Use Extended Features] check box.

3. Select the [Notify of printout/data-transmission when using print server] check box in
"Notification".

4. Click [OK].

The dialog box for setting the expansion function closes.

The client setting is completed.

• Set the printing notification function on the printer driver as well as on SmartDeviceMonitor for
Client.
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Using NetWare
This section describes the setting procedure for network printers in the NetWare environment. In the
NetWare environment, you can connect the printer as a "print server" or "remote printer".

• IPv6 cannot be used on this function.

Setting procedure

• When using the printer as a print server

1. Installing SmartDeviceMonitor for Admin

2. Setting the network interface board.

3. Turning the printer off and then back on.

• When using the printer as a remote printer

1. Installing SmartDeviceMonitor for Admin.

2. Setting the network interface board.

3. Setting NetWare.

4. Starting the print server.

• This procedure assumes an environment is already prepared for normal NetWare running
the printing service setting.

• The procedure is explained with the following example settings:

• File server's name ...CAREE

• Print server's name ...PSERV

• Printer's name ...R-PRN

• Queue name ...R-QUEUE

Using SmartDeviceMonitor for Admin

To use the printer in a NetWare environment, use SmartDeviceMonitor for Admin to set the NetWare
printing environment.

• The NetWare Client provided by Novell is required to set the printing environment using
SmartDeviceMonitor for Admin under the following environments:

• NDS or Bindery mode in Windows 2000/XP

• p.169 "Using SmartDeviceMonitor for Admin"
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Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin lists printers connected to the network. If you cannot identify the printer
you want to configure, print configuration page, and then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using NetWare 3.x.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. In the left area, click [Configuration], and then click [NetWare] in "Network".

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use up
to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote printer.
Enter the same number as the number of the printer to be created on the print server (0 to 254
characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer cannot
detect when a print job ends. Therefore, the printer terminates printing when a certain period of
time has elapsed since it last received print data (i.e., when it has not received print data for a
certain period of time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several before restarting Web Image Monitor.
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6. Click [Logout].

• To check that the configuration is made correctly, enter the following from the command prompt.

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name with the configuration
page printed from the printer. For details about printing a configuration page, see "List/Test Print
Menu".

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• p.135 "List/Test Print Menu"

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using NetWare 4.x, NetWare 5/5.1,
or NetWare 6.0.

• When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or NetWare 6.0, set it to
the NDS mode.

• When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. In the left area, click [Configuration], and then click [NetWare] in "Network".

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use up
to 32 alphanumeric characters.
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• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote printer.
Enter the same number as the number of the printer to be created on the print server (0 to 254
characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer cannot
detect when a print job ends. Therefore, the printer terminates printing when a certain period of
time has elapsed since it last received print data (i.e., when it has not received print data for a
certain period of time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

• To check that the configuration is made correctly, enter the following from the command prompt.

F:> NLIST USER/A/B

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name with the configuration
page printed from the printer. For details about printing a configuration page, see "List/Test Print
Menu".

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and printer.
Use the [Network] dialog box of Windows to change the frame type of the computer.

• p.135 "List/Test Print Menu"

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP environment of NetWare
5/5.1.

• When creating a queued print server in a pure IP environment of NetWare 5/5.1 or NetWare 6.0,
create a print queue on the file server using NetWare Administrator.

• This printer is not available as a remote printer for use in a pure IP environment.
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• To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Select the object in which the print queue is located in the directory tree, and then click
[Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Select the object in which the printer is located, and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name

11. Select the [Define additional properties] check box, and then click [Create].

12. Click [Assignments], and then click [Add] in the [Assignments] area.

13. In the [Available objects] box, click the queue you, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK].

16. Check the settings, and then click [OK].

17. Select a context specified using NIB Setup Tool, and then click [Create] on the [Object] menu.

18. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

19. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

20. Select the [Define additional properties] check box, and then click [Create].

21. Click [Assignments], and then click [Add] in the [Assignments] area.

22. In the [Available objects] box, click the queue you created, and then click [OK].

23. Check the settings, and then click [OK].

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.
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To exit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.

4. In the left area, click [Configuration], and then click [NetWare] in "Network".

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare 3.x.

Setting up using PCONSOLE

1. Enter "PCONSOLE" from the command prompt.

F:> PCONSOLE

2. Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

3. From the [Available Options] menu, select [Print Queue Information], and then press the
[Enter] key.

4. Press [Insert] key, and then enter a print queue name.

5. Press [Esc] key to return to the [Available Options] menu.

6. Set up the network connection to a printer.

7. On the [Available Options] menu, click [Print Server Information], and then press the [Enter]
key.

8. To create a new print server, press the [Insert] key, and then enter a print server name.

For a currently defined print server, select a print server in the [Print Server] list.

9. From the [Print Server Information] menu, select [Print Server Configuration].

7. Using a Printer Server
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10. From the [Print Server Configuration] menu, select [Printer Configuration].

11. Select the printer indicated as [Not Installed].

12. To change the printer name, enter a new name.

A name "Printer x" is assigned to the printer. The "x" stands for the number of the selected printer.

13. As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

14. Press the [Esc] key, and then click [Yes] on the confirmation message.

15. Press the [Esc] key to return to [Print Server Configuration Menu].

16. Assign print queues to the created printer.

17. From [Print Server Configuration Menu], select [Queues Serviced By Printer].

18. Select the printer created.

19. Press the [Insert] key to select a queue serviced by the printer.

You can select several queues.

20. Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

21. Press the [Esc] key until "Exit?" appears, and then select [Yes] to exit PCONSOLE.

22. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

• If the printer works as configured, the message "Waiting for job" appears.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.

4. In the left area, click [Configuration], and then click [NetWare] in "Network".

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.
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6. Click [Logout].

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under NetWare 4.x, 5/5.1 and 6.

• To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS mode.

• Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Set up the network connection to a print queue. Select the object in which the print queue is
located in the directory tree, and then click [Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Set up the network connection to a printer. Select the object in which the printer is located,
and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name

11. Select the [Define additional properties] check box, and then click [Create].

12. Assign print queues to the created printer. Click [Assignments], and then click [Add] in the
[Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK]. Check the
settings, and then click [OK].

16. Set up the network connection to a print server. Select a context specified using NIB Setup
Tool, and then click [Create] on the [Object] menu.
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17. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

18. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

19. Select the [Define additional properties] check box, and then click [Create].

20. Assign the printer to the created print server. Click [Assignments], and then click [Add] in
the [Assignments] area.

21. In the [Available objects] box, click the queue you created, and then click [OK].

22. In the [Printers] area, click the printer you assigned, and then click [Printer Number].

23. Enter the printer number, and then click [OK]. Check the settings, and then click [OK].

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To exit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

25. Enter the printer server name as the context name, and then press the [OK] key.

26. Select the printer name on the context menu, and then press the [OK] key.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.

4. Click [Configuration] in the left area, and then click [NetWare] in "Network".

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].
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8. Special Operations under Windows

Printing Files Directly from Windows
You can print files directly using Windows commands. For example, you can print PostScript files for
PostScript 3.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2

You can print files directly using "lpr", "rcp" or "ftp" command.

• To use "sftp" commands, use an sftp client software that is compatible with ssh v2.

Setup

Follow the procedure below to make network environment settings.

1. Enable TCP/IP with the control panel, and then set up the printer's network environment
about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

2. Install a TCP/IP in Windows to set up the network environment.

Consult the administrator for the local setting information.

3. To print under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2, install
"Printing service for UNIX" as the network application.

• For details about setting up IPv4 address, see Hardware Guide.

• For details about setting the IPv4 address of the printer using DHCP, see "Cautions to Take When
Using in a Network".

• This completes the setup for specifying a printer using an IPv4 address when printing. When using a
host name to specify a printer, proceed to "Using a Host Name Instead of an IPv4 Address" and
continue the setup.

• p.311 "Cautions to Take When Using in a network"

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of IPv4 address. The host
names vary depending on the network environment.
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When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

• For details about printing a configuration page, see p.135 "List/Test Print Menu".

In other cases

Add the IPv4 address and host name of the network printer to the hosts file on the computer used for printing.
Methods of addition vary depending on operating systems.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2

1. Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows 2000/XP/Vista, Windows
Server 2003/2003 R2.

2. Add an IPv4 address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.

3. Save the file.

• When using a host name under Windows Server 2003/2003 R2 with IPv6 protocol, perform host
name resolution using an external DNS server. The host file cannot be used.

Printing Commands

The following explains printing operations using the "lpr", "rcp" and "ftp" commands.

Enter commands using the command prompt window. The location of the command prompts varies
depending on operating systems:

• Windows 2000

8. Special Operations under Windows
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[Start] - [Programs] - [Accessories] - [Command Prompt]

• Windows XP, Windows Vista, Windows Server 2003/2003 R2

[Start] - [All Programs] - [Accessories] - [Command Prompt]

• Match the data format of the file to be printed with the emulation mode of the printer.

• If the message "print requests full" appears, no print jobs can be accepted. Try again when sessions
end. For each command, the amount of possible sessions is indicated as follows:

• lpr: 10

• rcp, rsh: 5

• ftp: 3

• Enter the file name in a format including the path from the directory executing commands.

lpr

When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass name\file name

When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file name

When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named "file 1" located in the "C:
\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...] printer's host name:

[option]

• In file names, "*" and "?" can be used as wild cards.

• When printing a binary file, add the "-b" option.

When using a printer with the host name "host" to print a PostScript file named "file 1" or "file 2" located in
the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

Printing Files Directly from Windows

263

8



ftp

Use the "put" or "mput" command according to the number of files to be printed.

When one file is printed

ftp> put \pass name\file name [option]

When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...] [option]

1. Formulate the printer's IP address or the host name of the hosts file printer as an argument
and use the "ftp" command.

% ftp printer's IP address

2. Enter the user name and password, and then press the [OK] key.

For details about the user name and password, consult your administrator.

User:

Password:

3. When printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

4. Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1" in the "C:\PRINT"
directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS

ftp> mput C:\PRINT\file1 C:\PRINT\file2

5. Quit ftp.

ftp> bye

• "=", ",", "_", and ";"cannot be used for filenames. File names will be read as option strings.

• For "mput" command, option can not be defined.

• For "mput" command, "*" and "?" can be used as wild cards in file names.

• When printing a binary file in ASCII mode, print may not come out correctly.
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9. Mac OS Configuration

Mac OS
This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual
of the Mac OS you are using for details.

• For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

• USB can be used only with Mac OS 9.2.2.

• The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD) files to print from a Mac
OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 and
higher.

PostScript 3 Printer Driver

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [PS Driver] folder.

5. Double-click the folder of the language you use.

6. Open [Disk1], and then double-click the installer icon.

7. Follow the instructions on the screen.

PPD Files

1. Double-click the CD-ROM drive icon.

2. Double-click the [Mac OS 8 and 9] folder.

3. Double-click the [Printer Descriptions] folder.

4. Double-click the folder of the language you use.
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5. Open the [Disk1] folder.

6. Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions] under [System
Folder].

7. Restart the Mac OS.

Setting Up PPD Files

• Make sure that the printers are connected to an AppleTalk network before performing the following
procedure.

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.

3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

4. Click [Create].

5. Click the printer you want to use, and then click [Select PPD].

6. A PPD file is set up and the Adobe PS icon appears at the left of the printer name in the list.

Using USB Interface

To use a printer connected by USB, create a desktop printer icon.

• Make sure that printers are connected to the USB before performing the following procedure.

• USB can be used only with Mac OS 9.2.2.

1. Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

2. Click [AdobePS] in [With], click [Printer (USB)] in [Create Desktop], and then click [OK].

3. Click [Change] in [USB Printer Selection].

4. Select the model you are using in [Select a USB Printer:], and then click [OK].

5. Click [Create].

6. Enter the printer name, and then click [Save].

7. Quit Desktop Printer Utility.

Setting Up Options

1. On the [Apple] menu, click [Chooser].
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2. Click the [Adobe PS] icon.

3. In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and
then click [Setup...].

4. Click [Configure].

A list of options appears.

5. Select the option you want to set up, and then select an appropriate setting for it.

6. Click [OK].

The list of options closes.

7. Click [OK].

The [Chooser] dialog box appears.

8. Close the [Chooser] dialog box.

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Installing Adobe Type Manager

• Quit all applications currently running before installation. Install ATM after you restart the computer.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive con.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [ATM] folder.

5. Double-click the [ATM 4.6.2 installer] icon.

6. Follow the instructions on the screen.

7. When the procedure is complete, restart the computer. ATM will be completely installed only
after restarting.

8. On the [Apple] menu, open [Control Panel], and then click [~ATM].

The ATM control panel opens.

• For details about installation, see the operating instructions in the ATM folder.
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Installing Screen Fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

1. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

2. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [Fonts] folder.

5. Double-click the [ScreenFonts] folder.

6. Double-click the [TrueType] or [Type1] folder.

Select the font type you want to use.

7. Copy the fonts you want to install in [Fonts] folder under [System Folder].

8. A confirmation message appears.

9. Click [OK].

The fonts are installed.

10. Restart the Mac OS.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

1. Open [Control Panel], and then double-click the [AppleTalk] icon.

2. On the [Connect via:] pop-up menu, click [Ethernet].

3. If you change zones, select a name on the [OK] pop-up menu.

4. Close the AppleTalk control panel.

5. Restart the computer.

• The procedures used to configure Mac OS may vary depending on the Mac OS version. The following
describes how to configure Mac OS 9.1. If you are using a different version of Mac OS, use the
following procedures as a reference and see the manuals for your Mac OS version.

• Confirm the Connection to the Printer with TCP/IP.
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• For information about installing applications required for EtherTalk, see the Mac OS manuals.
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Mac OS X
This section explains how to configure a Mac OS X to use EtherTalk and USB.

Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the
manual of the Mac OS X you are using for details.

• For Mac OS X 10.1 or higher.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

• The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, consult your administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the [MacOSX PPD Installer] folder.

5. Double-click the installer icon.

6. Follow the instructions on the screen.

Setting Up PPD Files

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click [More Printers...]. Then select the zone from the second pop-up menu.

Other Mac OS X

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.
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3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, select the printer you are using from the [Print Using] popup menu.

A list of printer types appears.

4. Select the PPD file for the model you are using, and then click [Add].

5. Quit Printer Setup Utility.

Setting Up Options

1. Start System Preferences.

2. Click [Print & Fax].

3. In the [Printer] list, click the name of the printer you want to use, and then click [Printer
Setup...].

4. Select the option you want to set up, and then select an appropriate setting for it.

5. Click [Apply Changes].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Using USB Interface

Follow the procedure below to setup USB connection.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has "USB" indicated in the "Connection" column.

Other Mac OS X

Click [USB] on the pop-up menu.

The connected printer appears.

3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.

A list of printer types appears.

4. Select the connected printer from the list of printer models, and then click [Add].

Mac OS X

271

9



5. Quit Printer Setup Utility.

• When printing with a USB connection to a Macintosh computer, printer language does not change
automatically. Use the control panel on this printer to change printer language to [Auto Detect] or
[PS] before printing.

Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS X 10.2.3 or higher.
Ethernet, wireless LAN connections can also be used.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has "Bonjour" indicated in the "Connection" column.

Other Mac OS X

Click [Rendezvous] on the pop-up menu.

3. Select the name of the connected printer from the list of printer models, and then click [Add].

Under Mac OS X 10.4 or later, Installable Options window appears. Select the option you want to
set up, and then select an appropriate setting for it, and then [Continue].

4. Quit Printer Setup Utility.

When printing with a Rendezvous connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto Detect]
or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

• You need an administrator name and a password (phrase). For details, consult your administrator

1. Open [System Preference], and then click the [Network] icon.

2. Click [Built-in Ethernet] in the [Show:] list box.

3. Click the [AppleTalk] tab.

4. Select the [Make AppleTalk Active] check box.

5. To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up menu.
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6. When the settings are made, click [Apply Now].

7. Quit [System Preference].

• For information about installing applications required for EtherTalk, see the Mac OS manuals.
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Configuring the Printer
Use the control panel to enable AppleTalk. (The default is active.)
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Using PostScript 3

Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

Normal Print

Select this for normal printing. The print job starts immediately after the print command is given.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the printer. The saved job can be printed from the printer's control panel.
You can also delete the saved job.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.

Locked Print

Use this function to save documents in the printer memory with a password, and then edit and print
them as you want.

• The "User ID:" can contain to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
must be 4-8 digits.

• Entering the "User ID:" helps you distinguish your print job from others.

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's
control panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.
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Stored Print

Use this function to store a file in the printer, and then print it from the computer or the printer's control
panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Store and Print

Use this function to prints the file at once and also stores the file in the printer.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Using Sample Print

• You need Mac OS X v10.2 or higher to use this function.

• To use this function, the optional hard disk must be installed on the printer.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 1,000 pages for Sample Print, Locked Print, Hold Print and
Stored Print.

• Sample Print files will not appear on the display panel if they have already been executed or deleted
using Web Image Monitor before you select [Sample Print] from the control panel.

• Sample Print files printed or deleted using Web Image Monitor after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, sample print jobs are automatically collated by the printer driver. If the collate option is
selected in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.
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• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 1,000 pages.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Set the number of copies to two or more.

The sample print job is sent to the printer, and one set is printed.

3. In the pop-up menu, click [Job Log].

4. On the [Job Type:] pop-up menu, select [Sample Print].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his/her jobs.

6. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete a saved job, see "Deleting a Sample Print File".

7. Press the [Menu] key.

The [Menu] screen appears.

8. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

9. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

10. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

Enter the new number of sets using the [ ] or [ ] keys. You can enter up to 999 sets.

To cancel printing, press the [Escape] key.

11. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

12. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file will be deleted.

Deleting a selected Sample Print file only

1. Press the [Menu] key.

The [Menu] screen appears.
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2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Sample Print file, press the [Escape] key.

5. Press Check the file you want to delete is displayed, and then press the [  Enter] key.

The selected file is deleted.

6. Press the [Online] key.

The initial screen appears.

Deleting all Sample Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Sample Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID and the time when the job was stored appear.

4. Press the [ ] or [ ] key to confirm deleting all files, and then press the [  Enter] key.

To cancel deleting a Sample Print file, press the [Escape] key.

5. Press the [  Enter] key.

6. Press the [Online] key.

The initial screen appears.

Using Locked Print

• You need Mac OS X v10.2 or higher to use this function.

• To use this function, the optional hard disk must be installed on the printer.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 1,000 pages for Sample Print, Locked Print and Hold Print.

• Locked Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Locked Print] using the control panel.

• Locked Print files printed or deleted using Web Image Monitor after you have selected [Locked Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Locked Print files.
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• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, locked print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 1,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Locked Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see "Delete a Locked Print File".

6. Press the [Menu] key.

The [Menu] screen appears.

7. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

8. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

9. Select the file you want to print using the [ ] or [ ] key, and then press the [  Enter] key.

The password screen appears.

10. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

Check that the file you want to print is displayed

11. Enter the number of sets you want to print, press the [ ] or [ ] key.

To cancel printing, press the [Escape] key.

12. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.
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13. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

Deleting a selected Locked Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

The password screen appears.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.

6. Press Check the file you want to delete is displayed, and then press the [  Enter] key.

The selected file is deleted.

7. Press the [Online] key.

The initial screen appears.

Deleting all Locked Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Locked Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID and the time when the job was stored appear.

4. Press the [ ] or [ ] key to confirm deleting all files, and then press the [  Enter] key.

The password screen appears.

To cancel deleting a Locked Print file, press the [Escape] key.

5. Enter the password using the [ ] or [ ] key, and then press the [  Enter] key.

If you forget your password, ask your administrator for help.
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The printer deletes files that correspond to the entered password. The number of files to be deleted is
displayed on the confirmation screen.

6. Press Check the file you want to delete is displayed, and then press the [  Enter] key.

The selected file is deleted.

7. Press the [Online] key.

The initial screen appears.

Using Hold Print

• You need Mac OS X v10.2 or higher to use this function.

• To use this function, the optional hard disk must be installed on the printer.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 1,000 pages for Sample Print, Locked Print and Hold Print.

• Hold Print files will not appear on the display panel if they have already been printed or deleted using
Web Image Monitor before you select [Hold Print] using the control panel.

• Hold Print files printed or deleted using Web Image Monitor after you have selected [Hold Print] using
the control panel will still appear on the display panel. However, an error message will appear if you
try to print or delete those Hold Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Hold print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 1,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Hold Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. File Name can also be set.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.
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To print the document, perform the following steps.

To delete the document, see "Deleting a Hold Print File".

6. Press the [Menu] key.

The [Menu] screen appears.

7. Press the [ ] or [ ] to display key [Hold Print], and then press the [  Enter] key.

8. Press the [ ] or [ ] to display key [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

9. Select the file you want to print using the [ ] or [ ] key, and then press the [  Enter] key.

To cancel printing, press the [Escape] key.

10. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

11. Press the [Online] key.

The initial screen appears.

• When printing is completed, the stored file is deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file is deleted.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a Hold
Print file from Web Image Monitor. For details, see Web Image Monitor Help.

Deleting a selected Hold Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Hold Print file, press the [Escape] key.

5. Check that the file you want to delete is displayed, and then press the [  Enter] key.

6. Press the [Online] key.

The initial screen appears.
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Deleting all Hold Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Hold Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID and the time when the job was stored appear.

4. Press the [ ] or [ ] key to confirm deleting all files, and then press the [  Enter] key.

To cancel deleting a Hold Print file, press the [Escape] key.

5. Press the [  Enter] key.

6. Press the [Online] key.

The initial screen appears.

Using Stored Print

• You need Mac OS X v10.2 or higher to use this function.

• To use this function, the optional hard disk must be installed on the printer.

• Stored Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Stored Print] using the control panel.

• Stored Print files printed or deleted using Web Image Monitor after you have selected [Stored Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Stored Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Stored print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 1,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].

• [Stored Print]
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Stores the file in the printer and print it later using the control panel.

• [Store and Print]

Prints the file at once and also stores the file in the printer.

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box. File Name can also
be set.

The user ID associates the user with his/her jobs.

You can assign a password to a saved document, but password assignment is not mandatory.

The password must be entered when printing or deleting.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see "Deleting Stored Print File".

6. Press the [Menu] key.

The [Menu] screen appears.

7. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

8. Press the [ ] or [ ] key to display [Print One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

To cancel printing, press the [Escape] key.

9. Press the [ ] or [ ] key to display the file you want to print, and then press the [  Enter]
key.

If you set a password in the printer driver, a password confirmation screen appears. Enter the
password.

10. Press the [  Enter] key.

The "To print, press [ESC] 1-4 times" message appears. Then the file selection screen reappears.

11. Press the [Online] key.

The initial screen appears.

• To stop printing after printing has started, press the [Job Reset] key. A Stored Print file is not deleted
even if the [Job Reset] key is pressed.

• The Stored Print file that sent to the printer is not deleted unless you delete a file or select [Auto Del.
Stored].

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a
Stored Print file from Web Image Monitor. For details, see Web Image Monitor Help.

• For details about the [Auto Del. Stored], see "System Menu".
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• p.141 "System Menu"

Deleting a selected Stored Print file only

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Delete One File], and then press the [  Enter] key.

The file name and the time when the job was stored appear.

4. Press the [ ] or [ ] key to display the file you want to delete, and then press the [  Enter]
key.

To cancel deleting a Stored Print file, press the [Escape] key.

If you set the password in the printer driver, enter the password to delete.

If you forget your password, ask your administrator for help.

5. Press the [  Enter] key.

6. Press the [Online] key.

The initial screen appears.

Deleting all Stored Print files

1. Press the [Menu] key.

The [Menu] screen appears.

2. Press the [ ] or [ ] key to display [Stored Print], and then press the [  Enter] key.

3. Press the [ ] or [ ] key to display [Del. All Files], and then press the [  Enter] key.

The user ID and the time when the job was stored appear.

4. Press the [ ] or [ ] key to confirm deleting all files, and then press the [  Enter] key.

To cancel deleting a Stored Print file, press the [Escape] key.

If you set the password in the printer driver, enter the password to delete.

If you forget your password, ask your administrator for help.

5. Press the [  Enter] key.

6. Press the [Online] key.

The initial screen appears.
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User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to check
the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Mac OS Select the [Enable User Code] check box, and then enter a user code
in the [User Code] box on [Job Log] in the print dialog box.

Mac OS X Select the [Enable User Code] check box, and then enter a user code
in the [User Code] box on [Job Log] in the print dialog box.

Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

Mac OS [Fit to Paper] on [Printer Specific Options] in the print dialog box.

Prompt User

Print is performed with the size of document to be printed unchanged.

Nearest Size and Scale

If the paper size is smaller than the selected paper size, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

Nearest Size and Crop

When the paper size is smaller than the size of document to be printed, print is adjusted to meet the
paper size.
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Paper Source (Paper Feed)

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Resolution

Use this to set the resolution types.

The following table shows the tabs or menus where you can select this function.

Mac OS [Resolution] on [Printer Specific Options] in the print dialog box.

Mac OS X [Resolution] on the [Features x] tab on [Printer Features] in the print
dialog box.

Orientation Override

Use this to set the paper orientation.

The following table shows the tabs or menus where you can select this function.

Mac OS [Orientation Override] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Orientation Override] on the [Feature Sets: X] tab on [Printer Features]
in the print dialog box.

You can select the following items:

• Off

• Landscape

• Portrait

Duplex Printing

Use this function to select duplex printing.
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• To use this function, the optional duplex unit must be installed on the printer.

The following table shows the tabs or menus where you can select this function.

Mac OS [Print on Both Sides] on [Layout:] in the print dialog box.

Mac OS X • 10.3 or higher

The [Two Sided Printing] check box on [Layout:] in the print dialog
box.

• Other Mac OS X

The [Print on both Sides] check box on [Duplex:] in the print dialog
box.

None

Disables duplex printing.

Flip on Long Edge

Prints so you can open it to the long edge when bound along the long edge.

Flip on Short Edge

Prints so you can open it to the short edge when bound along the short edge.

Toner Saving

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Print Mode] on [Printer Specific Options] in the print dialog box.

Mac OS X [Print Mode] on the [Feature Set: x] tab on [Printer Features] in the print
dialog box.

• For details about this function, see printer driver Help.

Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of multiple-
page documents.
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• To use this function, a memory unit of at least 192 MB or hard disk drive must be installed on the
printer.

• If you are using Mac OS or Mac OS X, make sure that the following check boxes have not been
selected.

• Mac OS

The [Collate:] check box in the print dialog box.

• Mac OS X

The [Collate:] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Collate:] on the [Feature Sets: x] tab on [Printer Feature] in the printer
dialog box.

Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Paper Type] on the [Feature Set: x] tab on [Printer Features] in the print
dialog box.

Image Smoothing

Use this to select the image smoothing type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Image Smoothing:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Image Smoothing:] on the [Feature Set: x] tab on [Printer Features] in
the print dialog box.

Off

Disables image smoothing.
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On

Performs image smoothing unconditionally.

Auto

Performs image smoothing automatically for images that have a resolution less than 25% of supported
printer resolution.

Less than 90 ppi - Less than 300 ppi

Performs image smoothing only when the image has an image resolution (pixels per inch) less than
the respective value you have selected in the list.

• When Auto is selected, data processing may take a long time.

• When [Image Smoothing:] is used for a mask image, this function may have an undesired effect on
the print result.

Dithering

Use this function to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Mac OS Dithering: on Printer Specific Options in the print dialog box.

Mac OS X Dithering: on the Feature Set: x tab on Printer Features in the print dialog
box.

You can select the following items:

Auto

Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

Photographic

Performs dithering using an appropriate pattern for photographs.

Text

Performs dithering using an appropriate pattern for text.

User Setting

Use this setting to print images set in half tone in your application.
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Printer Utility for Mac
By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

• If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x
and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the printer.

1. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

2. Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

3. Double-click the [Mac OS 8 and 9] icon to open it.

Under Mac OS X, double-click the [Mac OS X] folder.

4. Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for
Mac] file, and then drop it into the Macintosh hard disk.

5. Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic environment is supported.)

• Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

Mac OS

• Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple
menu.

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

Printer Utility for Mac will take a few seconds to start.

Mac OS X

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

3. In the [Available Printers:] box, select the printer you want to use.

If you change zones, select a name from [Available Network Zones:].

Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

4. Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

5. Click [Choose].

Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

• The following procedure to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

• During the download, do not turn off the power switch, operate the panel or open or close the cover.

• If the printer restarts, all the printer settings return to the defaults.
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• Confirm that a Macintosh and the printer are connected with Appletalk.

1. Select [Download PS Fonts...] on the [File] menu.

2. Click [Add to list].

The dialog box to select fonts appears.

3. Select the desired font files, and then click [Open].

The list of selectable font names appears.

4. After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

5. Click [Download].

The fonts begin to download, and the download status is shown.

6. When the completion message appears, click [OK].

7. Click [Cancel].

• Some fonts cannot be downloaded.

• Before downloading, read the documentation about the fonts you want to use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer memory and
hard disk drive can be displayed.

1. Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

2. Select [Printer's memory] or [Printer's disk].

3. Click [OK].

• The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

• You cannot delete the fonts displayed in italic.

1. Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.
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2. Select [Printer's memory] or [Printer's disk].

3. Select the fonts you want to delete.

4. Click [Delete].

A confirmation message appears.

5. Confirm the fonts you want to delete and the printer name from which you want to delete
the fonts.

6. Click [Continue], and then click [OK].

7. Click [OK].

Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard disk drive are deleted.
Before initializing, be sure to check the fonts on the hard disk drive.

• When initializing the printer hard disk drive from the control panel, all of the data on the printer hard
disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

• Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might be
damaged.

1. Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears. To cancel initialization, click [Cancel].

2. Click [Execute].

Initializing starts.

3. When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print "Print Fonts Catalogue" and "Prints Fonts Sample".

1. Select [Page Setup...] on the [File] menu.

2. Select the paper size.

3. Click [OK].

Printing Font Catalog

You can print the names of fonts available on the printer.

1. Select [Print Fonts Catalog...] on the [File] menu.
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2. Click [Print].

• The paper selected under [Page Setup] is used.

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

1. Select [Print Fonts Sample...] on the [File] menu.

2. Click [Print].

• Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect several printers on the network,
assign different names so you can identify them. If several printers have the same name, a digit appears
next to the printer name in [Chooser].

• You can enter up to 31 digits and letters.

• Do not use symbols, for example "*", ":", "=", "@", "~".

Mac OS

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. Select the printer whose name you changed, and then close the [Chooser] dialog box.

If there are several AppleTalk zones, select the zone the printer belongs to.

Mac OS X

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.
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3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone for the Macintosh in use.

7. In the [Available Printers:] list, select the printer whose name you changed, and then click
[Choose].

Restarting the Printer

You can restart the printer.

1. Select [Restart Printer] on the [File] menu.

2. Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

The fonts downloaded in the printer memory will be deleted.

If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

1. Select [Download PostScript File...] on the [Utility] menu.

2. Select the file name to download, click the file name, and then click [Open].

3. Type the log file name, and then click [Save].

The selected file is downloaded.

Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

• Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.
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2. Select the zone in which you want to locate the printer, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. In the [AppleTalk zone:] list, select the zone you changed.

8. In the [Select a PostScript Printer:] list, select the printer you want to use.

9. Close the [Chooser] dialog box.

Mac OS X

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

2. Select the zone which you want to locate the printer in, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone you changed.

7. In the [Available Printers:] list, select the model of printer in use, and then click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

1. Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

2. Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status and
available space on the hard disk drive. You can also confirm the zone to which the printer belongs.

3. Click [OK].
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Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

• "Launch Dialogue Console" is recommended for users with an understanding of PostScript.

• Do not download any file other than PostScript files to the printer.

• "Launch Dialogue Console" must be used at your own responsibility.

1. Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

2. Type the PostScript command in the editor screen.

To edit a PostScript file, select [Open] on the [File] menu to open it.

You can search or replace a character string by using the [Search] menu.

3. After editing the PostScript file, select [Download Top Window] on [Console] menu to start
printing.

The PostScript file is sent to the printer.

The [Reply from Printer] box opens, depending on the PostScript file you sent.

4. Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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10. Appendix

Software and Utilities Included on the CD-ROM
The following softwares and utilities are included in the CD-ROMs that come with the printer.

Font Manager 2000

For installing new screen fonts, or organizing and managing fonts already in the system. For details
about Font Manager 2000, see the manual on the CD-ROM labeled "Printer Drivers and Utilities".

SmartDeviceMonitor for Admin

For the system administrator to manage network printers.

• SmartDeviceMonitor for Admin Help

DeskTopBinder - SmartDeviceMonitor for Client

For users to manage their network print status.

• DeskTopBinder - SmartDeviceMonitor for Client Help

Viewing the contents of the CD-ROM

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system. The following drivers are
included on the CD-ROM provided with this printer.

PCL 5e/6 printer driver

This printer driver allows the computer to communicate with the printer via a printer language.

The following operating system is supported.

• Windows 2000/XP/Vista, and Windows Server 2003/2003 R2

RPCS printer driver

This printer driver allows the computer to communicate with the printer using a printer language. In
addition to the conventional user interface, another preset user interface is provided.
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The following operating system is supported.

• Windows 2000/XP/Vista, and Windows Server 2003/2003 R2

PostScript Printer Drivers and PPD files

PostScript printer drivers and the PPD files are included on the CD-ROM provided with this printer.
PostScript printer drivers allow the computer to communicate with the printer using a printer language.
PPD files allow the printer driver to enable specific printer functions.

The following operating system is supported.

• Windows 2000/XP/Vista, Windows Server 2003/2003 R2, Mac OS, and Mac OS X.

• The PostScript printer drivers and PPD files are included on the CD-ROM labeled "Printer Drivers
and Utilities".

• For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environment is supported.)

PPD files

PPD files are included on the CD-ROM provided with this printer. PPD files allow the printer driver to
enable specific printer functions.

SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX to monitor network printers.
It can monitor multiple network printers using IP address. We recommend that administrators use this
application.

File path

SmartDeviceMonitor for Admin is stored in the following folder on the CD-ROM.

NETWORK\DEVMON\ADMIN\DISK1

Operating system Protocol stack

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Window NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP
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Operating system Protocol stack

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows

Windows Server 2003/2003
R2

TCP/IP provided with Windows Server 2003/2003 R2

IPX/SPX provided with Windows Server 2003/2003 R2

NetWare Client provided with Windows Server 2003/2003
R2

Novell Client provided with Windows Server 2003/2003 R2

Available functions

SmartDeviceMonitor for Admin has the following functions to check:

• printer supplies such as paper or toner;

• results of print jobs executed from the computer.

• For information about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for Admin Help.

DeskTopBinder - SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that users install this application.

• Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows 2000/XP/Vista, Windows
Server 2003/2003 R2.

• Constantly monitoring the status of devices on the network using TCP/IP and IPX/SPX.

File path

SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.

NETWORK\DEVMON\CLIENT\DISK1

Operating system Protocol stack

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

Software and Utilities Included on the CD-ROM
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Operating system Protocol stack

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows

Windows Server 2003/2003
R2

TCP/IP provided with Windows Server 2003/2003 R2

IPX/SPX provided with Windows Server 2003/2003 R2

NetWare Client provided with Windows Server 2003/2003
R2

Novell Client provided with Windows Server 2003/2003 R2

Available functions

SmartDeviceMonitor for Client has the following functions.

• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a print server.

• Prints on a substitute printer when there are too many jobs waiting on the specified printer,
or when an error disables printing (Recovery Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).

• Executes prior group registration of printers specified for Recovery Printing or Parallel
Printing.

• Notification function

• Displays an error message when there is an error on the specified printer while transferring
or printing data.

• Notifies a print completion. You can also be notified of the print condition, such as displaying
the notice only when Recovery Printing is executed.

• Monitoring function

• Checks printer supplies such as paper or toner.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of printers.

• Enables you to check the print job log using the user ID

• Notifies the user when a print job is completed by displaying the [Printout/Data-transmission]
dialog box. You can also be notified of specific print conditions, such as when Recovery printing
is performed.

• Display the log of printed files, and the current status of the files being printed.
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• To perform Recovery or Parallel printing, the same options that are installed on the original printer
must be installed on the other printers also. Printers that lack a required option cannot be used for
Recovery or Parallel printing.

• To perform Recovery or Parallel printing, the same paper loaded in the original printer must be loaded
in the other printers also. Load all printers with the same paper as that loaded in the tray selected for
printing.

• Results of Recovery or Parallel Printing might differ, depending on the model of the other printer and
the options installed on it.

• If you select Sample Print or Locked Print, you cannot select Recovery Printing or Parallel Printing.

• For details about using SmartDeviceMonitor for Client, see SmartDeviceMonitor for Client Help.
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Protection Using Encryption
When you access the printer using a Web Image Monitor or IPP, you can establish encrypted
communication using SSL.

When you access the printer using an application such as SmartDeviceMonitor for Admin, you can establish
encrypted communication using SNMPv3 or SSL. To protect data from interception, analysis, and
tampering, you can install a server certificate in the printer, negotiate a secure connection, and encrypt
transmitted data.

• You must install one of the following memory options to perform encryption:

• the hard disk

• the data storage card

SSL (SSL (Secure Sockets Layer)Secure Sockets Layer)

AQC899S

1. To access the printer from a user's computer, request for the SSL server certificate and public key.

2. The server certificate and public key are sent from the printer to the user's computer.
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3. Create shared key from the user's computer, and then encrypt it using public key.

4. The encrypted shared key is sent to the printer.

5. The encrypted shared key is decrypted in the machine using private key.

6. Transmit the encrypted data using the shared key, and then decrypt the data at the machine to
attain secure transmission.

SSL (Secure Sockets Layer) Encryption

This can be specified by the administrator.

To protect the communication path and establish encrypted communication, create and install the server
certificate. There are two ways of installing a server certificate: create and install a self-certificate using the
printer, or request a certificate from a certificate authority and install it.

Configuration flow (self-signed certificate)

1. Creating and installing the server certificate

Install the server certificate using Web Image Monitor.

2. Enabling SSL

Enable the SSL/TLS setting using Web Image Monitor.

Configuration flow (certificate issued by a certificate authority)

1. Creating the server certificate

Create the server certificate using Web Image Monitor.

The application procedure after creating the certificate depends on the certificate authority.
Follow the procedure specified by the certificate authority.

2. Installing the server certificate

Install the server certificate using Web Image Monitor.

3. Enabling SSL

Enable the SSL/TLS setting using Web Image Monitor.

Creating and Installing the Server Certificate (Self-Signed Certificate)

Create and install the server certificate using Web Image Monitor.

• To confirm whether SSL configuration is enabled, enter https://(printer's-address) in your Web Image
Monitor's address bar to access this printer. If the "The page cannot be displayed" message appears,
check the configuration as the SSL configuration is invalid.

Protection Using Encryption
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Creating and Installing the Self-Signed Certificate

Create and install the server certificate using Web Image Monitor. This section explains the use of a self-
certificate as the server certificate.

1. Log on to Web Image Monitor in the administrator mode.

2. In the left area, click [Configuration], and then click [Device Certificate] in "Security".

The [Device Certificate] page appears.

3. Click [Create].

4. Make the necessary settings.

5. Click [OK].

The setting is changed.

6. Click [OK].

A security warning dialog box appears.

7. Check the details, and then click [OK].

[Installed] appears under [Certificate Status] to show that a server certificate for the printer has been
installed.

8. Quit Web Image Monitor.

• Click [Delete] to delete the server certificate from the printer.

• For details about the displayed items and selectable items, see Web Image Monitor Help.

Creating the Server Certificate (Certificate Issued by a Certificate Authority)

Create the server certificate using Web Image Monitor. This section explains the use of a certificate issued
by a certificate authority as the server certificate.

1. Log on to Web Image Monitor in the administrator mode.

2. In the left area, click [Configuration], and then click [Device Certificate] in "Security".

The [Device Certificate] page appears.

3. Click [Request].

4. Make the necessary settings.

5. Click [OK].

[Requesting] appears for [Certificate Status] in the [Device Certificate] area.

6. Quit Web Image Monitor.
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7. Apply to the certificate authority for the server certificate.

The application procedure depends on the certificate authority. For details, contact the certificate
authority.

• If you apply for two certificates simultaneously, the certificate authority may not appear in the
certificates. When you install these certificates, be sure to take notes of the certificate contents and
the order in which the certificates were installed.

• Using Web Image Monitor, you can create the contents of the server certificate but you cannot send
the application.

• Click [Cancel Request] to cancel the request for the server certificate.

• For details about the displayed items and selectable items, see Web Image Monitor Help.

Installing the Server Certificate (Certificate Issued by a Certificate Authority)

Install the server certificate using Web Image Monitor.

This section explains the use of a certificate issued by a certificate authority as the server certificate. Enter
the server certificate contents issued by the certificate authority.

1. Log on to Web Image Monitor in the administrator mode.

2. In the left area, click [Configuration], and then click [Device Certificate] in "Security".

The [Device Certificate] page appears.

3. Click [Install].

4. Enter the contents of the server certificate.

In the Device Certificate Request box, enter the contents of the server certificate received from the
certificate authority.

5. Click [OK].

[Installed] appears under [Certificate Status] to show that a server certificate for the printer has been
installed.

6. Quit Web Image Monitor.

• For details about the displayed items and selectable items, see Web Image Monitor Help.

Enabling SSL

After installing the server certificate in the printer, enable the SSL setting.

This procedure is used for a self-signed certificate or a certificate issued by a certificate authority.
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1. Log on to Web Image Monitor in the administrator mode.

2. In the left area, click [Configuration], and then click [SSL/TLS] in "Security".

The [SSL/TLS] page appears.

3. Click [Active] for [SSL/TLS].

4. Click [OK].

The SSL setting is enabled.

5. Quit Web Image Monitor.

• If you set [Permit SSL/TLS Communication] to [Ciphertext Priority], enter "https://(printer's address)/"
to access the printer.

User Settings for SSL (Secure Sockets Layer)

If you have installed a server certificate and enabled SSL (Secure Sockets Layer), you need to install the
certificate on the user's computer.

The administrator must explain the procedure for installing the certificate to users. If a warning dialog box
appears while accessing the printer using the Web Image Monitor or IPP, start the Certificate Import Wizard
and install a certificate.

1. When the [Security Alert] dialog box appears, click [View Certificate].

The [Certificate] dialog box appears.

To be able to respond to inquiries from users about such problems as expiry of the certificate, check
the contents of the certificate.

2. On the [General] tab, click [Install Certificate...].

Certificate Import Wizard starts.

3. Install the certificate by following the Certificate Import Wizard instructions.

• For details about how to install the certificate, see the Web Image Monitor Help.

• If a certificate issued by a certificate authority is installed in the printer, confirm the certificate store
location with the certificate authority.

• For details about where to store the certificate when accessing the printer using IPP, see the
SmartDeviceMonitor for Client Help.
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Setting the SSL / TLS Encryption Mode

By specifying the SSL/TLS encrypted communication mode, you can change the security level.

Encrypted Communication Mode

Using the encrypted communication mode, you can specify encrypted communication.

Ciphertext Only Allows encrypted communication only.

If encryption is not possible, the printer does not
communicate.

Ciphertext Priority Performs encrypted communication if encryption
is possible.

If encryption is not possible, the printer
communicates without it.

Ciphertext/Clear Text Communicates with or without encryption,
according to the setting.

Setting the SSL / TLS Encryption Mode

This can be specified by the administrator.

After installing the server certificate, specify the SSL/TLS encrypted communication mode. By making this
setting, you can change the security level. Specify the SSL/TLS encrypted communication mode using Web
Image Monitor.

1. Log on to Web Image Monitor in the administrator mode.

2. Click [Configuration].

3. Click [SSL/TLS] in "Security".

4. Select the encryption communication mode in the [Permit SSL/TLS Communication] list, and
then click [OK].

Select [Ciphertext Only], [Ciphertext Priority], or [Ciphertext/Clear Text] as the encrypted
communication mode.

5. Quit Web Image Monitor.

SNMPv3 Encryption

This can be specified by the administrator.
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When using SmartDeviceMonitor for Admin or another application to make various settings, you can
encrypt the data transmitted. By making this setting, you can protect data from being tampered with. Specify
the SNMPv3 encrypted communication mode using Web Image Monitor.

1. Log on to Web Image Monitor in the administrator mode.

2. Click [Configuration].

3. Click [Network Security] in "Security".

4. Click [Encryption Only] in the [Permit SNMPv3 Communication] area in the [SNMPv3] area,
and then click [OK].

5. Quit Web Image Monitor.

• To use SmartDeviceMonitor for Admin for encrypting the data for specifying settings, you need to
specify the administrator's [Encryption Password] setting and [Encryption Key] in [SNMP
Authentication Information] in SmartDeviceMonitor for Admin, in addition to specifying [Permit
SNMPv3 Communication] on the printer.

• If administrator's [Encryption Password] setting is not specified, the data for transmission may not be
encrypted or sent.

• For details about specifying [Encryption Key] in SmartDeviceMonitor for Admin, see the
SmartDeviceMonitor for Admin Help.
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Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, packets are sent back and
forth, causing communication charges to be incurred. Because packet transmission is a specification of
NetWare, you need to change the configuration of the router. If the network you are using does not allow
you to configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

• The MAC address of the printer doing the filtering is printed on the printer configuration page. For
details about printing a configuration page, see p.135 "List/Test Print Menu".

• For details about configuring the printer if the router cannot be configured, see the instructions below.

Configuring the printer with NetWare

1. Following the setup method described earlier in this manual, configure the file server.

2. Set the frame type for NetWare environment.

• For details about selecting a frame type, see p.149 "Host Interface Menu".

Configuring the printer without NetWare

When not printing, the network interface board sends packets over the network. Set NetWare to "inactive".

• For details about selecting protocols, see p.149 "Host Interface Menu".

Using DHCP

You can use the printer in a DHCP environment. You can also register the printer NetBIOS name on a
WINS server when it is running. Note the following points when an Ethernet interface is simultaneously
installed.
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When static IPv4 addresses are set for each interface

• IPv4 address: When set at the same value, the Ethernet interface is preferred.

• Subnet mask: When a value overlaps, the Ethernet interface is preferred.

• Gateway address: The value set is used. For the gateway address, set the gateway address
located in the subnetwork set by the interface. If the value is outside the subnet range set by the
interface, it operates as "0.0.0.0".

When obtaining addresses from the DHCP server

• IP Address, Subnet Mask: you can configure addresses assigned by a DHCP server. If IPv4
addresses overlap or the same subnet IP addresses are selected, the effective value is assigned
only to the prioritized interface. Ethernet has default interface priority.

• AutoNet: A temporary IPv4 address starting with 169.254 and not used on the network, is
assigned to the prioritized interface.

• Gateway Address, DNS Server Address, and Domain Name: You can configure the addresses
assigned by DHCP to the prioritized interface.

If the gateway address is beyond the range of the subnet selected for the interface, the printer
operates using "0.0.0.0".

Ethernet has default interface priority.

When there are static IPv4 addresses and addresses assigned by DHCP

• IPv4 Address and subnet mask: if a static IPv4 address is the same as an address assigned by
DHCP, or the static subnet mask address and the subnet mask address assigned by DHCP
overlap, the printer uses the static IPv4 address interface. The interface with the DHCP setting is
set by default.

• Gateway Address: operates using the address entered manually.

If a static address is not selected, or is set to 0.0.0.0, the interface using the address assigned
by DHCP is used.

• NetBIOS name on a WINS server must be configured for the WINS server.

• Supported DHCP servers are Microsoft DHCP Server included with Windows 2000 Server, Windows
Server 2003, and the DHCP server included with NetWare and UNIX.

• If you do not use the WINS server, reserve the printer's IP address in the DHCP server so the same
IPv4 address is assigned every time.

• To use the WINS server, change the WINS server setting to "active" using the control panel.

• Using the WINS server, you can configure the host name via the remote network printer port.

• DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via ISDN, it will result
in increased line charges. This is because your computer connects to the ISDN line whenever a packet
is transferred from the printer.
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• If there is more than one DHCP server, use the same setting for all servers. The printer operates using
data from the DHCP server that responds first.

Using AutoNet

If the printer IPv4 address is not assigned by a DHCP server automatically, a temporary IPv4 address
starting with 169.254, which is not used on the network, can be automatically selected by the printer.

You must change this setting to "on" to use AutoNet.

• The IP address assigned by the DHCP server is given priority over that selected by AutoNet.

• You can confirm the current IPv4 address on the configuration page. For more information about the
configuration page, see "List/Test Print Menu".

• When AutoNet is running, the NetBIOS name is not registered on the WINS server.

• The printer cannot communicate with devices that do not have the AutoNet function. However, this
printer can communicate with Macintosh computers running Mac OS X 10.2.3. or higher.

• p.135 "List/Test Print Menu"

• p.188 "Remote Maintenance by telnet"

Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server when the power is turned
on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin even
in a DHCP environment. This section explains configuring the WINS server.

• The WINS server is supported with Windows 2000 Servers WINS Manager.

• For details about the WINS server settings, see Windows Help.

• If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.

• The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.

2. Enter "http://(printer's address)/" in the address bar to access the printer whose settings
you want to change.

Top Page of Web Image Monitor appears.
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3. Click [Login].

The dialog box for entering the user name and password appears.

4. Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the left area, click [Configuration], and then click [IPv4] in "Network".

6. Check that [Active] is selected for [WINS] in the [Ethernet+IEEE 802.11b] column, and then
enter the WINS server IPv4 address in [Primary WINS Server] and [Secondary WINS
Server].

7. Click [OK].

8. Quit Web Image Monitor.

Using telnet

See p.188 "Remote Maintenance by telnet".

Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record and PTR
record) managed by the DNS server. When a DNS server is part of the network environment to which this
printer, a DNS client, is connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static or acquired by DHCP.
When the dynamic DNS function is not used, records managed by the DNS server must be updated
manually, if the printer's IP address is changed.

To update the record using the printer, the DNS server has to have one of the following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits updating.

For a static IP setting

If the IP address or host name is changed, the A and PTR records are updated.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and wireless LAN

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

For DHCP settings

As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:
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• When the printer acquires the IP address from the DHCP server, the DHCP server updates the A
and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer updates the A record,
and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and wireless LAN

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

• Dynamic update using message authentication (TSIG, SIG (0)) is not supported.

DNS servers targeted for operation

For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2 features

• BIND 8.2.3 or higher

For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2 features

• BIND 8.2.3 or higher

For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003/2003
R2 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

For IPv6 setting

• Microsoft DNS servers with standard Windows Server 2003/2003 R2 features

• BIND 9.2.3 or higher

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as
follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions)/
Windows Server 2003/2003 R2 features

• ISC DHCP 3.0 or higher
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• DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the "dns" command. For details, see p.188 "Remote Maintenance by
telnet".
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Installing Font Manager 2000

• Under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, installing applications by Auto
Run requires administrator permission. To install a printer driver by Auto Run, log on using an account
that has administrator permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Click [Font Manager 2000].

4. Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, or
7.0
Under Windows 2000/XP/Vista, or Windows Server 2003/2003 R2 with Adobe PageMaker, you need
to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder "DRIVERS\PS\XP_VISTA\(Language)\DISK1\" on the CD-
ROM.

The "XP_VISTA" folder inside the "PS" folder is for Windows 2000/XP/Vista, Windows Server
2003/2003 R2. Use the folder that is appropriate for the operating system you are currently using.

The third folder "(Language)" may be substituted by an appropriate language name.

Copy the .ppd file to the PageMaker folder.

• For PageMaker 6.0 default installation

The directory is "C:\PM6\RSRC\PPD4".

• For PageMaker 6.5 default installation

The directory is "C:\PM65\RSRC\USENGLISH\PPD4".

The "USENGLISH" may vary depending on your language selection.

• For PageMaker 7.0 default installation

The directory is "C:\PM7\RSRC\USENGLISH\PPD4".

The "USENGLISH" may vary depending on your language selection.

• If the driver is not set correctly after copying the ".ppd" file, printing may not be performed properly.

• When using PageMaker, the optional features that can be selected by the printer driver will not be
active. The following procedure describes how to activate the optional printer features.

1. On the [File] menu, click [Print].

The [Print Document] dialog box appears.

2. Make the necessary settings in the [Features] box.
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When Using Windows Terminal Service/
MetaFrame
The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

Windows NT Server 4.0 Terminal Server Edition with SP6 or higher

• MetaFrame XP 1.0 SP1/SP2/FR1

Windows 2000 Server/Advanced Server

• MetaFrame XP 1.0 SP1/SP2/SP3/SP4/FR1/FR2/FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Windows Server 2003/2003 R2

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

When Windows Terminal Service is operating

• PCL printer drivers

• PostScript 3

• RPCS drivers

• Some RPCS printer driver functions do not work if Windows Terminal Service is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.
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Windows Terminal Service

In an environment where Windows Terminal Service is installed, some printer driver functions are
unavailable, even if no Windows Terminal Service functions are used. Use the install mode to install
SmartDeviceMonitor for Client in an environment where Terminal Service is running on a Windows
NT Server 4.0 Terminal Server Edition or Windows 2000 Server family computer. The following are
the two methods of installation using the install mode:

1. Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor for Client.

2. Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL

To quit the install mode, enter the following command in the MS-DOS command prompt:

CHANGE USER /EXECUTE

• For more information, see Windows Help.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers], you can select a logical printer created by copying the client's
local printer data to the MetaFrame server. We strongly recommend testing this function in your
network environment before using it for your work.

• The settings for optional equipment will not be stored in the server after the equipment is
disconnected. The settings for optional equipment will be restored to its defaults each time the
client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a WAN environment over
dial-up lines such as ISDN, printing may not be possible or errors may occur, depending on
data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making settings in [Client
Printer bandwidth] under [Citrix Management Console] according to the environment.

• If a print error occurs on the server and the print job or a printer created in [Auto-creating client
printers] cannot be deleted, we recommend the following:

• MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details, see the Readme
file provided with MetaFrame.

• MetaFrame XP 1.0 FR2

Make settings in [Delete pending print jobs at logout] under [Printer Properties
Management] of Citrix Management Console.

MetaFrame's [Printer driver replication]

Using [Printer driver replication], you can distribute printer drivers across all servers in a server farm.
We strongly recommend testing this function in your network environment before using it for your
work.
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• If the printer drivers are not properly copied, install them directly onto each server.
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Copyright Information about Installed
Applications

expat

• The software including controller, etc. (hereinafter "software") installed on this product uses the expat
under the conditions mentioned below.

• The product manufacturer provides warranty and support to the software of the product including the
expat, and the product manufacturer makes the initial developer and copyright holder of the expat,
free from these obligations.

• Information relating to the expat is available at:

http://expat.sourceforge.net/

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Centre, Ltd. and Clark Cooper.

Copyright (c) 2001, 2002 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

NetBSD

1. Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright
notice applicable for each of the files/binaries, the source code tree must be consulted.
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A full source code can be found at http://www.netbsd.org/.

Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

2. Authors Name List

All product names mentioned herein are trademarks or registered trade-marks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in
this document:

• This product includes software developed by the University of California,Berkeley and its contributors.

• This product includes software developed by the NetBSD Foundation.

• This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

• This product includes software developed for the NetBSD Project. See http://www.netbsd.org/ for
information about NetBSD.

• This product contains software developed by Ignatios Souvatzis for the NetBSD project.

• This product contains software written by Ignatios Souvatzis and MichaelL. Hitch for the NetBSD
project.

• This product contains software written by Michael L. Hitch for the NetBSD project.

• This product includes cryptographic software written by Eric Young(eay@cryptsoft.com)
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• This product includes cryptographic software written by Eric Young(eay@mincom.oz.au)

• This product includes software designed by William Allen Simpson.

• This product includes software developed at Ludd, University of Lulea,Sweden and its contributors.

• This product includes software developed at Ludd, University of Lulea.

• This product includes software developed at the Information Technology Division, US Naval Research
Laboratory.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by David Jones and Gordon Ross

• This product includes software developed by Gordon W. Ross and Leo Weppelman.

• This product includes software developed by Hellmuth Michaelis and Joerg Wunsch

• This product includes software developed by Internet Research Institute, Inc.

• This product includes software developed by Leo Weppelman and Waldi Ravens.

• This product includes software developed by Mika Kortelainen

• This product includes software developed by Aaron Brown and Harvard University.

• This product includes software developed by Adam Ciarcinski for the NetBSD project.

• This product includes software developed by Adam Glass and Charles M.Hannum.

• This product includes software developed by Adam Glass.

• This product includes software developed by Advanced Risc Machines Ltd.

• This product includes software developed by Alex Zepeda, and Colin Wood for the NetBSD Projet.

• This product includes software developed by Alex Zepeda.

• This product includes software developed by Alistair G. Crooks.

• This product includes software developed by Alistair G. Crooks. for the NetBSD project.

• This product includes software developed by Allen Briggs

• This product includes software developed by Amancio Hasty and Roger Hardiman

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Bill Paul.

• This product includes software developed by Bodo Moeller. (If available, substitute umlauted o for
oe)

• This product includes software developed by Boris Popov.

• This product includes software developed by Brad Pepers

• This product includes software developed by Bradley A. Grantham.

• This product includes software developed by Brini.

• This product includes software developed by Causality Limited.
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• This product includes software developed by Charles D. Cranor and Seth Widoff.

• This product includes software developed by Charles D. Cranor and Washington University.

• This product includes software developed by Charles D. Cranor, Washington

• University, and the University of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor, Washington University, the University
of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor.

• This product includes software developed by Charles Hannum.

• This product includes software developed by Charles M. Hannum, by the University of Vermont and
State Agricultural College and Garrett A.Wollman, by William F. Jolitz, and by the University of
California,Berkeley, Lawrence Berkeley Laboratory, and its contributors.

• This product includes software developed by Charles M. Hannum.

• This product includes software developed by Christian E. Hopps, Ezra Story, Kari Mettinen, Markus
Wild, Lutz Vieweg and Michael Teske.

• This product includes software developed by Christian E. Hopps.

• This product includes software developed by Christian Limpach

• This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

• This product includes software developed by Christopher G. Demetriou.

• This product includes software developed by Christos Zoulas.

• This product includes software developed by Chuck Silvers.

• This product includes software developed by Colin Wood for the NetBSD Project.

• This product includes software developed by Colin Wood.

• This product includes software developed by Cybernet Corporation and Nan Yang Computer
Services Limited

• This product includes software developed by Daishi Kato

• This product includes software developed by Dale Rahn.

• This product includes software developed by Daniel Widenfalk and Michael L. Hitch.

• This product includes software developed by Daniel Widenfalk for the NetBSD Project.

• This product includes software developed by Darrin B. Jewell

• This product includes software developed by David Miller.

• This product includes software developed by Dean Huxley.

• This product includes software developed by Eduardo Horvath.

• This product includes software developed by Eric S. Hvozda.

• This product includes software developed by Eric S. Raymond
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• This product includes software developed by Eric Young (eay@@mincom.oz.au)

• This product includes software developed by Eric Young (eay@cryptsoft.com)

• This product includes software developed by Eric Young (eay@mincom.oz.au)

• This product includes software developed by Ezra Story and by Kari Mettinen.

• This product includes software developed by Ezra Story, by Kari Mettinen and by Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, Michael Teske and by
Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, and Michael Teske.

• This product includes software developed by Ezra Story.

• This product includes software developed by Frank van der Linden for the NetBSD Project.

• This product includes software developed by Gardner Buchanan.

• This product includes software developed by Gary Thomas.

• This product includes software developed by Gordon Ross

• This product includes software developed by Gordon W. Ross

• This product includes software developed by HAYAKAWA Koichi.

• This product includes software developed by Harvard University and its contributors.

• This product includes software developed by Harvard University.

• This product includes software developed by Herb Peyerl.

• This product includes software developed by Hubert Feyrer for the NetBSD Project.

• This product includes software developed by Iain Hibbert

• This product includes software developed by Ian F. Darwin and others.

• This product includes software developed by Ian W. Dall.

• This product includes software developed by Ichiro FUKUHARA.

• This product includes software developed by Ignatios Souvatzis for the NetBSD Project.

• This product includes software developed by Internet Initiative Japan Inc.

• This product includes software developed by James R. Maynard III.

• This product includes software developed by Jared D. McNeill.

• This product includes software developed by Jason L. Wright

• This product includes software developed by Jason R. Thorpe for And Communications, http://
www.and.com/

• This product includes software developed by Joachim Koenig-Baltes.

• This product includes software developed by Jochen Pohl for The NetBSD Project.

• This product includes software developed by Joerg Wunsch

• This product includes software developed by John Birrell.
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• This product includes software developed by John P. Wittkoski.

• This product includes software developed by John Polstra.

• This product includes software developed by Jonathan R. Stone for the NetBSD Project.

• This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD
Project.

• This product includes software developed by Jonathan Stone.

• This product includes software developed by Jukka Marin.

• This product includes software developed by Julian Highfield.

• This product includes software developed by Kazuhisa Shimizu.

• This product includes software developed by Kazuki Sakamoto.

• This product includes software developed by Kenneth Stailey.

• This product includes software developed by Kiyoshi Ikehara.

• This product includes software developed by Klaus Burkert,by Bernd Ernesti, by Michael van Elst,
and by the University of California, Berkeley and its contributors.

• This product includes software developed by LAN Media Corporation and its contributors.

• This product includes software developed by Leo Weppelman for the NetBSD Project.

• This product includes software developed by Leo Weppelman.

• This product includes software developed by Lloyd Parkes.

• This product includes software developed by Luke Mewburn.

• This product includes software developed by Lutz Vieweg.

• This product includes software developed by MINOURA Makoto, Takuya Harakawa.

• This product includes software developed by Manuel Bouyer.

• This product includes software developed by Marc Horowitz.

• This product includes software developed by Marcus Comstedt.

• This product includes software developed by Mark Brinicombe for the NetBSD project.

• This product includes software developed by Mark Brinicombe.

• This product includes software developed by Mark Murray

• This product includes software developed by Mark Tinguely and Jim Lowe

• This product includes software developed by Markus Wild.

• This product includes software developed by Martin Husemann and Wolfgang Solfrank.

• This product includes software developed by Masanobu Saitoh.

• This product includes software developed by Masaru Oki.

• This product includes software developed by Mats O Jansson and Charles D.Cranor.

• This product includes software developed by Mats O Jansson.
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• This product includes software developed by Matt DeBergalis

• This product includes software developed by Matthew Fredette.

• This product includes software developed by Matthias Pfaller.

• This product includes software developed by Michael Graff for the NetBSD Project.

• This product includes software developed by Michael Graff.

• This product includes software developed by Michael L. Hitch.

• This product includes software developed by Michael Shalayeff.

• This product includes software developed by Michael Smith.

• This product includes software developed by Mike Glover and contributors.

• This product includes software developed by Mike Pritchard.

• This product includes software developed by Minoura Makoto.

• This product includes software developed by Nan Yang Computer Services Limited.

• This product includes software developed by Niels Provos.

• This product includes software developed by Niklas Hallqvist, Brandon Creighton and Job de Haas.

• This product includes software developed by Niklas Hallqvist.

• This product includes software developed by Onno van der Linden.

• This product includes software developed by Paul Kranenburg.

• This product includes software developed by Paul Mackerras.

• This product includes software developed by Per Fogelstrom

• This product includes software developed by Peter Galbavy.

• This product includes software developed by Phase One, Inc.

• This product includes software developed by Philip A. Nelson.

• This product includes software developed by Philip L. Budne.

• This product includes software developed by RiscBSD.

• This product includes software developed by Roar Thronaes.

• This product includes software developed by Rodney W. Grimes.

• This product includes software developed by Roger Hardiman

• This product includes software developed by Roland C. Dowdeswell.

• This product includes software developed by Rolf Grossmann.

• This product includes software developed by Ross Harvey for the NetBSD Project.

• This product includes software developed by Ross Harvey.

• This product includes software developed by Scott Bartram.

• This product includes software developed by Scott Stevens.
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• This product includes software developed by Shingo WATANABE.

• This product includes software developed by Softweyr LLC, the University of California, Berkeley, and
its contributors.

• This product includes software developed by Soren S. Jorvang.

• This product includes software developed by Stephan Thesing.

• This product includes software developed by Steve Woodford.

• This product includes software developed by Takashi Hamada

• This product includes software developed by Takumi Nakamura.

• This product includes software developed by Tatoku Ogaito for the NetBSD Project.

• This product includes software developed by Terrence R. Lambert.

• This product includes software developed by Tetsuya Isaki.

• This product includes software developed by Thomas Gerner

• This product includes software developed by Thomas Klausner for the NetBSD Project.

• This product includes software developed by Tobias Weingartner.

• This product includes software developed by Todd C. Miller.

• This product includes software developed by Tohru Nishimura and Reinoud Zandijk for the NetBSD
Project.

• This product includes software developed by Tohru Nishimura for the NetBSD Project.

• This product includes software developed by Tohru Nishimura. for the NetBSD Project.

• This product includes software developed by TooLs GmbH.

• This product includes software developed by Toru Nishimura.

• This product includes software developed by Trimble Navigation, Ltd.

• This product includes software developed by WIDE Project and its contributors.

• This product includes software developed by Waldi Ravens.

• This product includes software developed by Wasabi Systems for Zembu Labs, Inc. http://
www.zembu.com/

• This product includes software developed by Winning Strategies, Inc.

• This product includes software developed by Wolfgang Solfrank.

• This product includes software developed by Yasushi Yamasaki

• This product includes software developed by Zembu Labs, Inc.

• This product includes software developed by the Alice Group.

• This product includes software developed by the Center for Software Science at the University of Utah.

• This product includes software developed by the Charles D. Cranor, Washington University, University
of California, Berkeley and its contributors.

Copyright Information about Installed Applications

329

10

http://www.zembu.com/
http://www.zembu.com/


• This product includes software developed by the Computer Systems Engineering Group at Lawrence
Berkeley Laboratory.

• This product includes software developed by the David Muir Sharnoff.

• This product includes software developed by the Harvard University and its contributors.

• This product includes software developed by the Kungliga Tekniska Hogskolan and its contributors.

• This product includes software developed by the Network Research Group at Lawrence Berkeley
Laboratory.

• This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.OpenSSL.org/)

• This product includes software developed by the PocketBSD project and its contributors.

• This product includes software developed by the RiscBSD kernel team

• This product includes software developed by the RiscBSD team.

• This product includes software developed by the SMCC Technology Development Group at Sun
Microsystems, Inc.

• This product includes software developed by the University of California, Berkeley and its contributors,
as well as the Trustees of Columbia University.

• This product includes software developed by the University of California, Lawrence Berkeley
Laboratory and its contributors.

• This product includes software developed by the University of California, Lawrence Berkeley
Laboratory.

• This product includes software developed by the University of Illinois at Urbana and their contributors.

• This product includes software developed by the University of Vermont and State Agricultural College
and Garrett A. Wollman.

• This product includes software developed by the University of Vermont and State Agricultural College
and Garrett A. Wollman, by William F. Jolitz, and by the University of California, Berkeley, Lawrence
Berkeley Laboratory, and its contributors.

• This product includes software developed for the FreeBSD project

• This product includes software developed for the NetBSD Project by Bernd Ernesti.

• This product includes software developed for the NetBSD Project by Christopher G. Demetriou.

• This product includes software developed for the NetBSD Project by Christos Zoulas

• This product includes software developed for the NetBSD Project by Emmanuel Dreyfus.

• This product includes software developed for the NetBSD Project by Frank van der Linden

• This product includes software developed for the NetBSD Project by Ignatios Souvatzis.

• This product includes software developed for the NetBSD Project by Jason R. Thorpe.

• This product includes software developed for the NetBSD Project by John M. Vinopal.

• This product includes software developed for the NetBSD Project by Matthias Drochner.
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• This product includes software developed for the NetBSD Project by Michael L. Hitch.

• This product includes software developed for the NetBSD Project by Perry E. Metzger.

• This product includes software developed for the NetBSD Project by Scott Bartram and Frank van der
Linden

• This product includes software developed for the NetBSD Project by Allegro Networks, Inc., and
Wasabi Systems, Inc.

• This product includes software developed for the NetBSD Project by Genetec Corporation.

• This product includes software developed for the NetBSD Project by Jonathan Stone.

• This product includes software developed for the NetBSD Project by Piermont Information Systems
Inc.

• This product includes software developed for the NetBSD Project by SUNET,Swedish University
Computer Network.

• This product includes software developed for the NetBSD Project by Shigeyuki Fukushima.

• This product includes software developed for the NetBSD Project by Wasabi Systems, Inc.

• This product includes software developed under OpenBSD by Per Fogelstrom Opsycon AB for RTMX
Inc, North Carolina, USA.

• This product includes software developed under OpenBSD by Per Fogelstrom.

• This software is a component of "386BSD" developed by William F. Jolitz,TeleMuse.

• This software was developed by Holger Veit and Brian Moore for use with "386BSD" and similar
operating systems. "Similar operating systems" includes mainly non-profit oriented systems for
research and education, including but not restricted to "NetBSD", "FreeBSD", "Mach" (by CMU).

• This software includes software developed by the Computer Systems Laboratory at the University of
Utah.

• This product includes software developed by Computing Services at Carnegie Mellon University
(http://www.cmu.edu/computing/).

• This product includes software developed by Allen Briggs.

In the following statement, "This software" refers to the Mitsumi CD-ROM driver:

• This software was developed by Holger Veit and Brian Moore for use with "386BSD" and similar
operating systems. "Similar operating systems" includes mainly non-profit oriented systems for
research and education, including but not restricted to "NetBSD", "FreeBSD", "Mach" (by CMU).

In the following statement, "This software" refers to the parallel port driver:

This software is a component of "386BSD" developed by William F. Jolitz, TeleMuse.

Netatalk(NetBSD)/NetaTalk 1.4b2+asun2.1.3

Copyright (c) 1990,1991 Regents of The University of Michigan. All Rights Reserved.
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FreeBSD 4.6.2/netipx

Copyright (c) 1984, 1985, 1986, 1987, 1993

The Regents of the University of California. All rights reserved.

Modifications Copyright (c) 1995, Mike Mitchell

Modifications Copyright (c) 1995, John Hay

Sablotron

Sablotron (Version 0.82) Copyright (c) 2000 Ginger Alliance Ltd. All Rights Reserved

a) The application software installed on this product includes the Sablotron software Version 0.82
(hereinafter, "Sablotron 0.82"), with modifications made by the product manufacturer. The original code
of the Sablotron 0.82 is provided by Ginger Alliance Ltd., the initial developer, and the modified code of
the Sablotron 0.82 has been derived from such original code provided by Ginger Alliance Ltd.

b) The product manufacturer provides warranty and support to the application software of this product
including the Sablotron 0.82 as modified, and the product manufacturer makes Ginger Alliance Ltd., the
initial developer of the Sablotron 0.82, free from these obligations.

c) The Sablotron 0.82 and the modifications thereof are made available under the terms of Mozilla Public
License Version 1.1 (hereinafter, "MPL 1.1"), and the application software of this product constitutes the
"Larger Work" as defined in MPL 1.1. The application software of this product except for the Sablotron
0.82 as modified is licensed by the product manufacturer under separate agreement(s).

d) The source code of the modified code of the Sablotron 0.82 is available at: http://support-
download.com/services/device/sablot/notice082.html

e) The source code of the Sablotron software is available at: http://www.gingerall.com

f) MPL 1.1 is available at: http://www.mozilla.org/MPL/MPL-1.1.html

JPEG LIBRARY

• The software installed on this product is based in part on the work of the Independent JPEG Group.

SASL

CMU libsasl

Tim Martin

Rob Earhart

Rob Siemborski
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Copyright (c) 2001 Carnegie Mellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived
from this software without prior written permission.

For permission or any other legal details, please contact:

Office of Technology Transfer

Carnegie Mellon University

5000 Forbes Avenue

Pittsburgh, PA 15213-3890

(412) 268-4387, fax: (412) 268-7395

tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
CARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Samba(Ver 3.0.4)

For SMB transmission, this machine uses Samba ver 3.0.4 (hereinafter referred to as Samba 3.0.4).

Copyright (c) Andrew Tridgell 1994-1998

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675
Mass Ave, Cambridge, MA 02139, USA.
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• The source code for SMB transmission by this machine can be downloaded from the following website:
http://support-download.com/services/scbs

RSA BSAFE®

• This product includes RSA BSAFE (c) cryptographic software from RSA Security Inc.

• RSA, BSAFE are either registered trademarks or trademarks of RSA Security Inc. in the United States
and/or other countries.

• RSA Security Inc. All rights reserved.

Open SSL

Copyright (c) 1998-2004 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.
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5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If
this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used. This can be in the form of a textual message at program startup or in documentation (online
or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used
are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence

[including the GNU Public Licence.]

Open SSH

The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.

OpenSSH contains no GPL code.

1)

Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland All rights reserved

As far as I am concerned, the code I have written for this software can be used freely for any purpose. Any
derived versions of this software must be clearly marked as such, and if the derived work is incompatible
with the protocol description in the RFC file, it must be called by a name other than "ssh" or "Secure Shell".

[Tatu continues]

However, I am not implying to give any licenses to any patents or copyrights held by third parties, and the
software includes parts that are not under my direct control. As far as I know, all included source code is
used in accordance with the relevant license agreements and can be used freely for any purpose (the GNU
license being the most restrictive); see below for details.

[However, none of that term is relevant at this point in time. All of these restrictively licenced software
components which he talks about have been removed from OpenSSH, i.e.,

- RSA is no longer included, found in the OpenSSL library

- IDEA is no longer included, its use is deprecated

- DES is now external, in the OpenSSL library

- GMP is no longer used, and instead we call BN code from OpenSSL
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- Zlib is now external, in a library

- The make-ssh-known-hosts script is no longer included

- TSS has been removed

- MD5 is now external, in the OpenSSL library

- RC4 support has been replaced with ARC4 support from OpenSSL

- Blowfish is now external, in the OpenSSL library

[The licence continues]

Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can
be found e.g. at "http://www.cs.hut.fi/crypto".

The legal status of this program is some combination of all these permissions and restrictions. Use only at
your own responsibility. You will be responsible for any legal consequences yourself; I am not making any
claims whether possessing or using this is legal or not in your country, and I am not taking any responsibility
on your behalf.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED
IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY
TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2)

The 32-bit CRC compensation attack detector in deattack.c was contributed by CORE SDI S.A. under a
BSD-style license.

Cryptographic attack detector for ssh - source code

Copyright (c) 1998 CORE SDI S.A., Buenos Aires, Argentina.

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are
permitted provided that this copyright notice is retained.
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THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES ARE
DISCLAIMED. IN NO EVENT SHALL CORE SDI S.A. BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE
OR MISUSE OF THIS SOFTWARE.

Ariel Futoransky <futo@core-sdi.com>

<http://www.core-sdi.com>

3)

One component of the ssh source code is under a 3-clause BSD license, held by the University of California,
since we pulled these parts from original Berkeley code.

Copyright (c) 1983, 1990, 1992, 1993, 1995

The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

4)

Remaining components of the software are provided under a standard 2-term BSD licence with the
following names as copyright holders:

Markus Friedl

Theo de Raadt

Niels Provos

Dug Song

Kevin Steves
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Daniel Kouril

Wesley Griffin

Per Allansson

Jason Downs

Solar Designer

Todd C. Miller

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5)

Portable OpenSSH contains the following additional licenses:

c) Compatibility code (openbsd-compat)

Apart from the previously mentioned licenses, various pieces of code in the openbsd-compat/ subdirectory
are licensed as follows:

Some code is licensed under a 3-term BSD license, to the following copyright holders:

Todd C. Miller

Theo de Raadt

Damien Miller

Eric P. Allman

The Regents of the University of California

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Open LDAP

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a
version number. You may use this Software under terms of this license revision or under the terms of any
subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS "AS IS"
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S) OR
OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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The names of the authors and copyright holders must not be used in advertising or otherwise to promote
the sale, use or other dealing in this Software without specific, written prior permission. Title to copyright
in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright (c) 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

Heimdal

Copyright (c) 1997-2005 Kungliga Tekniska Högskolan (Royal Institute of Technology, Stockholm,
Sweden). All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the Institute nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE INSTITUTE OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

IPSTM print language emulations

Copyright (c) 1987-2006 Zoran Corporation. All rights reserved.

racoon

Copyright (C) 1995, 1996, 1997, and 1998 WIDE Project.

All rights reserved.
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TrouSerS

THE ACCOMPANYING PROGRAM IS PROVIDED UNDER THE TERMS OF THIS COMMON PUBLIC
LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF THE PROGRAM
CONSTITUTES RECIPIENT'S ACCEPTANCE OF THIS AGREEMENT.

1. DEFINITIONS

"Contribution" means:

a) in the case of the initial Contributor, the initial code and documentation distributed under this Agreement,
and

b) in the case of each subsequent Contributor:

i) changes to the Program, and

ii) additions to the Program;

where such changes and/or additions to the Program originate from and are distributed by that particular
Contributor. A Contribution 'originates' from a Contributor if it was added to the Program by such
Contributor itself or anyone acting on such Contributor's behalf. Contributions do not include additions to
the Program which: (i) are separate modules of software distributed in conjunction with the Program under
their own license agreement, and (ii) are not derivative works of the Program.

"Contributor" means any person or entity that distributes the Program.

"Licensed Patents " mean patent claims licensable by a Contributor which are necessarily infringed by the
use or sale of its Contribution alone or when combined with the Program.

"Program" means the Contributions distributed in accordance with this Agreement.

"Recipient" means anyone who receives the Program under this Agreement, including all Contributors.

2. GRANT OF RIGHTS

a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive,
worldwide, royalty-free copyright license to reproduce, prepare derivative works of, publicly display,
publicly perform, distribute and sublicense the Contribution of such Contributor, if any, and such derivative
works, in source code and object code form.

b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-exclusive,
worldwide, royalty-free patent license under Licensed Patents to make, use, sell, offer to sell, import and
otherwise transfer the Contribution of such Contributor, if any, in source code and object code form. This
patent license shall apply to the combination of the Contribution and the Program if, at the time the
Contribution is added by the Contributor, such addition of the Contribution causes such combination to be
covered by the Licensed Patents. The patent license shall not apply to any other combinations which include
the Contribution. No hardware per se is licensed hereunder.

c) Recipient understands that although each Contributor grants the licenses to its Contributions set forth
herein, no assurances are provided by any Contributor that the Program does not infringe the patent or
other intellectual property rights of any other entity. Each Contributor disclaims any liability to Recipient for
claims brought by any other entity based on infringement of intellectual property rights or otherwise. As a
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condition to exercising the rights and licenses granted hereunder, each Recipient hereby assumes sole
responsibility to secure any other intellectual property rights needed, if any. For example, if a third party
patent license is required to allow Recipient to distribute the Program, it is Recipient's responsibility to acquire
that license before distributing the Program.

d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its Contribution, if
any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS

A Contributor may choose to distribute the Program in object code form under its own license agreement,
provided that:

a) it complies with the terms and conditions of this Agreement; and

b) its license agreement:

i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and implied,
including warranties or conditions of title and non-infringement, and implied warranties or conditions of
merchantability and fitness for a particular purpose;

ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, indirect,
special, incidental and consequential damages, such as lost profits;

iii) states that any provisions which differ from this Agreement are offered by that Contributor alone and
not by any other party; and

iv) states that source code for the Program is available from such Contributor, and informs licensees how
to obtain it in a reasonable manner on or through a medium customarily used for software exchange.

When the Program is made available in source code form:

a) it must be made available under this Agreement; and

b) a copy of this Agreement must be included with each copy of the Program.

Contributors may not remove or alter any copyright notices contained within the Program.

Each Contributor must identify itself as the originator of its Contribution, if any, in a manner that reasonably
allows subsequent Recipients to identify the originator of the Contribution.

4. COMMERCIAL DISTRIBUTION

Commercial distributors of software may accept certain responsibilities with respect to end users, business
partners and the like. While this license is intended to facilitate the commercial use of the Program, the
Contributor who includes the Program in a commercial product offering should do so in a manner which
does not create potential liability for other Contributors. Therefore, if a Contributor includes the Program
in a commercial product offering, such Contributor ("Commercial Contributor") hereby agrees to defend
and indemnify every other Contributor ("Indemnified Contributor") against any losses, damages and costs
(collectively "Losses") arising from claims, lawsuits and other legal actions brought by a third party against
the Indemnified Contributor to the extent caused by the acts or omissions of such Commercial Contributor
in connection with its distribution of the Program in a commercial product offering. The obligations in this
section do not apply to any claims or Losses relating to any actual or alleged intellectual property
infringement. In order to qualify, an Indemnified Contributor must: a) promptly notify the Commercial
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Contributor in writing of such claim, and b) allow the Commercial Contributor to control, and cooperate
with the Commercial Contributor in, the defense and any related settlement negotiations. The Indemnified
Contributor may participate in any such claim at its own expense.

For example, a Contributor might include the Program in a commercial product offering, Product X. That
Contributor is then a Commercial Contributor. If that Commercial Contributor then makes performance
claims, or offers warranties related to Product X, those performance claims and warranties are such
Commercial Contributor's responsibility alone. Under this section, the Commercial Contributor would have
to defend claims against the other Contributors related to those performance claims and warranties, and
if a court requires any other Contributor to pay any damages as a result, the Commercial Contributor must
pay those damages.

5. NO WARRANTY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS PROVIDED ON AN "AS
IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED
INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Each Recipient is
solely responsible for determining the appropriateness of using and distributing the Program and assumes
all risks associated with its exercise of rights under this Agreement, including but not limited to the risks and
costs of program errors, compliance with applicable laws, damage to or loss of data, programs or
equipment, and unavailability or interruption of operations.

6. DISCLAIMER OF LIABILITY

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR ANY
CONTRIBUTORS SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS),
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OR DISTRIBUTION OF THE PROGRAM OR THE EXERCISE OF ANY RIGHTS GRANTED
HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. GENERAL

If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect the
validity or enforceability of the remainder of the terms of this Agreement, and without further action by the
parties hereto, such provision shall be reformed to the minimum extent necessary to make such provision
valid and enforceable.

If Recipient institutes patent litigation against a Contributor with respect to a patent applicable to software
(including a cross-claim or counterclaim in a lawsuit), then any patent licenses granted by that Contributor
to such Recipient under this Agreement shall terminate as of the date such litigation is filed. In addition, if
Recipient institutes patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit)
alleging that the Program itself (excluding combinations of the Program with other software or hardware)
infringes such Recipient's patent(s), then such Recipient's rights granted under Section 2(b) shall terminate
as of the date such litigation is filed.
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All Recipient's rights under this Agreement shall terminate if it fails to comply with any of the material terms
or conditions of this Agreement and does not cure such failure in a reasonable period of time after becoming
aware of such noncompliance. If all Recipient's rights under this Agreement terminate, Recipient agrees to
cease use and distribution of the Program as soon as reasonably practicable. However, Recipient's
obligations under this Agreement and any licenses granted by Recipient relating to the Program shall
continue and survive.

Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid inconsistency
the Agreement is copyrighted and may only be modified in the following manner. The Agreement Steward
reserves the right to publish new versions (including revisions) of this Agreement from time to time. No one
other than the Agreement Steward has the right to modify this Agreement. IBM is the initial Agreement
Steward. IBM may assign the responsibility to serve as the Agreement Steward to a suitable separate entity.
Each new version of the Agreement will be given a distinguishing version number. The Program (including
Contributions) may always be distributed subject to the version of the Agreement under which it was
received. In addition, after a new version of the Agreement is published, Contributor may elect to distribute
the Program (including its Contributions) under the new version. Except as expressly stated in Sections 2
(a) and 2(b) above, Recipient receives no rights or licenses to the intellectual property of any Contributor
under this Agreement, whether expressly, by implication, estoppel or otherwise. All rights in the Program
not expressly granted under this Agreement are reserved.

This Agreement is governed by the laws of the State of New York and the intellectual property laws of the
United States of America. No party to this Agreement will bring a legal action under this Agreement more
than one year after the cause of action arose. Each party waives its rights to a jury trial in any resulting
litigation.

• To obtain the source code for opening TrouSerS (Version 0.27), which is provided with this machine,
access the Web site at the following URL: http://www.ricoh.com/support/trousers/index.html

• TrouSerS version control is by SourceForge CVS. For methods of obtaining the source code, access
the Web site at the following URL: http://sourceforge.net/cvs/?group_id=126012
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